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1. Before starting

Purpose of Document

This document provides the information on how to use the CodeScroll Controller Tester Product.
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2. Overview

Introduction

Controller Tester is a test automation solution for unit and integration tests of software developed and
executed in various environments.

Toolchain supported in Controller Tester

Controller Tester supports about 100 toolchain. For more information, please contact the Technical
support contact at the bottom of this document Troubleshooting page.

Features

Controller Tester is a source code-based software test automation tool for unit and integration tests and
the major features are as follows.

Test design

Automatically create tests and test data
Intuitive test design interface
Ability to import test data in various format

PN~

Ability to design of integration test for complex nested structures

Achieving coverage goals

Supports statement, branch, MC/DC and function call coverage
Provides guides to achieve the goal of MC/DC
Checks the coverage results by linking the control flow graph with the source code

o Dd -~

The coverage goal can be achieved quickly by testing only uncovered section after measuring the
system coverage (QualityScroll COVER product).

Others

1. Supports the simulation and the actual target environment tests

2. Links with DevOps(issue management + continuous integration + configuration management) tools

3. Shares project settings with CodeScroll product family: By carrying out the project settings only
once, coding rule inspection + runtime error detection + unit/integration test can be possible.

4. Reports in various formats

Standard certification

1. IEC 61508-3 (Electrical/Electronic)
2. 1SO 26262-8 (Automotive)
3. IEC 60880 (Nuclear)

Page 4 of 249



Suresofttech

4. |EC 62279/ EN 50128 (Railway)
5. DO-178C / DO-330 (Aviation)

Overall screen of Controller Tester

User Manual - 3.3

It provides high DOF windows made by Eclipse RCP. User can set them in [Window] menu and each

view.

g92

S

woid ZLIB_TMTERMAL _tr_Flush_bits{s}
deflate_state *z;

bi_flush(s);

* Send one empty static ble
* Thiz takes 18 bits, of wh

ZLIE TMTERMAL
deflate_state
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3. Install

Installation requirements

OS  Microsoft Windows 7/10 (32bit/64bit)
RAM 512MB or more

Free space about 500MB (GCC Compiler not installed) or about 1GB (GCC Compiler installed)

Ll (When carrying out tests actually, HDD usage may be increased due to the test results.)

Install Controller Tester for Windows
By using the install package, you can install Controller Tester as follows:

1. Execute setup.exe file.

Bl maocified Tipst -

I Codesocl Conveller Tener_30ms
[ .

! It does not work properly when installed with ‘CodeScroll Controller Tester_3.x.msi’.

2. Click [Next] after the installation wizard runs and gathers installation information.

’{vd-:.'u':le'{lnlﬂ Teites Setup =

Welcans te Codeterall Controllar Tostor Selop

Wellcomne o the Winsed for { cde ol € ovtroler Tesed Srtup

3. Accept the end-user license and click [Next].
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End-User License Sgreement

1 el Ny wvbzgmmng Loy

Freparmg mallation

lin

L e we——

Frval ey Sureac® and o Dademaria cortared moPe ScEaW e Pedemaria o
repateced Fademaria of Serenok Technoopes. nc. n For Bepubic of Kores andir

o —— PR Cmetmy hed ety bile—acn. badn faeme Sl seew ped g Say
B P FRSHRANR O MR TRIARANE OF IR T Bt B il B0

o o aber wny ek, bede name, grocect e, Dpoa, CopEght of

pier proprwiey roliom, Rpecde wTEoE o bbel P Be Zo%wwe The EULA
el A PRE e B el BteilE O B BERGET RaSEE B B 0F BV
BRI L

4. Set the path to install Controller Tester and whether or not to install the GCC compiler built in
Controller Tester, and click [Next].

[l oSt Comtiober Teites Setup R

Enstallation | der

Thin i ther lokdey weer oo wroll Comtroler Teuter mill be mataled

Colerting imbormsban
Prrparimg i sllalion
vad allengy

1 mabswey enlalafam

5. All required information for the installation has been collected. Click [Install].

Reasdy 1o Install

The tetep Wirard i resdy bs begm the {odeicral Controler Teder
it alla i,
Collecting il ==

Prrparieg vl slales
Drvat alllenegy

1 by wwy enlalufan

6. Install Controller Tester.
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tnstalling CodeSorell Controller Tester

Welkccane o the Wiosed dor { ode %ol € coviraler Teuiss Srtup.
1 ol wvbarmabon
Prrparimg e slalon
(S )

1 sk weg mnFalarum

7. When running Controller Tester immediately after installation is complete, check [Launch

CodeScroll Controller Tester] and click [Finish].
B Cotetonss Comtroter Tente Sty [=="]

Codesoroll Controller Tester Satup Conmplite

ooty mbarmsban
Preparing mulsllstion
Lasl alleng

1 mabeweg emlalalam
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4. Uninstall

Uninstall Controller Tester for Windows

There are three ways to uninstall Controller Tester.

1. Uninstall using [Control Panel] -> [Uninstall a program]

e ==
G:._J o v Comteod Faval 5 iy

T EMpLNET'S SETENG

2. Uninstall using [Start] -> [All programs] -> [CodeScroll Controller Tester 3.x] -> [Uninstall
CodeScroll Controller Tester 3.x]

|, CodeScroll Controller Tester 3.0
B CodeScroll.exe
(@ WUninstall CodeScroll Controller Tester 3.0

3. Uninstall using [Path to install] -> [Uninstall CodeScroll Controller Tester 3.x]

b coalapaiitan
Lo featyres

B %1% PR

& e

b p?

L bt

= ardpsizeml

B CodeSereilone

. Codefomil e manifes
& | CodeSomilini

7 pohpsec.ent

& epladiihienl

2 | neticataml

# Uninstsll CodeScroll Controller Tester 3.0

115 EB

* “Uninstall Controller Tester” deletes the files necessary to operate the Controller Tester.
The workspaces set by users are not deleted.

The procedures for [Uninstall CodeScroll Controller Tester 3.x] are as follows:

1. Run [Uninstall CodeScroll Controller Tester Tester 3.x] to collect the information needed to
uninstall the program. Click [Next] to proceed.
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- CodeScroll Controller Tester Setup @

Welcome to CodeScroll Controller Tester Setup

Welcome to the Wizard for CodeScroll Controller Tester Setup.

. Collecting information
O Preparing installation
O Installing

O Finalizing installation Wizard.

2. Select the checkbox [Uninstall CodeScroll Controller Tester 3.x] and [Uninstall GCC Compiler] and
click [Next].

- CodeScroll Controller Tester Setup @

Modify, Repair or Remove installation

Welecome to CodeScroll Controller Tester Maintenance Wizard.

. Collecting information

o Preparing installation Please choose the maintenance operation you wish to perform and dick "Mext™,

O Installing

0 Finalizing installation Uninstall CodeScroll Controller Tester 3.3

Re mpiler

* [Remove GCC Compiler] can be checked only when [Remove CodeScroll Controller
Tester 3.x] is checked.

If the GCC compiler has not deleted, the GCC compiler cannot be installed when re-
installing the Controller Tester.

3. All the necessary information for uninstalling has been collected. Click [Uninstall].
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. CodeScroll Controller Tester Setup

Ready to Remove

The Setup Wizard is ready to begin the CodeScroll Controller Tester

Collecting information
Preparing installation
Installing

Finalizing installation

4. When the Controller Tester is successfully uninstalled, click [Finish].
. CodeScroll Controller Tester Setup

CodeScroll Controller Tester Setup Complete

CodeScroll Controller Tester has been uninstalled

Collecting information
Preparing installation
Installing

Finalizing installation
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5. Run

Select the shortcut icon or [Start] -> [All programs] -> [CodeScroll Controller Tester 3.x] -> [CodeScroll

Controller Tester 3.x].

i CODESCROLL
e

#iE CONTROLLER TESTER

Select the workspace (working space) following the splash screen of the Controller Tester. You can
select either the already existed directory or enter a new directory as the workspace path. You can also
use the currently selected workspace as the default so that you do not need to reselect the workspace
the next time you run again. When the path has been set, click the [OK] button.

B wierispace Selectmn. ==
Pick Workspace

Yol vetrkspace i whsbie seitwigs and vanou impoetant lles wll be siored.

Worgpece  CUCTID = | Beowse |

Use thit as the defsult and do mct sk sgein

cone [ ok ][ Cance

If the selected directory does not exist, confirm the user whether to create the directory.
B New Wiekspace (===

9 Weuld you like to create o workspace in the selected location?

[oc [ comce

Create a directory in the workspace you have set and the welcome page of the tool is displayed. The
welcome page is displayed only when creating a workspace newly, and is not displayed when selecting
the workspace created previously.
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Software for Safe world

a4 o DM RLEE TISTIR

CONTROLLER TESTER T [o—

MNaedi

Wintian Critical domain tequines certfication oo Lafety and selisbiity,

Close the welcome page and the product screen is displayed.

User Manual - 3.3
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6. Set License

User Manual - 3.3

To use Controller Tester, you must register the license first. The procedures for registering the license
are as follows.

1.

2. Select [Product] -> [Controller Tester] and click [Edit].

3.

Select [Help] -> [License] in Menu.

Help
Welcome

() Help

Ly License...

'] Parser Config

. About

4

.I.iame

4 Prodest

Controlier Tester Irrealid Bcerae,

[

Enter the license in the manner provided in Editing License Information and click [OK] button to

register the license.
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License Information

() Floating

Please enter floating license server information.

Operating system: | Window -
P/ hostname:

Port:

Authenticstion connechon
@ Modelock

Please enter nodelock license file path.
{License file name : ctlic)

File path:

o [ omea ]

» Floating: Register it through the license server. Enter the server information (operating
system, IP, port) and click [Authentication Test] button.
* Node-lock: Register the license file provided.
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7. Set a Toolchain (Analyzer)

To perform the test using Controller Tester, the toolchain setting is required.
You must have a toolchain (compiler information) for the source under test to create a project.

The toolchain can be set in [Window] -> [Preferences] -> [Toolchain].

| e = |
i bl [ =
A
e i ok R iepx Ca  Comewson O eI MIEW
e o WCAFAND ey LI ey
Fete—arn - s Joget Lmitar
Paebeieiin o N QS Iy BEF Ly
PR N L
Bart
Harcn Ve P
Aepl
e
i T Rl
L)
Ee
sepiy s Ciom Camanl

And it can also be set through [Toolchain setting] in Create a source file C/C++ project wizard or in
Create a C/C++ Project from Embedded wizard.
I New Progect o e ]

MNew Project
Creste new peoject

Pregect namie |

Lescatica: CACTI0

Select Toolchain

| Default  Tookchain Mame * Descrigtion
GCC 4.7 Giea) Automatscally genersbed
GCC 5.3 (3loa) dartomatically generated

< Back l‘ Plex = F -' Camgel |

The functions related to the toolchain setting provided by Controller Tester are as follows.

« Add a Toolchain
« Edit a toolchain

» Duplicate a toolchain

- Remove a toolchain

« Export a toolchain

* Import a Toolchain
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7.1. Auto-registration of Toolchain

When executing the Controller Tester, it extracts the information of Visual Studio compiler installed in
user PC and the information GCC compiler installed along with the Controller Tester and registers the
toolchain automatically (the registered toolchain is not registered again.).

I onian o A
e g F

T o & @ Faniil re . &=

b Bt b e e g, P
TN e SMEOT e | G Pty (et G | ol gt 7 P ol My

CONTROLLER TESTER

Needs

Mnsiien Crtical doman iegue cenification en wfety and iehabdity

The auto-registered toolchain can be checked in [Window] -> [Preferences] -> [Toolchain] window, and it
displays the message “Automatically generated.” in the description.

[ E— B e |
Tasdlhain T
sy
Trca " Topinban Hemm  Tepeiie. Comomaen el Cwssrplioe il
:‘W o GOC D (L [y il iy bl

S A1) = —
b & GO0 (L wangy e Ak, gearmed
b mar sl < e
b
St Pt Ty
T
(L el
Tooml by
du
Dmad
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7.2. Add a Toolchain
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1.

2.

In [Window] -> [Preferences] -> [Toolchain] window, click the [Add Toolchain] button.

B Preferences

o x
| ToolChain MR 2
> Analysis
Editor Status  Toolchain Name Target Compi... Cenversion Toolchain ... Description Add Toolchain.
Exclusion
Language Add RTV Toolchain.
Performance Ei:
Perspectives
Source File Types Duplicate.
> Target Test
) Test Remove
Theme (CS Labs)
> ToolChain
Open Confiquration Folder
Detall

[Apply and Close] Cancel

In [Add a toolchain] window, enter the toolchain information.

B cdit Teelchain [m] X

Toolchain(Method Manage)
Manage toclchain infermaticn.

Toclchain Informaticn

Name: [Gcc 5.3 (32bity |

Description ‘ ‘

Env Script: ‘C wUserswxAppDatawRoamingwCodeScrollw1.1#parserConfigtGCC 5.:| | Browse...

Configuration: » GNU Compilers b gcc » 5.3 b cthers

¢ e @

Cumpwler.lC.Ngcc‘-\‘S.3.0+\‘32b|t+\'b|n5\‘gcc.exe ‘ Browse... I

Linker: | CHvgoons.3.0%32bitwbintrgec.exe

‘ Browse...

Archiver: | Cvgoons.3.0%32bitwbinar.exe
System Header:

CHgCCHS. 3 03 2bitwlibgec¥mingw32#5.3.0winclude Add...
CHgCeWS 3. 0%32bitwinclude ~
CHgCCS. 3. 03 2bitwlibgecwmingw32#5.3.0winclude-fixed

‘ Browse...

Edit...
Remove
Up

Down

Libraries:

Add...

Edit...

Remove

Automatically extract toolchain infermation from entered compiler. Extract Toclchain Info

< Back Next = Cancel

* When you click [Extract toolchain Info]@ button after [Compiler]@, the toolchain information

is extracted automatically from the compiler entered.

* In [Compiler]@, enter the compiler path.
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= Ifitis based on Visual Studio:
C:\program Files (x86)\Microsoft Visual Studio 10.0\VS\bin\cl.exe
= Ifitis based on GCC:
C:\MinGW\bin\gcc.exe
= CodeWarrior 5.x or higher for Freeescale HC (s) 12:
C:\Program Files (x86)\Freescale\CWS12v5.1\Prog\chc12.exe
3. In [Name], enter the name of toolchain to be created.
4. In [Description], enter the description of toolchain to be created.
5. The entry information of [Env Script], [Configuration] and [C/C++] is set automatically by extracting
the information from the compiler or can be entered directly by user.
6. After entering the toolchain information, click the [Next] or [Finish] button.

B Add a toolchain m] *

Advanced Compile setting

Set the parser configuration. (Depending on the toelchain, some
options apply differently)

Keyword Directive Define Predefined Type  etc
Keywords:

Add

Edit.

Remove

ASM Keywords:

Add

Edit.

Remove

Example:

< Back Mext > Finish Cancel

7. In [Advanced Compile setting] window displayed when clicking the [Next] button, the detailed items
related to the configurations selected in the [Configuration] are shown. Each item can be changed
by the user. The application of the changed items can be checked in advance via [Example].

* For the detailed setting procedure for the other toolchain detail, please contact the
Technical support contact at the bottom of this document Troubleshooting page.
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7.3. Edit a Toolchain
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1. Select the toolchain to be edited and click the [Edit] button.

B Edit Toolchain

Toolchain(Method Manage)

Manage toclchain information.

] X

Toolchain Information

Name: [acc 5.3 (32bity

Description: |

Env Script: ‘C wUserswxwAppDatawRoamingwCodeScrollw 1.1 %parserConfigGCC 5| | Browse

Configuration: » GMNU Compilers » gcc ¥ 53 b others

c Cs+

Compiler: |C'Ngccw5 3.0%32bitwbin#gcc.exe

Browse.

Linker: |C'Ngccw5 3.0%32bitwbin#gcc.exe

Browse.

Archiver: |C'Ngccw5 3.0%32bitwbinwar exe

Browse.

System Header:

QWS 3.0W3 2bitvlib¥gecwmingw32wS.3.0Winclude
QoS 3.0w32bitvinclude
Qs 3.0W3 2bitvlibvgecwmingw32ws. 3.0winclude-fixed

Add

Edit
Remove

Up

Down

Libraries:

Add...
Edit...

Remove

Autematically extract toolchain infermation from entered compiler.

Extract Toolchain Info

< Back Next > Cancel

2. Edit the information of toolchain.
3. Click the [Finish] button.

Page 20 of 249



Suresofttech User Manual - 3.3

7.4. Duplicate a Toolchain

1. Select the toolchain to be copied and click the [Duplicate] button.
(It can copy only a toolchain which a compiler is not entered.)

2. Edit the toolchain information that you want to change.

3. Click the [Finish] button.
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7.5. Remove a Toolchain

Select the toolchain to remove and click the [Remove] button.

! If there is a project using the toolchain you want to remove, the project will not work
properly.
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7.6. Export a Toolchain

The toolchain information can be exported via ‘Export’ function.

1. Click [File] -> [Export] in menu and select [Toolchain] in [Preferences].
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you set the system header file in the toolch

Select the toolchain to be exported and click [Browse] button to specify the path to be exported. If

ain settings, a checkbox will be displayed in the

[Exporting system header] column, where you can choose whether to export.
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3. Click [Window] -> [Preferences] -> [Toolcha

in] -> [Exporting] in menu to set the system header

size to be exported. The system header larger than the size you had set cannot be exported.
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7.7. Import a Toolchain

The exported toolchain can be imported via the [Import] function.

[Fe] tds Semch Fromci Bum Weckow

Plew

Close
Chesie AN

Select [File] -> [Import] in menu and click [Toolchain] in [Preferences].
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T
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i Shilfta W

e —
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2. Select the file to import and check the toolchain to import when the toolchain fo the file is

displayed.

e

It the name of the toolchain to import is duplicated with the existing toolchain name, the status of export

becomes “Need to configure”. The name of the toolchain to import can be modified in [Select how to
resolve] window shown when clicking the [Next] button.
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8. Create a Project

Checklist before creating a project

Since Controller Tester is a tool that detects errors by actually executing source codes, the source code
under test must be executable. In other words, the source code under test must be buildable for normal
testing.

Before creating and testing a project, you need to set up a ‘toolchain’ that takes into account the
development environment of the target software. Please refer to Set a toolchain for details.

Controller Tester automatically generates a stub if the target object to link does not exist during the build
process. However, the automatic test stub generation feature may have limitations in performing tests,
so it is recommended to prepare an appropriate test strategy in advance.

Create a project
To create a Controller Tester project, execute [Create a Project wizard].

Select [File] -> [New] or click the shortcut icon.

File Edit Search Project Target Window Help

Mew > C/C++ Project with Source Files
Close CirlsW @ C/C++ Project from Embedded(CodeWarrior, Green Hills, NEC)
Close All Chrl+Shift=w A C/C++ Project from Visual Studio Project
B C/C+~ Project from Existing CodeScroll Project
Save Ctrl+S L .
mave i Create a C/C++ project with CPI File
Save All Ctrl+Shift+S | . ) . : )
@i Create a C/C++ project with Build Information
ename. 2
Renamme... e =i Other.. Cirl+N
Refrash F5

The following types of project creation wizards are provided.

e C/C++ Project with Source Files

Creates a project by selecting the source file directly.
+ C/C++ Project from Embedded
Creates a project by using an embedded project file.

« C/C++ Project from Visual Studio Project

Creates a project by using Visual Studio dsw, sin, vcxproj and veproj files.
» C/C++ Project form Existing CodeScroll Project

Creates a project by using the CodeScroll project created previously.
» Creates a C/C++ project with CPI File
Creates a project by using project creation information located in a CPI file.

* Creates a C/C++ project with Build Information

Creates a project by using a makefile and build script.
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Create a project with C/C ++ source code files. The user needs to enter the necessary information to

build the source code.

1.

Enter the project name in [Project name].

[ [ —
IWew Project
Coeale ab POt
Fiighi® naeee
Locataon CACTIO

Sebert Toobihgen

Dol Tookbain Mase

GOCAT (e
G 3 O]

= (B2

Automatically ganarated.
difinmatiialy generdind

Lesachain Setieg

Cancel

In [Select Toolchain], select the toolchain to use in the project. If there is no created toolchain,

create a toolchain through [Toolchain Setting]. Please refer to Set a Toolchain for details.

Click the [Next] button to move to the next screen. If you click the [Finish] button, an empty project

containing no source file is created.
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. Mew Project O *

New Project

Choose source files

Top Directory: |P:WExampIe_PrDjecth‘#maszlibJ.2.8 | Browse...
Directory File
v [m]zlib-1.28 2 |t}-‘|se filter text |
» [ sefttings
s []amiga adler32.c ~
s [] as400 COMpress.c
s [] contrib crc3z.c
» [ dec deflate.c
s [] examples gzclluse.c
5[] msdos gzlib.c
> [ nintendods gzrea_d_c
> [Jold gzwrite.c
» [ gnx infback.c
s [ test inffast.c
s [ watcom inflate.c
s [Jwin32 w inftrees.c o

Text file written list of source files

| Browse...

¥ The entered text file is separated by ' or newline character. Remove

15 itemns selected

* You can select the source file directly, or through a text file with a file path.

4. Select source files directly.

a. Click [Browse ...] to specify the [Top Directory] to be displayed in the directory screen

below.
* Except in special cases, make the directory one level higher than the directory
containing the source files you want to select as the top-level directory.

b. On the [Directory] screen shown on the left, select the directory containing the source files
to be used for project creation.

c. The files in the selected directory appear on the [File] screen shown on the right. Check the
files to add.

5. Select by using a text file with the file paths.
a. On the [Text file written list of source files] screen shown below, click [Browse ...] to select a
text file with a list of source files(absolute file path).
b. Clicking the [Remove] button deselects the selected text file and the source file selected
through the file.

6. After all settings are completed, click the [Finish] button to create the project.

Page 27 of 249



Suresofttech User Manual - 3.3

8.2. C/C++ Project from Embedded

Create a project with an embedded project file(.xml, .gpj, .prw, .prj). Except in special cases, the

information required for the build is automatically entered, so there is nothing to specify by the user.

B rew Project ] X

New Project

Create new project from CodeWarrior project file(*.xml), Green
Hills MULTI project fil(*.gpj)

Project name: |embedded |
Location: | P:#Product Workspacettct_3_1_02 |
Select Toolchain

Default Toolchain Name Description
[] CPP_TI_TMS320_6000_SoC_lUnit

[ GCC 4.7 (32bit)

[l GCC 5.3 (32bit)

[ Micrasoft Wisual Studio 2010 (32...

[ Micrasoft Wisual Studio 2010 (32...

[ Micrasoft Wisual Studio 2015 (32...

[ Microsoft Wisual Studio 2015 (32...

O gces

iar

Toolchain Setting

Import Setting
Embedded Project File: | |ﬂrow5e...|

< Back Next = Finish Cancel

Enter a project name in [Project name].

2. Choose a toolchain that fits the embedded project you select.

3. In [Import Setting] -> [Embedded Project File], specify the embedded project file of the software
under test.

4. After completing all settings, click [Finish] to create the project.
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Create a project with a Microsoft Visual Studio project file(.dsw, .sIn, .vcxproj, .vcproj). Except in special

cases, the information required for the build is automatically entered, so there is nothing to specify by the

user.

. MNew Project

New Project

Create C/C++ Project from Visual Studic Project. (dsw, sln,
NCXproj, veproj)

Project name: |sample
Location: | P¥Product_Workspacewct_3_1_02
Import Setting
Visual Studic Project: |P:WExampIe_PrUﬂecthanip‘ﬁlcpfew:pfe.sln ‘Browse...!
Advanced
| nets cocs

1. Enter the project name in [Project name].
2. Specify the Visual Studio project file to import in [Visual Studio Project].

3. If there are values that must be set before calling the compiler of the toolchain to be registered,

add a script file to set the values to [Advanced]-> [Environment Script File].

4. Click [Next] to move to the next screen. When you click Done, module settings are randomly

selected for the imported Visual Studio project.
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. Mew Project O *

New Project

Create C/C++ Project frem Visual Studic Froject. (*.dsw, *sln,
*VCKProj, *.veproj)

Select Active Modules:

Active Module Configuration (Click to Edit)
misci¥mk_errinfo Debug|Win32
srcwdispidisp Debug|win32
srcfe Debug|win32

Select All | | Deselect All Set All Cenfigurations...

LiBek [ Meds Cancel

5. Select the module to be activated from the modules included in the Visual Studio project.
6. Select the configuration of each module.

+ [Set All Configurations ...] allows you to change the configuration for all modules in a batch.
7. After all settings are completed, click the [Finish] button to create the project.
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8.4. C/C++ Project form Existing CodeScroll
Project

Import an existing CodeScroll project and create a new project with that information. You can easily
create a new project with the same configuration(source file, exclude/include analysis, compile flags) as
the existing project.

B rew Project O *

Import Projects =

(v, If the project of the same name exist, the '_copy’' is added after the name ; y
of the project. |

Select root directory: | P-#Product_Workspacettct_3_1_02 v|

Projects:

[zlib_build]MotLinked (P:#Product_Workspacewct_3_1_02%#[zl A select All
[zlib_build]example (P-#PFroduct_ Workspacewct_3_1_02%(zlib
[zlib_build]minigzip (P:¥Product Workspacetet_3_1_02u(zlit Deselect All
[zlib_build_project]NotLinked (P-#Product_ Workspacetct_3_1
[zlib_build_projectlexample (P #Product_Workspacettct 3.1 (
[zlib_build_projectiminigzip (P:#Product_Workspacewtct_3_1_
cpfe (P:#Product_Workspacettct_3_1_02%cpfe)

stub_sample (P-#Froduct_Workspacewct_3_1_02%stub_sampl
target (P:#Product_ Workspacetct_3_1_02#target)

zlib (P:#Product Workspacewtct_3_1_02%zlib) v

Refresh

= Back Mext = Cancel

1. Use the [Browse ...] button to select the CodeScroll workspace or CodeScroll project path.
2. Projects existing in the selected path are displayed in the [Projects] list.

+ When the CodeScroll workspace is selected, all the projects under it are displayed.
3. Click [Finish] to create the project.
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8.5. Create a C/C++ project with CPI File

Create a project from a CPI file. The CPI file is an information file for project creation in the command

line interface.

The CPI file must be created by the user using the template file in the {installation path}\plugins\
com.codescroll.gp.cli_x.x.x.x\cpi folder.

B rew Project ] X
New Project
Create C/C ++ project from the CPI file (* .cpi) information.
Location: |P:wproduct_WDrkspaceWct_S_L{}E |
CPI file
File: | | Browse(B)...
= Back Mext = Finish Cancel

1. Select a CPI file with the [Browse...] button.
2. Click the [Finish] button to create the project.

* You can also create a project by dragging and dropping a CPI file into the test navigator.
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8.6. Create a C/C++ project with Build
Information

Create a C / C ++ project from build information. The project is created as many as the number of
modules extracted from the build information.

1. Enter a project name in [Project name]. The final project name is determined by combining the
entered project name with the module name extracted from the build information.

» Ex) [Project name]Extracted module name
B new Project O X

New Project

Create C/C++ Project from Build Command. (2.g. makefile or build script)

Project name: |z|ib_bui|d_prcject |

Location: | P:#Product_Workspacettct_3_1_02 |

Select Teclchain

]
5]
ar
c
=

Teelchain Name - Diescription
CPP_TI_TMS320_6000_SoC_Unit

GCC 4.7 (32bit)

GCC 5.3 (32bit)

Microsoft Visual Studio 2010 (32bit)

Microsoft Visual Studio 2010 (32bit_64bit)

Microsoft Visual Studio 2015 (32bit)

Microsoft Visual Studio 2015 (32bit_g4bit)

gces

iar

OoooOoooroOod

Toolchain Setting
Import Setting
Build Command:

make clean al|

Build Directory: PwExample_Projectwcmamwzlib-1.2.3 Browse...

Mote: The final project name is determined by combining the entered project name
with the module name extracted from the build information. (e.g. [project name] extracted module name)

Advanced

< Back Mext > Cancel

2. Choose the same toolchain as the compiler you use for the build.
3. In [Import Setting]-> [Build Command], enter the command required for the build.
» Ex) Make all / make clean
4. Specify the path where the makefile is located in [Import Setting]-> [Build Directory].
5. If there are values that must be set before calling the compiler of the toolchain to be registered,
add a script file to set the values to [Advanced]-> [Environment Script File].
6. After completing all settings, click [Finish] to create the project.
7. When the project creation is completed after building, the result screen appears.
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B Create 2 C/C+- project with the build informaticn X

The C/C++ project(s) has been generated with the build informaticn.
(If 3 project with the same name already exists, skip it in project creation)

Result:
Project name State

i [zlib_build_project]MotLinked SUCCEsS
[zlib_build_project]example SUCCess
[zlib_build_project]minigzip SUCCESS

» Success: Project creation complete.

« Error: If the creation failed due to an error during project creation.
+ Exclude: If the same project name exists in the workspace.
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Generate test data and test code to test the functions of the source code. You can create individual tests

for each function.

Create unit tests

Generate test data and test code for each function under test.

1. Select the project or module to create unit tests, right-click and click the [Create Unit Test] menu.

'TE Test Mavigator &3 = <«’==:>
3 ctub_sample
[ target
y (=5 7lih
>0 Mew 4
>
i : % Delete Delete
5 1 Rename... F2
o= Import...
3 Export.
Refresh F5
Close Project
Quality Management Tools »
®  Run Target Test
24 Import Target Test Log >
Collect project leg
Create Unit Test...
™ Run Test F11
% Rebuild and Run Test
Run RTV Test Alt+F11
Reanalyze
Merge Project coverage...
Properties Alt+Enter

= =

2. After the analysis is finished, in [Select function to be tested], select the function to perform the

unit test.

B new Test

Select Function to be tested
Select Function to be tested.

o x

e

Project: [RTV_project

]

Selection type: | Source file v

type filter text

[ adler32.c
[ compress.c
O erc32c
[ deflstecc
0O gzclosec
O gdib.c

O gzread.c
O gzwrite.c
[ infoackc
[ inffaste
[ inflatec
[ infreesc
[ treesc

O uncompr.c
O zutilc

Run option
[JRun after Test Creation

Host RTV

|[type filter text ]
[ adler32(unsigned long, const unsigned char
[ adler32_combine(unsigned long, unsigned Ic|
[J adler32_combineé4(unsigned long, unsigned
[] sdler32_combine_(unsigned lang, unsigned |
[ adler32 z{unsigned long, censt unsigned chd

< >

0 items selected

Finish Cancel

B new Test [m] X
Select Function to be tested
Select Function to be tested E =

Project: | RTV_project

Selection type: v
| Name | path |~

—

O

@ adler32(unsigned long, const unsigned char *, un... [) adlers2.c
@ adler32_combine(unsigned long, unsigned long, .. [E adler32.c
@ adler32_combine64 (unsigned long, unsigned lon_.. ] adlera2.c
@ adler32_combine_(unsigned leng, unsigned long, .. [ adler32.c
@ adler32_z(unsigned long, const unsigned char *, ... [E adler32.c
© compressiunsigned char *, unsigned long *, cons... ) compress.c
@ compress2(unsigned char *, unsigned long *, con...| £ compress.c
@ compressBound(unsigned long) (5 compress.c

W N O e W e
O|ooon

9 (] |@ crc32(unsigned long, const unsigned char %, unsi__. (5] cre32.c

10 | [0 |e crc32 biglunsigned long, const unsigned char *, ... [ erc32.c

11 ] |®@ cre32_combineunsigned long, unsigned long, si... [E cre32.c

12 ] |@ cre32_combinesdiunsigned long, unsigned long, . B cre32.c

13 [ | cre32_combine_(unsigned long, unsigned long, si... B cre32.c

14 @ cre32 little(unsigned long, const unsigned char *... [ ere32.c

15 ] | @ crea2 z(unsigned long, const unsigned char *, u_ |5 cre32.c -

0 items selected
Run option
[JRun after Test Creation
Host RTV

Finish Cancel
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a. You can filter the function under test using [type filter text].
b. You can use the [Selection type] combo box to select the function to be tested based on the
source file or function.
You can easily select and deselect all functions under test with the right-click menu.
When [Run after Test Creation] is selected, the test is executed after the test data is
generated.
3. Click [Finish] to create the unit test.

Create and run tests

The [Create and Run] function allows you to create and run unit tests at once without using the [Create
Unit Test] function.

1. Select the function to be tested in the test navigator and right-click.

Ty Test Mavigator BEE v =
13 stub_sample Py
17 target

v g zlib
v (g Default Module

v [ adler32.c

@ adler>

@ adle Create Unit Test
> Q compre: Create and Run
> L erez2ce
> Lg deflatec
> g gzioc
> L infbackc

s [i2 inffast e

2. If you select the [Create and Run] menu, it creates a test for the target function and then runs the
test.

Create an integration test

You can use the toolbar menu to create an integrated test.

Unit Test Integration Test = & & | 2 EH~- =0
m v Statement Coverage
0,
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
MName Result Coverage
v INTEGRATION_@ 33/0/0) 33 100.0% 12/72
v [1est] adler32_combine(unsigned long, unsigned long, signed 11/0/0) 11
case] 1
case] 2
case] 3
case] 4
case| 5
case] 6
case| 7
case] 8
case] 9
case| 19
case| 11

The integration test name is automatically assigned and can be changed using the [Rename] context
menu.

Page 36 of 249



Suresofttech User Manual - 3.3

Unit Test IntegrationTest] Bl @ EE = o
m | v Statement Coverage|
0,
(33/0/0) 33 43.0%
(1719/3995)
type file, test, state, issue
Mame Result Coverage
v @ INTEGRAT Create Test. i (33/0/0)33 100.0% (12/12)
v [ ad) Create sup- I Rename o x !
1
] Copy Mew name: |
€8s
te] Paste
4
1 Duplicate
{ Duplicate m | oK | | Cancel ‘
] Paste as sub
[CE5E1 { 9¢  Delete Delete
s
o Remme. R
] Select Test
» [(fest] adl g, signed 11/0/0) 11
Deselect Test
» [(Eest] adl g, signed 11/0/0) 11

Generate binary for debugging
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The test editor can be opened by double-clicking the test or test case in each test view, located at the
bottom of the unit/integrated test view.

Unit Test

BB E- =0

~  Statement Coverage

0,
(19/0/5) 24 2.9%
(118/3995)
type file, function, test, state, issue
MName Result Coverage Q
~ @ adler32(u g (8/0/3513 97.0% 10002
> dler32 in:i ar *, unsig 8/0/513
v > adler32_combine(un 1707011 100.0% (12/12
v [ i8S > adler32_combine(uns i 11/0/0)11
v
k| adler32{unsigned long, const u_. 52 = B8
Test Info (zlib/adler32_test0) e B
Test Structure Q, Test Info Edit
Test structure using a tree view and edit the infermaticn in the test. |Change the notaticn edit the partition @
Name In | Out = Set Numeral System
Test global code @® 10 Numeral System O 16 Mumeral System
User code
Global Variable Variable Partition
~ Test target function
v @ adler32unsigned long, const unsic ‘M‘“ | - ‘M"X
Local Static Variable “Sm e value
v Parameter/return g
~ o adler : uleng Fartition List
o adler : unsignedlong M [ 0"
v o buf - const Bytef * e
v o [0] : Bytef 315
v o [0] : Byte g
o [0] : unsignedc ™ [ v 1755517 ©

Test Info ‘ Test Case ‘ Test Code ‘ Configuration ‘

i 142M of 1032M E

«¥s You can move the editor and open it in a separate window.
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The Test Information tab is a feature that presents the test code as a tree of test structures, making it
easy for users to modify the test code.

|| adler32_combine{unsigned long,... &3

= 0
Test Info (zlib/adler32_combine_test0) EY By
Test Structure Q, = Test Info Edit
Test structure using a tree view and edit the information in the test. Change the notation edit the partition L
Name In | Out 2 Set Numeral System
Test global code (® 10 Numeral System () 16 Numeral System
User code
Global Variable Variable Partition
v Test target function
v @ adler32_combine{unsigned long, u [Min | ~ [max || Add
Local Static Variable |Sing|e Value ‘ Add
~ Parameter/return
v o adlerl - ulong Partiticn List
o adler : unsigned long | "o Delete
v o adler2 : ulong "1 ~E5520"
o adler2 : unsigned long O "§5521" Default
o len2 : long O "65522~131041"
v of retumvar - uLeng v "131042" v
Test Info| Test Case| Test Code Configuration|

» User code can be inserted into the test code.

* You can control global variables related to the function under test.
* You can control the input and output of the function parameters and return values.

You can enter the code to be executed just before calling the function under test.

Repeat function calls

You can have the function under test be called multiple times.

[ adler32_combine(unsigned long, . 52

=0
Test Info (zlib/adler32_combine_test0) A
The information has been changed after executing the test.
Test Structure \ @ g Test Info Edit
Test structure using a tree view and edit the information in the test Test target function
N O -
el L e Iteration count: [5 [=
Test global code
User code
Global variable
~  Test target function
~ & adler32_combine(unsigned long, u
Local Static Variable
- Parameter/return
v o adlert : ulong
o adlerl - unsigned long [ . B _
v o ader2 : ulong E| ader32_combiny janed long, .. &2 B8
o adler2 : unsigned long ‘ "
o len2 : lon = . N . .
B 9 34 for(cs_index=0;cs_index<s;cs_indexs+){
<" retumvar - ulong Bl s
Test Info | Test Case| Test Code| Configuration| “ uLong [5] adler32_combine(unsigned long, unsigned long, signed long)
returnvar[cs_index] = adler32_combine(adlerl,adler2,len2);
}

/*0utput*/
CS_VINT_QUTPUT(returnvar[@], "returnvar[e]”);

b_configuration()*/
teste_stub_configuration();

sa }
s

52 gendif

Test Info Test Case Test Code Configuration

Change detection

If you edit and save the information of a test that has already been executed, “The information has been
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changed after executing the test.” is displayed at the top of the test editor.

k| adler32_combine{unsigned long,... &%
Test Info (zlib/fadler32_combine_testd)

The information has been changed after sxecuting the test.
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10.2. Test Case

Test cases provide the ability to edit inputs for a function under test and the expected value for the
execution result.

] adler32_combine{unsigned long,... 2 = 8
Test Case (zlib/adler32_combine_test0) #1 Q. BlEl = - =
Parameter Type Input Expected Value  Host Output Target Cutput ~
Local Static Variable
v Parameter/retumn
~ o adler
o adler! unsigned long 65520
v o adler2
o adler2 unsigned long 131041
o len2 long 2147483647
v o returnvar
o returnvar unsigned long 4279500767

Before call code
After call code
User code
. Stk v
< >

» More Info

Test Info | Test Case | Test Code | Configuration

In the test structure tree, you can enter input values for the variables specified as input.

o If there is no input value, the value of the variable is ‘undefined value’, and the tool
initializes the variable with no value entered as 0 (Blank if a string) for the
convenience of the user.

* You can switch the representation of the test structure as a table or tree with the [Show as Tree],
[Show as Table] toolbar menu.

* With the [Apply the test case in a lump] context menu, you can apply the input and expected
values of the test case to other test cases in the same test at once.

» If you select the ‘Out’ of a variable in the test structure tree, You can check the value of the
variable after the test is performed.

» Editable cells are displayed in a pale sky color.

+ If the expected value is different from the host/target output, it is displayed in blue.

* You can use ~ (range) and logical operators! (Not), & (and), and | (or) in expected values.

» The following shortcuts are available.

o Move row: arrow keys (1, |)

o Editable cell focus: Enter

o Editable cell focus out: Esc

o Move column (editable cell): Tab (right), Shift + Tab (left)

Change detection

If you edit and save the information of a test case that has already been executed, “The information has
been changed after executing the test.” is displayed at the top of the test editor.

k| adler32_combine{unsigned long,... &3
Test Case (zlibfadler32_combine_testd) #1

The information has been changed after executing the tast
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You can check the test code by clicking the Test Code tab in the test editor.

I adler32(unsigned lang, const u.. 5

test@ics_error o

factory/factory.h"

le "adler32_testd.h"

Test Info | Test Case | Test Code | Configuration |

If the user edits and saves the test structure tree, the changes are automatically reflected in the
test code.

If the return type of the function under test is a primitive type, a macro that outputs the return value
is automatically generated.

If you want to modify the test code yourself, you must switch the test to unmanaged code.
The test execution function must have a return type and an input parameter of a void type.
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On the configuration tab, you can make various settings for unit testing.

] adler32_combine{unsigned long, .. 53
Configuration(zlib/adler32_combine_test0)

Test Name

|hd\ersz_c:mbinelunswgned leng, unsigned long, signed long)_0

Description

Set related file

P:#Example Projectcirdipwzlib-1.2.3%adler32.c Search..

Run Test

Test Case Timeout(Second) l:|

# If the time-out value is empty, run the time-out value of the project.
[ maintain test case context

Change Unmanaged Code |

Test |ﬂfD‘TESf Ca.se‘Test Code | Configuraticn

« If you modify and save the test name, the test name that appears in the unit test view changes.

* You can enter a description for the test.

+ With the related file settings, you can select the file to which the function under test belongs.

* You can set the timeout for the test.
* You can choose whether to keep the context for the test.

+ If you want to write test code yourself, you need to do [Change Unmanaged Code].
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10.5. Test Macro

Controller Tester provides several macros to help users write test code more easily. You can check and
write the macro provided using the “[Ctrl] + [SPACEBAR]” shortcut in the editor view.

ASSERT macro

Examine the conditional expression and print the success/failure in the test case view.

Macro Parameter
CS_ASSERT(_b) _b: conditional expression

_B: conditional expression

CS_ASSERT_MSG(_B, _msg) _mgs: message to print when the conditional expression is false

Output macro

Print the values of specific variables in the test case view.

Macro Parameter

_V: Integer variable
s: test data name

CS_INT_OUTPUT( v, _s)

v: unsigned integer variable

CS_UINT_OUTPUT( v, _s) o test data name

v: real variable

CS_FLT_OUTPUT(V, _8) "~ st data name

v: char* or char[] variable

CS_STR_OUTPUT( v, _s) _s: test data name

Input macro

Pass test data to the function under test.

Macro Parameter

_t: integer type name

CS_INT_INPUT(L, _s) s: test data name

_t: unsigned integer type name

CS_UINT_INPUT(L, _s) s: test data name

_t: real type name

CS_FLT_INPUT(L, _s) s: test data name

CS_STR_INPUT(_t, _s) _t: char* or char[] type name
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_s: test data name

! Input macros cannot be used in stubs for target testing.

Address-related macros

If there is a part that directly assigns or fetches the value in the embedded address in the converted
source code, it may not operate normally when executed on the local computer. In this case, you can
use an address-related macro for the virtual address.

Macro Description

CS_VIRTUAL_ADDR( b, e) Creates the space from the address (_b) to the address (_e)

CS_ADDR_ASSIGN( t, a, v) .
CS_ADDR_SET( t, a, v) Assigns the value (_v) of type (_t) to the address (_a)
CS_ADDR_GET(_t, a) Fetches the value of type (_t) from the address (_a)

CS_VIRTUAL_ADDR_CLEAR() Frees the memory space created

Address-related macro example
// Create virtual memory area from @xFFE48888U to 188,
C5 _VIRTUAL_ADDR(@xFFE4B888U,8xFFE4BRREU4+1RE) ;

// 18 allocation of type int to @xFFE48808U.
CS_ADDR_SET(int,@xFFE40008U,18);
C5_ADDR_ASSIGN(int,@xFFE4@@88U,18);

/f The value of exFFE4@@@BU is assigned to the variable a.
a = C5_ADDR_GET(int,@xFFE48888U);

Other macros

Macro Parameter Description
CS_LOG(_msg) _msg: log message Outputs user log
CS_TESTCASENO() Returns the number of the test currently running
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Testing can be performed in a variety of ways.

Run all tests

Run the selected tests in the [Unit Test] view and [Integration Test] view.

1. Select the project to run the test, right-click ans slect [Run test]

Tq Test Mavigator 1% =5
3 stub_sample
3 target
1= 7lih
1 New >

Delete Delete

x

1
1
1 Rename... F2

Import...
Export...

G E

Refresh F5
Close Project

Quality Management Tools »

®  Run Target Test
24 Import Target Test Log >
Collect project leg

Create Unit Test...

™ Run Test Fi1
% Rebuild and Run Test
Run RTV Test Alt+F11
Reanalyze

Merge Project coverage..

Alt+Enter

Properties

- = "

2. A progress monitor of the test opens. When the test is completed, you can check the results

through each test view.

Run unit tests

Run the selected unit tests in the [Unit Test] view.

1. Click the [Run] button on the dashboard in the [Unit Test] vie

Unit Test

type file, function, test, state, issue

(655 /0 / 283) 938

W.

He B> ¥ = 08

v Statement Coverage

2. A progress monitor of the test opens. When the test is completed, you can check the results

through each test view.
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* To perform only a specific test case, select the test case you want to run and right-click

the mouse and click the [Run Test Case] menu.

Run integration tests
Run the selected tests in the [Integration Test] view.

1. Click the [Run] button on the dashboard in the [Integration Test] view.

Unit Test Integration Test R4 L@ & Y= 0O
v Statement Coverage

Lo ;
(33/0/0) 33 43.0%
(1719/3995)

type file, test, state, issue

2. A progress monitor of the test opens. When the test is completed, you can check the results

through each test view.
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If an error occurs while running the test case, you can use the [Inspect Debug Info] function to determine

the cause of the error.

[Inspect Debug Info] function can be checked in the unit test view with the context menu of the test case.

Copy

Paste

Duplicate

Duplicate multiple times...
¥ Delete

Add Test Case
Host Cutput Value -= Expected Value
Target Cutput Value -= Expected Value

™ Run Test Case
&  Run Target Test Case

o Add Stub_

Open Host Error Loaction

; Inspect Drebug Info

Ctrl+C
Ctrl+v

Ctrl+D

Delete

* Before executing the test case, the test case is automatically executed before performing

[Inspect Debug Info].

When [Inspect Debug Info] is performed, debug information is displayed in the [Inspect Debug Info].

% Debug Information &2
Test Case (test/func_test0) #1

Stack trace:
~ o [Project: test] test run
= func3(signed int *) at test1.c:42
= func2() at test1.c:30
= func(signed int) at test1.c12

6= = 3
List of variable/expression:
Variable/Expression Value Location
p (testl.c: 40) 12319812 before line

The test case (Debug info included) is displayed in the test case where the [Inspect Debug Info] was

performed.
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w test()

v [ (1851 test() o
1 signaled (Debug info included)
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13. Properties

Controller Tester provides a page to set the properties of the project, module, and source files
(translation unit).

The property page types are:

* Project Properties

* Module Properties

» Source File(Translation Unit) Properties
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13.1. Project Properties

You can edit the properties of the created project.
Select [Project]-> [Properties] from the menu or right-click the project in the Test Navigator view and
click the [Properties] menu.

Inclusion and Exclusion Info

You can set what to exclude or include when analyzing the project.

* To analyze only selected directories or files, add the targets to be analyzed to [Included]
and check [Exclude All].

B Properties for zlib m] x
Inclusion and Exclusion = v
Inclusion and Exclusion
. Included
Info
» Target test Add File.
Test
’ Add Directory...
Edit
Remove
Excluded

5 CwWProgram FileswCodeSerell Controller Tester 3.2#Wpluginsi¥com.codescroll Add Eile.
5 pwProduct_Workspacewct_3_1_0714zlib# csdata

P WorkspacewTarget_PlatformetOxygentwindowss. #. 4. u-4-2-br_news 433 sy

Edit...

Remove

< >
[ Exclude All

Mote: If there is cne resource in beth places, the resource is inclusion item.

Apply and Close Cancel

» Add targets to include in the analysis.
1. Click the [Add File] or [Add Directory] button.
2. Select files or a directory to analyze.
3. Click the [Open] or [OK] button.

* Add targets to exclude from the analysis.
1. Click the [Add File] or [Add Directory] button.

2. Select files or a directory to exclude from the analysis.
3. Click the [Open] or [OK] button.

Info

Shows brief information(path, type, location) about the project.
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B Properties for zlib

type filter text

Inclusion and Exclusicn
Info

» Target test

» Test

a
Info = =R
Project Infermation
Path: /zlib
Type: Project

Location: P:/Product Werkspace/ct_3_1_02/zlib

Apply and Close Cancel

Virtual Address

You can select a memory setting managed by the Virtual Address preference.

B Properties for zlib

type filter text
Inclusion and Exclusicn
Info
» Target test
v Test
Exclusion of coverage
External Command

Run Test
Virtual Address

> Generate test cases automatically

Virtual Address Lo

Configuration name: |}

Detail information

Begin End

Apply and Close Cancel

External Command

You can enter external commands to run before or after the test run.

User Manual - 3.3

In [Pre-command for test run], you can enter a command or batch file to execute an external command

before running the test.
In [Post-command for test run], you can enter a command or batch file to execute an external command

after running the test.
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B Properties for zlib O x
type filter text External Command fror
Inclusicn and Exclusion
Info Pre-command for test run
» Target test [ P#Example_Projecticivdipszlib-1.2.3#rebuild bat |
v Test Post-command for test run
Exclusion of coverage - - — -
External Command |P.'n\‘Btample,ProJecthwdlszhb-1 2.3#rebuild.bat |
» Generate test cases aut
Run Test
wirtual Address
< >
Apply and Clusel | Cancel

Exclusion of coverage

You can set coverage exclusions on a per-file or per-function basis.

User Manual - 3.3

You can see that the coverage of the excluded function is excluded from the coverage results obtained

by running the test.

B Froperties for zlib m] X
type filter text Exclusion of g =10 NI 2 4
Incl d Excl
‘:f(DUSIDﬂ ane Bclusion The list of resources excluded coverage.
5 Target test The list of files excluded coverage.
v Test Source File Add...
Exclusion of coverage
External Command Remove
» Generate test cases aut
Run Test
Virtual Address
The list of functions excluded coverage
Functicn Source File Add
Remove
< >
Apply and Clmel | Cancel
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Run Test

Set the generated tests to run in a user-specified directory, not in a workspace. In this case, you do not
need to copy the library or header files used by the target under test to the workspace or change the link
settings.

Click the [Start Test in User Code] checkbox.
Select the home directory to run the test and click the [Apply] button.

B Properties for zlib [m} X
type filter text Run Test f=T - -
Inclusicn and Exclusicn
Info [[] Start Test in User Code
Target test
g Test Launch Directery : | | Browse...

w Test
Exclusicn of coverage
External Command
Generate test cases au [ Maintain test case context

R}-'” Test [ Redirect standard output or standard error
Virtual Address

Test Case Timeout(Second) |3 =

Restore Defaults Apply

Apply and Close Cancel

[Test Case Timeout] Set the time to be used as the timeout judgment when executing the test case. If
the test execution time exceeds the test case timeout time, the test for that test case ends and the result
is reported as a timeout.

[Maintain test case context] is a feature that performs all test cases with one launcher. The previous test
execution result (static, global variable) is maintained during the test, and each test case result value
does not appear independently. This makes the relationship between the test case result values clear.

[Redirect standard output or standard error] is a feature to record standard output and standard error in
the log file for each test case.

Generate test cases automatically

You can set to keep previous test cases when automatically generating test cases.

! The search-based generation is not affected.
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B Properties for zlib

type filter text
Inclusien and Exclusien
Info
Target test
v Test
Exclusion of coverage
External Command

Run Test
Virtual Address

Generate test cases automatically

test cases ically =4 - v

Generate test cases automatically
Keeping the previous test case when auto generating test cases
% Search-based generation is not affected.

Restore Defaults

Apply

Apply and Close Cancel

Combination

You can set up how to extract test data if the variable partition is range.

B rroperties for zlib m] X
type filter text Combination [ER R
Inclusion and Exclusion
Info Create Test Data from Partition
Target test Max
w Test Min
Exclusion of coverage [IRandom
External Command
~ Generate test cases aut Data Combination
Combination (®) Flat Combination
Function Generater () Pairwise Combination
H I
search-based (Cs L Mumber of Limit: |2E-C |
Run Test
Virtual Address (O Random Combination
Mumber of Test case: |5 |
Array elements
(®) Generate array of the first element (O Generate array of all the elements
Generate global variable
[ Create global variable in the relationship between function calls.
P 3 Restore Defaults Apply
Apply and Close Cancel

User Manual - 3.3

Select the desired test data extraction method by checking the checkbox. The meaning of each value is

as follows.
Method Description
Max value Selects the maximum value of the partition section.
Min value Selects the minimum value of the partition section.

Random value Selects a random value among partition sections.

You can select multiple test methods of data extraction.

When all are unchecked, the default is automatically set to the maximum and minimum values.

[Data combination] supports Flat, Pairwise and Random. The meaning of the combination is shown in
the following table.

Combination Description
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Flat Combines simply based on variables having the largest number of test data.

Combines so that each selected parameter data is paired at least once with the parameter
data other than itself.

Pairwise is performed as many as the maximum number(default 200) of symbols used for
the combination, and when the number of symbols is exceeded, Flat is performed.

Pairwise

Combines the test data as many as the number of test cases that the user defines any value
Random between the minimum value and the maximum value for the variable partition of input
parameters(default 5).

[Array elements] is a feature to select how to generate test data for each array element.

Method Description
Generate an array of the first element Creates only the first element regardless of the array size.

Generate an array of all the elements Creates elements as much as the array size.

When creating a test, global variable creation is an option to create all global variables used by all
functions called from the function under test.

Search-based (CS Labs)

es CS Labs allows you to preview new features that will be released in CodeScroll tools
later. Based on feedback for the new features, CS Labs features may or may not be
applied as formal features.

You can set the maximum search when automatically generating test cases based on search.

. Properties for zlib [m] X

type flter text Search-based (CS Labs) Grery
Inclusien and Exclusien
Info General settings for maximum search

Target test Number of searches(for each branch case). |LD-C |
v Test

Exclusion of coverage
External Command

Search time (seconds) |3EE |

~ Generate test cases automatically
Combination
Function Generator
Search-based (CS Labs)
Run Test
Virtual Address

< N Restore Defaults Apply

Apply and Close Cancel

Option Description

Number of searches(for each Searches for the number of times entered for each branch
branch) combination.

Search time(seconds) Searches for the time entered.
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When using the function generator to automatically generate test cases, specify common setting values

that each function has in common.

B properties for zlib

type filter text
Inclusion and Exclusion
Info
» Target test
v Test
Exclusion of coverage

Function Generator

Sample interval |D

Sample count: |D

Start value: |D

External Command
~ Generate test cases automatically
Combination
Functicn Generator
Search-based (CS Labs)
Run Test
Virtual Address

Restore Defaults Apply

Apply and Close Cancel

Option Description
Sample interval Interval of samples when sampling from function

Number of samples when sampling from function

Sample count (Number of test cases)

Start value Default value at which the function starts, and generates a value based on the value

Import settings

Project created by Visual Studio project

- Properties for cpfe [m] X
type filter text Import =R - -
Import
Inclusion 2nd Exclusicn Visual Studio Project: P:#Example_Projectwcinvipwcpfewcpfe.sin
nfo Select Active Modules:
» Target test
5 Test Active Module Configuration (Click to Edit)
misc#mk_errinfo Debug|win32
sreswvdispidisp Debug|win32
srcwfe Debug|Win32
Select All | | Deselect All Set All Configurations.
Restore Defaults Apply
Apply and Close Cancel

You can see the path of the Visual Studio project used for creating the project and the modules active in
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the selected project.
You can change whether each module is active or not and the configuration.
You can change the configuration of all modules collectively through the [Set All Configurations] menu.

1. If you click the [Set All Configurations] button, a dialog box where you can select one of the
configurations common to all modules opens.

- Set All Configurations O x

Commen Configurations:

[ Debug|win32

conc

2. Select the configuration to be applied to all modules in common and click the [OK] button.
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Build

You can set toolchain related information (toolchain, linker) and link flags for the module. Changing the

toolchain also changes the toolchain set in all source files(translation units) under the module.

B Properties for Default Module O
y Build < e
Build
. ) Select a teclchain
Compile flag —
Default Teelchain Mame Description
O CPP_TI_.TM5320_6000_SoC_Unit
O GCC 4.7 (32bit)
GCC 5.3 (32bit)
[l Microsoft Visual Studio 2010 (3...
O Micrasoft Visual Studio 2010 (3...
O Micrasoft Visual Studio 2015 (3...
O Micrasoft Visual Studio 2015 (3...
O gees
O iar
Linker: gec.exe ~
Link Flag:
Undo Redo Find/Replace...
Restore Defaults Apply
Apply and Close Cancel

Compile flag

You can set compile flag information for that module.
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. Froperties for Default Module

type filter text
Build
Compile flag

m} X

Compile flag (=T g -

Note: The compile flag informatien is saved in all source files set to use a parent compile flag.

Overwrite all sub source files

Command Include Define Macro

Undo Redo Find/Replace.

£2g Import.. &5 Export...

Apply and Close Cancel

User Manual - 3.3

+ [Overwrite all sub source files] overwrites the compile flag entered to all source files (translation

units) under the module.

« [Import] imports an external compile flag. [Export] saves the current compile flag externally.

o Import

1. Click the [Import] button.

2. Select the file (.cf file) which has compile flags from the file open dialog.
o Export

1. Click the [Export] button.

2.

In the save dialog, enter the name and location of the file to enter the compile flag and

save.
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13.3. Source File Properties

Build

You can set toolchain related information (toolchain, compiler) for the source file (translation unit).

B Froperties for adleraz.c O X
ype filter text] Build e T
Build
- Select a toolchain
Compile flag -
Info Default  Toolchain Mame Descripticn

CPP_TI_TMS320_6000_SoC..
GCC 4.7 (32bit)

GCC 5.3 (32bit)

Microsoft Visual Studic 20...
Microsoft Visual Studio 20...
Microsoft Visual Studio 20...
Microsoft Visual Studio 20...
gces

iar

goooooron

Compiler: gcc.exe ~

Restore Defaults Apply

Apply and Close Cancel

Info

Shows the information of the source file (translation unit) and the module containing the source file.

B eroperties for adler3z ¢ m] *
type filter text Info =1 - -
uild Translation Unit Information
Compile flag

Info Module: Default Module

Primary Scurce File Information

Path: /zlib/adler32.c

Type: Linked File

Location: P/Example_Project/c/dip/zlib-1.2.3/adler32.¢
Size: 4,561 bytes

Apply and Close Cancel

Compile flag

You can set compile flags for source files(translation units).

Page 61 of 249



User Manual - 3.3

Suresofttech
B Properties for adler32 c m] X
type filter text Compile flag = - -
Compile flag [JiParent compile flag inheritance
Info Command |nclude Define Macre
Undo Redo Eind/Replace...
£ Import... 253 Export...
Apply and Close Cancel

* If you select the [Parent compile flag inheritance] check button, the compile flag of the module
containing the source file is applied. Conversely, deselecting can change the current compilation

flag.
» [Import] imports an external compile flag. [Export] saves the current compile flag externally.

° Import
1. Click the [Import] button.
2. Select the file (.cf file) which has compile flags from the file open dialog.

o Export
1. Click the [Export] button.
2. In the save dialog, enter the name and location of the file to enter the compile flag and

save.
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14. Preferences

In the preference menu, you can check or change the current settings of the tool.

The preferences provided by Controller Tester are as follows.

* Analysis

» Exclusion

» Performance

» Source File Types

+ Language
e Theme

» Test
e Toochain

» Persperctive
- Editor

Page 63 of 249



Suresofttech

14.1. Analysis
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You can check or change the settings related to the analysis.

Metric

For any view showing metric data, you can set which metrics are visible or hidden and the order in which

they are displayed.

The name of the selected metric is displayed as a tooltip message.

B preferences O
type filter text Metrics & - -
w Analysis
CFG Medule  File Class ~ Function
Call Graph
Function View Hide/Show Metrics
« Metrics Hide Show
Diagnasis FUMCYC FUNST Up
View FUMNC . FUCYC o
Test Mavigator FUMIV FUNDC =
Editor FUNSP =< | FUNCE
Exclusion FUNCR FUNPA
Language FUNEM FUNGS
Ferformance fPusM FUNRP
Perspectives FUNDM
Register external comman:
Source File Types
Target Test
Test
Theme (C5 Labs)
TeolChain
key
< 5 Restore Defaults Apply
=

After selecting a metric, you can move to the ‘Hide’ list or the ‘Show’ list with the [>>] or [<<] button.
After selecting a metric in the ‘Show’ list, you can change the order in which the metrics are displayed
with the [Up] or [Down] button.

Metrics View

You can change the settings of the views showing metric data.
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B preferences

type filter text
w Analysis
» CFG
» Call Graph
Function View
~ Metrics
Diagnosis
View
Test Mavigator
Editor
Exclusion
Language
Performance
Perspectives
Register external comman:
Source File Types

View

Metrics View

Rows per page: | 100

Metrics Tep Chart View
Sum for the rest of the items to display

Number of items to display: |1D

Metrics Bar Chart View

Mumber of items to display: |5CHJ

Metrics view and Metrics chart view interwork

Filtering the items of the metric view based on the value selected in the metrics chart view

Number of items to display: |5

[A The metrics chart view display a range of filtering in metrics view

» Target Test
5 Test Metrics Diagnosis Chart View
Theme (CS Labs) Show the sum of items that cannot be diagnosed
> ToolChain
key
P N Restore Defaults Apply
Apply and Close Cancel
Diagnosis

You can check or set diagnostic information for metrics.
Set the message and diagnostic image (shown in the metrics view) to be displayed when the selected

metric value is included in each range.

B Preferences | X
type filter text Diagnosis Frorw
w Analysis
y CFG Module  File Class  Function
» Call Graph
Function View Diagnosis of ~
~ Metrics =
Diagnosis Message Range Image Edit
View Simple(without mu... [0.00, 10.00) W
Test MNavigator More complex(mo...  [10.00, 20.00) -
Editor Complexthigh risk)  [20.00, 50.00) =2
Exclusion Greatly complexive... [50.00, max) =
Language
Performance
Perspectives
Register external comman:
Seurce Fils Types
» Target Test
» Test
Theme (C5 Labs)
» ToolChain
key
= N Restore Defaults Apply
Conca

To edit the diagnostic information, click the [Edit] button.

A dialog box appears where you can edit the diagnostic information for the selected metric.

User Manual - 3.3
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B &dit Diagnesis of 'FUCYC

Diagnesis Level: ¥
Set of Images: | Weatherd ~

Levell

Change Sort Order

Message: |Simple(withnut much rish)

Range: [0.00 - Image: ¥
Level2
Message: | More compleximoderate risk)
Range: |10.00 ~ |20.00 Image: .
Level3
Message: | Complexihigh risk)
Range: [20.00 ~ |s0.00 Image:
Leveld
Message: | Greatly complex(very high risk)
Range: |50.00 ~ | max Image: ==
Cancel
1. Set the diagnostic stage (2 ~ 5).
2. Sets the diagnostic image to show in the metrics view.
3. Press the [Change Sort Order] button to change the sort order of diagnostic images.
4. Enter the diagnostic message and diagnostic range for each step.
5. Select the [OK] button.

CFG

User Manual - 3.3

You can change the settings for the control flow graph displayed in the control flow graph view.
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B Preferences O *

type filter text CFG S v ow

~ Analysis
Centrol Flow Graph Preferences:
> CFG P

Call Graph [15how Function Call
Function “iew Show Library Functicns
Metrics Enable Autc-Layout

Test Mavigator

Editor

Exclusicn

Language

Performance

Perspectives

Register external comman
Source File Types

Target Test

Test

Theme (CS Labs)
TeolChain

key

v

v

W

v

Restore Defaults Apply

Apply and Close Cancel

Node Color

You can change the color of nodes in the control flow graph.

B Preferences [m] %
type filter text Node Color Gvhv v
w Analysis ]
v CFG CFG Nede Color:
MNode Color Begin Node Color: | —
» Call Graph ]
Function View Epdliodedeolbon —
> Metrics Condition Node Color: | —
Test Mavigator
Editor Block Nede Color: —/1
Exclusicn
Language Goto Node Color: /1
Performance Return Node Color: —]
Perspectives
Register external comman: | Function Node Color: —1
Source File Types ) ) ]
s Target Test Library Function Mode Celor: 1
> Test Single Statement Node Color: |
Theme (C5 Labs)
s ToolChain Single Declaration Node Color: |
ke
¥ Group Mode Color: —
< s Restore Defaults Apply
Apply and Close Cancel

Test Navigator

For each operation that copies or moves source files in the Test Navigator view, you can set options to
ask whether or not to continue.
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. Preferences

type filter text

~ Analysis
» CFG
> Call Graph
Function View
> Metrics
Test Navigator
Editor
Exclusicn
Language
Perfermance
Perspectives

Source File Types
Target Test

Test

Theme (CS Labs)
ToolChain

key

Test Mavigator

Register external comman

Copy source files te the other module by drag and drop.
(O Always O Never (@ Prompt

Move source files to the other module by drag and drop.
O Always O Never @ Erompt

Copy and paste a source file to a medule

O Always O Never (@ Prompt

Note: Drag and drop a source file to the other module with Ctrl key pushed down in order te copy a source file.

Restore Defaults Apply

Apply and Close Cancel

Function View

B Preferences

type filter text

~ Analysis
» CFG
Call Graph

v

Metrics

v

Editor
Exclusicn
Language
Performance
Perspectives

Function View

Test Mavigator

Register external comman
Source File Types

Function View

O X

Gvy D

Limit visible functions per group to (0: Unlimited): I:I

» Target Test
> Test
Theme (C5 Labs)
» ToolChain
key
< s Restore Defaults Apply
Apply and Close Cancel

Call Graph

You can change the settings of the function call graph displayed in the call graph view.

User Manual - 3.3
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. Preferences O
type filter text Call Graph =12 -
Analy:
h )nac}:és Call Graph Preferences:
. call Graph [J Show Library Functions
Function View Call Depth Setting
> Metrics (O Does not distinguish the direction
Test Mavigator
2
Editor Depth setting: |2
Exclusicn (® Distinguish the direction
Language Incoming depth setting: |2
Performance R |3
Perspectives utgaing dep ng-
Register external comman
Source File Types
» Target Test
» Test
Theme (CS Labs)
» ToclChain
key
« N Restore Defaults Apply
Apply and Close Cancel

User Manual - 3.3

The [Show Library Functions] checkbox allows you to set whether or not to display library functions.
If you set the value of ‘Does not distinguish the direction’ to ‘2’ in ‘Call Depth Setting’, it shows the call
information of one depth for both the caller and callee, centering on the selected function(Just the callers

or callee of the selected function shown).

If you want to set the caller and callee separately, you can specify the value of each step by selecting

the sub-option. You can change the color of nodes visible in the function call graph.

v

v v

v

Preferences

type filter text

Analysiz
» CFG
w Call Graph
Nede Color
Functicn View
> Metrics
Test Mavigator
Editor
Exclusicn
Language
Performance
Perspectives
Register external comman
Seurce File Types
Target Test
Test
Theme (C5 Labs)
ToclChain
key

Node Color

Call Graph Mede Celor:
Function Node Color: —/1

Library Functicn Nede Color: [

Restore Defaulis

Apply

Apply and Close

Cancel
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14.2. Exclusion

You can set the directories and files to exclude from the analysis.

B Freferences O X
type filter text Editor =2 v -

Analysiz .

Editor Editer settings:

Exclusion Text file enceding

Language (®) Default (UTF-8)

Performance Oother. |UTF-3

Ferspectives -

Register external comman, | [Automatic detecticn

Source File Types

Target Test Indentation

Test Tab size:

Theme (CS Labs) g

ToolChain Detect medifications

key [ Check the effect whenever the source file is modified (Including external medifications)
8 > Restore Defaulis Apply

Apply and Close Cancel

* Add the analysis exclusion target.
1. Click [Add].
2. Select the directories or files to be excluded.
3. Click [OK] or [Open].

» Delete the analysis exclusion target.
1. Select the directories or files to be deleted.
2. Click [Remove].
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14.3. Performance

It provides the settings that can improve the work performance suitably for the user environment.

B Freferences ] X
type filter text Performance (ol T
> Analysis

; Multi Core usage
Editor - .
Exclusion Perform Multi-core Analysis

Language Number of threads:

Performance
Perspectives [JUsing frozen code

Register external commany | Mote: Use this option if there are no changes te the source code.

Source File Types Minimizing unnecessary tasks to improve performance.

Target Test
» Test
Theme (CS Labs)
» ToolChain
key

v

Restore Defaults Apply

Apply and Close Cancel

Multi-Core Usage

The option [Multi Core usage] improves performance by using multiple cores when executing the project
analysis. (If PC has not enough CPU resource, it can affect the performance of the other tasks.)

» Perform Multi-core Analysis: Enter the number of the core to be used when analyzing the source
code. (The range of the core number: 2 ~ the maximum number of cores in the execution
environment)

Using frozen code

The option [Using frozen code] improves the performance by minimizing unnecessary tasks (detecting
and re-analyzing source code modifications etc.) assuming that there is no change in the source code
configuration.

Use this option only if the PC performance is very slow and the source code configuration is never
changed during testing. (If the source code or analysis setting is changed while the option is enabled, it
may cause unexpected problems.)

* Difference with Editor — [Detect modifications] option
While if [Detect modifications] option of Editor is enabled, it analyzes the modified source
code when executing [Analyze], if [Using frozen code] option of analysis is enabled, it
does not analyze the modified source code until re-analyzed even though the source
codes are modified. In addition, Editor — [Detect modifications] option is ignored.
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14.4. Source File Types
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You can set the extension to be used as a source file for each project type.

B Freferences ] X
type filter text Source File Types (=14 v v
Analysi
’ Ecrl]i:t}::ﬂ Source file types can add or delete.
Exclusion Project Category:
Language
Performance
Perspectives
Register external comman:
Source File Types
5 Target Test C/C++ File Types:
» Test -~
File T Description Status Add...
Theme (CS Labs) . yoe P )
. ToolChain . C Source File Product Def... Remove
key *C C++ Source File Product Def...
*.cc C+=+ Source File Product Def..
*.cpp C++ Source File Preduct Def...
0K C++ Source File Product Def...
< N Restore Defaults Apply
Apply and Close Cancel

* Add a source file extension.

1. Select the project type.

2. Click [Add].

3. Enter an extension, select the type and click [OK].

B C/C++File Type

C/C++ File Type
Enter a file type.

s

Pattern : *. ||

type : C Source File

OK

Cancel

« Remove a source file extension.

1. Select the project type.

2. Select the extension to be removed.
3. Click [Remove].
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Language
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Sets the language to be displayed in tools and reports.

You can select a language from the drop-down menu for [System] and [Report].

|ty'pe filter text

> Analysis
Editor
Exclusicn
Language
Performance
Perspectives

v

Target Test
Test

v

TeelChain
key

v

Source File Types

Theme (CS Labs)

L fe=T0 B=F 2 4

System: |English (United States) |

Report: |English (United States) |

| Restore Default5| |

Apply

|Apply and Closel |

Cancel

If you click the [Apply] button after changing the [System], a dialog box asking you to restart Controller

Tester will

open.

|type filter text

> Analysis
Editor
Exclusicn
Language
Performance
Perspectives

Source File Tvpes

L prorw

System: |Korean (South Korea) v|

Report: |English (United States) ~|

» Tes
The
» Too

key

» Tan . Chan

ge Language

You need to restart Controller Tester to change the [System] language.
Would you like to restart?

| Restore Default5| |

Apply

|Apply and Closel |

Cancel

* When you change the system language, the report language also changes automatically.
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To set the report language differently from the system language, change the report
language after restart.
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14.6. Theme

It provides the settings for changing the theme of the Controller Tester.

* CS Labs allows you to preview new features that will be released in CodeScroll tools
later. Based on feedback for the new features, CS Labs features may or may not be
applied as formal features.

B Preferences [m| X
[type filker text | | Theme (€S Labs) R R
> Analysis
Editor Enable theming (requires restart)
Exclusion Theme: | Light v ‘
Language
Performance Color and Font theme: |Defau|t (current) v‘
Perspectives
Register external commarn
Source File Types
> Target Test
» Test
Theme (CS Labs) Description:
» ToolChain
key
[] Enable animaticns
Use mixed fonts and colors for labels
Visible tabs on overflow:
Show most recently used tabs
< s | Restore E_)efau\ts| | Apply |
IAppI)r and Closel ‘ Cancel |
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Provides settings related to editing test and execution.
[Except for non-executable tests when errors occur during test execution] is an option that allows you to
execute only executable tests, excluding non-executable tests, when the whole test cannot be performed

due to an error that occurs during test execution.
The [Using Macro Constant] option allows you to edit the test using macro constants defined in the

source file (ex: using macro constants for input/expected values of array indexes and test cases).

! This setting only applies to converted projects.

B preferences

type filter text
Analysis
Editor
Exclusion
Language
Performance
Perspectives

Source File Types
Target Test

Test

Theme (CS Labs)
ToolChain

key

Test

Register external comman:

Except for non-executable tests when errors occur during test execution
O Always (O Never (@ Prompt
¥ This does not apply to the target test.

Note: If you can not proceed with the test due to an error that occurred

during the test run, continue to run only the runnable tests, with
the exception of non-executable tests.

[[Jusing Macre Constant
Mote: Changes to the 'Use Macre Constants' option are not reflected in existing projects.

To be reflected in an existing project, you must perform a "reanalysis”

( Restore Defaults Apply
Apply and Close Cancel

Virtual Address

It provides the memory settings for the embedded environment test. You can manage the memory

address group to be used in the project properties.

Page 76 of 249



Suresofttech

B Preferences

type filter text
> Analysis
Editor
Exclusion
Language
Performance
Perspectives

Source File Types

Target Test

v Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Wirtual Address

Theme (CS Labs)

ToolChain

key

v

v

Register external comman

O x
Virtual Address (=T =
Configuration name Description Add...
Edit(E)

Remove

wirtual memory address value range list

Begin

End

Apply and Close Cancel

User Manual - 3.3

In the screen above, you can check the virtual memory address information set. Click [Add...] button to

add the virtual memory address.

Basic Configuration

B virtual memory address Create

Virtual memory address Configuration

(D The count of virtual memory address value list is up to 50.
The virtual memery address value format is hexadecimal.

Mame:

Description:

Virtual memery address Configuration

Begin Virtual memory addre!| - |End Virtual memery addre!|

Begin

End

Add(a)

Delete(R)

oK

Cancel

The virtual memory address areas can be specified up to 50 areas and it can be entered in hexadecimal.

Export test data

When exporting data, you can set the output direction of variables to either horizontal or vertical

Select the output direction of the export variable and click [Apply].
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. Freferences O %
spe filter text - v -
P Export test data
> Analysis

Editor Export data Configuration
Exclusicn (@ Horizontal

Language O Vertical

Ferformance

Perspectives

Register external comman

Source File Types

Target Test

v Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
virtual Address

Theme (C5 Labs)

ToolChain

key

v

v

Restore Defaults Apply

Apply and Close Cancel

External Editor

You can set the external editor to open CSV file.
Enter the path of the external editor and click [Apply].

B preferences O X

type filter text External editor CR AR
> Analysis
Editor
Exclusion Path: | notepad ‘ Search...
Language
Performance
Perspectives
Register external commani
Source File Types
Target Test
v Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
wirtual Address
Theme (C5 Labs)
ToolChain
keey

Enter the path to an external editor that cpened for the csv file

v

v

Restore Defaults Apply

Apply and Close Cancel

Unit Test View

You can set the function node display in the Unit Test view included in the test perspective that UI/UX is
improved.
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B preferences

type filter text
> Analysis
Editor
Exclusion
Language
Performance
Perspectives

Source Fils Types

Target Test

w Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Virtual Address

Theme (CS Labs)

TeelChain

key

v

v

Register external comman

O =
Unit Test View (=14 -
Function nede show mode
(O All functions @ Only functions where tests exist
Restore Defaults Apply

Apply and Close Cancel

Coverage

User Manual - 3.3

You can set the branch coverage measurement and whether to display the covered/uncovered.

B Preferences

type filter text
> Analysis
Editor
Exclusion
Language
Performance
Perspectives

Source File Types

Target Test

w Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
virtual Address

Theme (C5 Labs)

ToolChain

key

v

v

Coverage (4

Register external comman

Branch coverage column info display
(® Covered Decision
(O Uncovered Decision

Branch coverage, MC/DC measurement operator
Conditional Operator(?)

[IBoolean Operator(&&, ||, |, =, <=, >, >=, ==, 1=)
[ constant expressicn at compile time

Limit to measure MC/DC

MNumber Operators(8&, ||, I=): 40 1=

MNumber of truth-table combinations: 20000 |5

Show MC/DC

(O show decision unit
100 % | % more than satisfied combinations show

(® Show condition unit

Note: The cperator option change does not apply to the existing project.
To apply, use 'Reanalysis' and 'Run Unit Test' functicn

< Restore Defaults Apply
Apply and Close Cancel

[Branch coverage Column Info display] radio button allows you to select the information of the marker to

be displayed in the left column of the editor.

« T/F marker option is shown in the source code editor.
» Covered Decision: T/F indication of a covered decision
* Uncovered Decision: T/F indication of an uncovered decision

Page 79 of 249



Suresofttech User Manual - 3.3

The checkbox [Branch coverage, MC/DC measurement operator] sets the branch coverage measuring
target. If it is re-analyzed and executed, the settings are applied.

+ Conditional Operator(?:) expression: Measures the branch coverage for ternary operator

expression.
* Boolean Operator(&,||,!,<,<=,>,>=,==,1=): Measures the branch coverage for boolean operator

expression.
» If unchecked all, measures the branch coverage for ‘if’, ‘for’, ‘while’, ‘do-while’ and ‘switch’

statements only.

Type Partition

You can edit the basic type partition for each toolchain and restore it into the default value provided.
In Toolchain combo box, select the toolchain to be modified, edit the partition and click [Apply].

l Preferences [m] X
type filter text Type Partition P -
Analysis
Editor Toolchain: |Micresoft Visual Studio 2015 (32bit 64bit) P
Exclusion
Language Type Partiticn ~ || Add...
Performance _intg4 -9223372036854775808~-1,0,1~92233... Edit(D)...
Perspectives _wchar t 0,1~65535
Register external comman char -128~-1,0,1~127 Remove
Source File Types double -1.7876931348623158e+308~-2.225073...
Target Test float -3.4028234668+38~-1.175494351e-38,0..
v Test int -2147483648~-1,0,1~2147483647
Coverage long -2147483648~-1,0,1~2147483647
Export test data long double -1.7976031348623158e+308~-2.225073...
Externzl editor long long -9223372036854775808~-1,0,1~32233
Perspective short -32768~-1,0,1~32767
L1122 FEITI signed _int64 -9223372036854775808~-1,0,1~92233...
Unit Test View . y D
virtuzl Address ngnEd char : 28: 0.1~ 2f I -
Theme (C5 Labs) signed int -2147483648~-10,1~2147483647
ToolChain signed long -2147483648~-1,0,1~2147483647
key signed long leng -9223372036854775808~-1,0,1~92233...
signed short -32768~-1,0,1~32767
unsigned _int64 0,1~18445744073709551615
unsigned char 0,1~255
nnnnnnnn A int N1 ANA0ETING <
< 5 Restore Defaults Apply
Coce

Perspective

After the test has created, you can set the opening option for the perspective associated.
Select one among [Always open], [Never open] and [Prompt] and click [Apply].
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B preferences O *

|ty'pe filter text

Perspective Qo

Analysis
Editor Open the associated perspective when creating 2 new unit test
Exclusion (O Always open () Mever cpen (@) Prompt
Language
Performance
Perspectives
Register external comman
Source Fils Types
Target Test
w Test
Coverage
Export test data
External editor
Perspective
Type Partition
Unit Test View
Virtual Address
Theme (CS Labs)
TeelChain
key

v

v

v

| Restore Defaults | | Apply |

|Apply and Closel | Cancel |
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You can set the information for the toolchain to be used in the tool.

You must have a toolchain (compiler information) for the source to be tested in order to create or

analyze the project.

The detail description of the toolchain settings can be found in the ‘Set a Toolchain (Analyzer)'.

Export Toolchain

It sets the system header size of the toolchain to be exported. The system headers larger than the size

you set cannot be exported.

B Preferences ] x
type filter text Exporting Grr
» ,;;iilc};m Set the system header size of ToolChain to be exported
Exclusion Toolchain system header size (MB): |300
Language
Performance
Perspectives

Reqgister external comman
Source File Types
Target Test
Test
Theme (CS Labs)
w ToolChain
Exporting
keey

Vo

Restore Defaults Apply

Apply and Close Cancel
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14.9. Persperctive

You can change the settings related to perspective.

B Freferences ] X
type filter text Perspectives F=TR =P
> Analysis

Open a new perspective

Editor

Exclusion (@ In the same window (C)In a new window

La

Pe:fgourfngaence Open the associated perspective when creating a new project
Perspectives O Always open O Never open @) Prompt

Register external comman:

Availabl tives:
source File Types wailable perspectives.

5 Target Test &2 Analysis Make Default
» Test = Test (default)

Theme (C5 Labs) Revert
» ToolChain

key Delete

Note: ‘Revert’ removes the customizaticn from the selected perspective.
This enly applies to newly opened perspectives.

Restore Defaults Apply

Apply and Close Cancel

Page 83 of 249



Suresofttech

14.10. Editor

User Manual - 3.3

You can change the settings related to the editor.

B Freferences

type filter text
Analysiz
Editor
Exclusicn
Language
Performance
Perspectives

Source File Types
Target Test

Test

Theme (CS Labs)
ToelChain

key

Editor (S v

Register external commar

Editer settings:
Text file enceding
(® Default (UTF-8)
(O Cther: | UTF-2
A Autematic detection

Indentation
Tab size:

Detect modifications
[ Check the effect whenever the source file is medified (Including external modifications)

Restore Defaulis Apply

Apply and Close Cancel

Text file encoding
You can set the encoding to be used when opening a text file in the editor. If the [Automatic detection]

option is on, it will automatically detect the encoding of the text file. (If it cannot be detected

automatically, it will open with the encoding you set.)

Indentation

If you change the tab size, the tab size shown in the editor is changed too.

Detect modifications

If the [Detect modifications] option is on, it checks the impact of the changes each time the source file is

modified.

* If the disc speed if slow, deselect this checkbox to improve the performance.
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15. Test Perspective

The Test Perspective provides Ul for displaying only the necessary information so as to keep the flow of
the testing task and focus on the goal.

It provides a high DOF screen with Eclipse RCP. You can set it in the [Window] menu and in each view.

I CodsScroll Controller Tester RTViRemote Target Verifier) « Target Plugin (&) - o ®

Eile Edit Search Broject Taget Window Helg

Fais Dashboardpart '« .. ... ...

& Tg | | Show Coverage T LovEagE 4 MODL T awE ) Chass Factory e Control Flow Graph  =-= Call Graph T2 Function Call Higrarchy ) Emor
[ adler32c & =0 Uit Test Bk~ =0
”1‘1 while (8) L v Statement Coverage
# define MoD(a) a X=- BASE m .
& define MOD(a) 2 %~ BASE 18 /0 /86) 24 2.9%
54 Hendif 118/3945

type file, function, test

Lon Hame Resylt Coverage o
uLong adler; . pare
const Bytef *bufi B 3 Signale .
' lest view part
unsigned long sumiz tasel &
unsigned n; = 7

- split Adler-37 into comgonent sums *
sun2 = (adler >> 16) & @xffff;

Source code

72[F) B 2dler32_combine 1/0/0 100.0%
. Ei
= . .
75[F]
7% adler32(wnsigned long, const u_. £ =0
78 } E Test Info (zlibsadler32_testd) .
88 defarrad
81[F] : i gl Test Structure ., @ @ TestInfo Edit
o ‘est structure wsing 3 tree wiew and edit the information in the test Change the notstion edit the partition €
B4 * in case short lengths are provided, keep it somewhat fast * Mame In Out
d ! ! Set Mumeral Systern
B5[TF] iF (len < 18) { v  Parsmelmiehan = f
B5[TF] while (len--) { arame, Tetul )10 Numeral Syctern (7 98 Mamearz] System
L adler += *bufes; ~ o adler : ulg -
88 sunz 4= adler; el
E ot .~ Test editor part =
5a[TF] if (adler >- BASE) v o [ : B add
51 adlar -= BASE; o
2 MOD4( sumz ) ; i /* only added so many BASE's */ wdi -S- _'__J -“'“"ygm_c = [Single Value Add
_ y return adler | (sum2 << 18); v o len J.m- Partition List
o len : unsigned int = o | T

96 * do dength WX blocks -- requires just one modulo operation * w o returniar : ulong
'::[F] m“: (len :ﬂxmi i < retumviar - unsigned Ic = T Difault
58 o == ] — = 2

no= WX /165 £+ wax is divisible by 16 */ Before call code g

do { - After call code w ci7oEggee &

Test info | Test Case Test Code| Configuration

R

The components that make up the test perspective are:

» Dashboard

+ Test Navigator View
* Unit Test View

» Integration Test View

» Coverage View

+ MC/DC View

+ Stub View

+ Class Factory View

» Control Flow Graph View
» Call Graph View
e Error View

+ Debug Information View

« Fault Injection View

* Input/output Data Graph View

» Console View
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Views that are not included by default can be opened from [Window]> [Show View]> [Other...] on the top
menu.
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15.1. Dashboard

The Dashboard section provides a summary of frequently used functions or tests that are currently in

progress.
% zlib =3 N w2 B b Host i) Y 2 [ Global Search (Ctrl+3) Q)i = |
New Project New Test Import Export Properties Preferences e
& TE | Show Coverage i) Coverage —JMC/DC &1 Stub ¢ Class Factory <% Control Flow Graph == Call Graph g Function Call Hierarchy ®") Emor

Project name

It shows the name of the project selected in the [Test Navigator] view.

T
=% zlib =] B x A B o Host i ¥ [ [ Global Search (Ctrl+3) Q| B|=
MNew Project New Test |Import Export Properties Preferences i

& Tg | Show Coverage =" Coverage —{ MC/DC i1 Stub [f) Class Factory <% Control Flow Graph =:= Call Graph g Function Call Hierarchy 5 Emor

Bookmark menu

You can use the Create Project, Create Test, Import, Export, Properties and Preferences functions.

% zlib = B M» A B fe Host @ X B [ Global Search (Ctrl+3) SSHE: A=
New Project New Test Import Export Properties Preferences
& Tg | Show Coverage :" Coverage —J MC/DC :i%Stub ¢} Class Factory < Control Flow Graph = Call Graph g Function Call Hierarchy ®Y Eror

Host/Target setting menu

You can change the test environment to the host or target.

"% zlib =3 B M 2 B o Host i ¥ B [ Global Search (Ctrl+3) Q)| B |[=

New Project New Test Import Export Properties Preferences b

& TR | Show Coverage i) Coverage —JMC/DC ¥ Stub ¢} Class Factory <% Control Flow Graph 2= Call Graph T Function Call Hierarchy ®) Emor

Coverage-related menu

You can use the Show the Merger coverage between host and target and the Show full coverage
(Include External Coverage) functions.

=% zlib =3 B x» A B & Host @ Y |/ clobal Search (Ctrl-3 Q)| B |[=

New Project New Test Import Export Properties Preferences -

& TH | Show Coverage :") Coverage -3 MC/DC i1 Stub [t} Class Factory <% Control Flow Graph = Call Graph %3 Function Call Hierarchy ®") Emor

Open Perspective menu
You can select and open the perspective located in Controller Tester

% zlib (=1 B N 2 B £ Host @ X B [ clobal Search (Ctri+3 Qi B | IS

New Project MNew Test Import Export Properties Preferences

& Tg | Show Coverage ") Coverage —MC/DC (1% Stub ¢) Class Factory < Control Flow Graph <o Call Graph T2 Function Call Hierarchy r ) Emor
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Global Search

The Global search allows you to search New, View, Editor, Menu, Properties, Preferences, Project
resource (source file, function), Test, Stub and Class factory, etc. by keywords. Select the Global search
window or press the shortcut key (Ctrl + 3) to use the Global search function.

= L% Host @ Y | d Q,

3rnm=rtipr. Freferences
1 Views A4 Input/Output Data Graph (Test)

—4 MC/DC (Test)
.| Metric Diagnosis Chart (Analysis)
“= Source-Header Relation (Analysis)
fi Unused Function (Analysis)
Menus ¥ Delete - Delete
@ Generate command line interface INI file
=1 Madification... - Modification
New Bi c/C++ Project from Embedded(CodeWarrior, Green Hills, NEC) - Create a new projec
B C/C+-+ Project from Existing CodeScroll Project - Create a new project from an existi
W C/C++ Project from Visual Studic Project - Create C/C++ Project from Wisual Studic
B’ C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC) - Create a
!; i Create a C/C++ project with Build Information - Create C/C++ project with the Builc
q B Create a C/C++ target test project with Build Information - Create C/C++ target test
| (53 Module - Create 2 new Module.
«| Preferences Diagnasis - Analysis/Metrics
Editor
Export test data - Test
External editor - Test
Mode Coler - Analysis/CFG
MNode Color - Analysis/Call Graph
Register external command menu
irtual Address - Test
: Project @& _dist_code - deflateh
@ _dist_code - treesh
@ _length_code - deflate h
@ _length_code - treesh

S— R R

£

H

: @ _tr_flush_bleck(struct internal_state *, char *, unsigned long, signed int) - trees.c

; @ _tr_stored_block(struct internal_state #, char *, unsigned long, signed int) - trees.c

1 @ _tr_tally(struct internal_state *, unsigned int, unsigned int) - trees.c

'1 @ adler32(unsigned long, const unsigned char *, unsigned int) - adler32.c

J Unit Test ) _tr_flush_blockistruct internal_state *, char *, unsigned long, signed int)_0 - trees.c
) be] _tr_stored_block(struct internal_state *, char * unsigned long, signed int)_0 - trees.c

| _tr_tally(struct internal_state *, unsigned int, unsigned int)_Q - tress.c

| adler32(unsigned leng, const unsigned char *, unsigned int)_0 - adler32.c
i 't adler32_combine(unsigned long, unsigned long, signed long)_0 - adler32.c
1 bi_reverse{unsigned int, signed int)_0 - trees.c

| bi_windup(struct internal_state #)_0 - trees.c

| build_bl_tres(struct internal_state *)_0 - trees.c

H [TH [TH [rH [rH [T

| Results per category are limited. Press 'Ctrl+3" to see all

* The project resource (source file, function, etc.), test, stub and class factory can be
searched by selecting the analyzed project.
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E ﬁ Host. i []i-]- inflate

irrmprtipr. Preferences
| Project @ fixedtables(struct inflate_state #) - infhack.c
@ fixedtables(struct inflate_state #) - inflatec
@ inflate(struct z_stream_s #, signed int) - inflate.c
L} inflate.c
[n] inflate.h

@ inflateBack(struct z_stream_s *, unsigned int (*)(void *, unsigned char =+, void *, sigr|

inflateBackEnd(struct z_stream_s *) - infback.c

inflateCopy(struct z_stream_s *, struct z_stream_s #) - inflate.c
inflateEnd(struct z_stream_s *) - inflate.c

¢ oQ0 QP

L]

inflateGetHeader(struct z_stream_s *, struct gz_header_s *) - inflate.c
inflatelnit2_(struct z_stream_s *, signed int, const char #, signed int) - inflate.c
inflatelnit_(struct z_stream_s *, const char #, signed int) - inflate.c

inflateBackinit_(struct z_stream_s *, signed int, unsigned char *, const char *, signed |

Stub 4 fixedtables_1 - inflate.c
| & inflateBackend_1 - infhack.c
| & inflateBackinit_1 - infback.c
| % inflateBack_1 - infback.c
| & inflateCopy_1 - inflate.c
& inflateEnd_1 - inflate.c
L inflateGetHeader 1 - inflate.c
| L inflatelnitz_1 - inflate.c
| L inflatelnit_1 - inflate.c
| & inflatePrime_1 - inflate.c
& inflateResst_1 - inflate.c
4 inflateSetDictionary_1 - inflate.c
& inflateSyncPoint_1 - inflate.c

| Unit Test IL] fixedtables(struct inflate_state #)_0 - infback.c
| t] fixedtables(struct inflate_state #)_1 - inflate.c
| inflate(struct z_stream_s *, signed int)_0 - inflate.c

rH [T

|
| inflateBack(struct z_stream_s *, unsigned int (¥)(void = unsigned char #*), void *, sign

Lz
{ 1) inflateBackEnd(struct z_stream_s *)_0 - infback.c |
') inflateBackinit_struct z_stream_s *, signed int, unsigned char *, const char *, signed |

] inflateCopy(struct z_strearn_s *, struct z_stream_s #)_0 - inflate.c
| b.] inflateEnd(struct z_stream_s #)_0 - inflatec
] inflateGetHeader(struct z_stream_s *, struct gz_header_s #)_0 - inflate.c

b ] inflatelnit2_(struct z_stream_s *, signed int, const char *, signed int)_0 - inflate.c
Ie] inflatelnit_(struct z_strearn_s * const char * signed int)_0 - inflate.c
'] inflatePrime(struct z_stream_s *, signed int, signed int)_0 - inflate.c

O

| inflateReset(struct z_stream_s *)_0 - inflate.c

Results per category are limited. Press 'Ctrl+3' to see all

Show Coverage

It allows you to set the covered area in the source code editor is marked or not.

=t =1
% zlib = B & A B o Host @ ¥ & [ Global Search (Ctrl-3)
New Project New Test Import Export Properties Preferences byl
& Tg || Show Coverage +') Coverage —{MC/DC 571 Stub [ Class Factory < Control Flow Graph

Open/Close the test-related view menu

s Call Graph %2 Function Call Hierarchy ®") Emor

User Manual - 3.3

You can open and close the [Coverage] view, [MC/DC] view, [Stub] view, [Class Factory] view, [Control

Flow Graph] view, [Call Graph] view, [Function Call Hierarchy] view, and [Error] view.

& = —1
& zlib L" Ei N A = Lk Host @ Y B
Newi Project New Test Import Export Properties Preferences
& TR || Show Coverage I-‘ Coverage —{MC/DC (i} Stub ¢) Class Factory < Control Flow Graph

:=Call Graph T Function Call Hierarchy ¥ Errorl

Page 89 of 249



Suresofttech

15.2. Test Navigator View
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The [Test Navigator] view shows the hierarchy structure of the projects and the test models under the

projects included in the workspace.

The [Test Navigator] view does not occupy any space but remains the minimized state. If you select
[Test Navigator] in the dashboard, the [Test Navigator] view is located above the source code editor

area.

- | Tg || show Coverage

Tg Test Mavigator B a8
L]

10 stub_sample
10 target

v 1 zlib
v (g Default Module

v [ adler3z.c

@ adler32
@ adler32_combine
| compress.c
g cre32c
[ g, deflate.c
L[4 gzioc
g infback.c
L4, inffast.c
L, inflate.c
L, inftrees.c
L, minigzip.c
L trees.c
L, uncompr.c
[ zutilc

(= Headers

Icon
Icon Description(*: created after analysis)
= Open project
0  Closed project
! Module
L} Source file (translation unit)
® *Global variable
@ *Function
= *Header folder
[n]  *Header file
[& *System header file
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Toolbar menu

Menu Description
<}==f> Link with Selection Highlights the items selected in the other view.

=l Collapse Al Hides all tree nodes.

Icon overlay

Icon overlay Description
S Analyzed

0 Changed after analysis

Copy the source file into the other module

To copy the source file into the other module, with Ctrl key pressed, drag and drop the source file to be
copied into the target module.

Alternatively, right-click the source file to be copied, select [Copy], right-click the target module and
select [Paste]. (Shortcut keys: Ctrl + C and Ctrl + V)

Move the source file to the other module

To move the source file to the other module, drag and drop the source file to be moved into the target
module.

Drag and Drop from Windows Explorer

* Creates a project by Visual Studio project
From Windows Explorer, drag and drop the Visual Studio file (.dsw, .sln, .vcxproj, .vcproj) into Test
Navigator view.

* Imports the source file from the file system
From Windows Explorer, drag and drop the source file into the target project or module in Test
Navigator view.

! Drag and Drop functionality in Explorer does not work in Windows 10.

Page 91 of 249



Suresofttech User Manual - 3.3

15.2.1. Merge Project Coverages

If a project size is too large to run the test at once, you can run the test by dividing it into multiple
projects. [Merge Project Coverage] function runs the test by dividing one project into multiple projects
and then shows the overall coverage results by merging the result of the test for these projects.

Merge Project Coverage

1. After selecting all the projects that you want to merge the coverage results, right-click it and select
[Merge Project Coverage].

T Test Mavigator BEg v &
13 stub sample
17 target
% Zlib
% Zlib_copy
g zlib_co
g zlib_co

New »

Delete Delete

x

Rename. F2
Import..
Export..

G E

Refresh F5
Close Project

Quality Management Teols >

Collect project log

Merge Project coverage...

2. Select [Merge Project Coverage] menu to open for creating the project name. Enter the project
name to be created in [Project Name].
B merge project coverage results *

Merge project coverage results

Add project's db files(* csp) to merge.
The merged project cannot create and run test.

Project Name: |zlibjnerged

Add project db files to merge:
B3 pwProduct_Workspacetct_3_1_02wzlib# csdatazlib.csp Add...
B3 pwproduct_Workspacetct_3_1_02%zlib_copy®# csdatazlib_copy.cs
a8 P-#Product Workspacewct_3_1_02%zlib_copy_copy#.csdatawzlib_c
=] P-wProduct WorkspaceWet_3_1_02%zlib_copy_copy_copy#.csdataw

Remove

cocl

» By clicking the [Add] button, you can perform a merge coverage function for projects not
included in the workspace.

3. Click [OK] to check that a new project that the project results had been merged has created in the
Test Navigator view. The merged project is displayed with a red mark on the upper right corner.
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Tq Test Navigator

3 stub_sample

J target

=% zlib

=% Zlib_copy

I zZlib_copy_copy

% zlib_copy_copy_copy
=% zlib_merged

b L L .

4. Select the project that the results had been merged and check the coverage view to see the
overall coverages.

") Coverage i3 B E )= o | +") Coverage 37 ® Bkl = a8
Host coverage information of 'dib’ project Host coverage information of “zlib_copy’ project

| Target Function | statement | Bramch | me/DC | Funetion Call|Function| & | | Target Function | | Branch | mcmoc | Function call|Function] A
_tr_align(struct internal_state 4) - 0,00% (0... ™= 0.00% (0... ™= 0.00% (0... == 0.00% (0. == N
_tr_flush_block(struct intemnal_state *.. == 52 35% (. == 43 75% (.. == 000% (0. = 70.00% (.
_trinit{struct internal_state %) =N - 100.00%... ==
_tr_stored_block(struct intemal _state .. ... = 0.00% (0... == 0.00% (0. ==N

_tr_align{struct internal_state *) = ().00% (0... ™= 0.005% (0._. ™= 0.00% (0... == 0.00% (D._== N 1
2
3
| B

- 5 | tr_tally(struct internal_state *, unsig... == 0,00% (0... == 0.00% (... ™= 0.00% (0= N/A
6
7
8

1

2 _tr_flush_blockjstruct internal_state *__jwm 0,005 (... == 0.00% (0._. = 0.00% { 0.00% (0. =N |
3 _tr_init(struct internal_state ¥ == (.00% (0... = N/A = N/A = .00% (0. ==N

4 | _tr_stored block(struct internal_stste _ we 0.00% (0... == 0.00% (D..
S _tr_tally{struct internal_state * unsig... = 0.00% (D... == 0.00% (D
[
7
]
9

-

-

adler32({unsigned long, const unsign._.[== 97 03% (.. ™= 83 33% (. == §6.66% (.. — N/A - adler32(unsigned long, const unsign,. == 11.65% (.. == 20 83% (. == 8 33% (1. = N/A

adler32_combine{unsigned long, un... == 100.00%. . == 100.00%.. == 100.00%... = N/A - adler32_combine{unsigned |ong, un,.. == 0.00% (0... == 0.00% (0... == 0.00% (0.. = N/A
bi_flushistruct internal_state ) = (.00% (0... == 0.00% (0._. == 0.00% (0. = N/& - bi_flush(struct intemal_state *) - 00% (0., == 0.00% (0. ==0.00% (0. = NA
bi_reverse(unsigned int, signed int) == 0.00% (0. == 0.00% (... == 0.00% (0. — N/A - 9  |bi_reverse(unsigned int, signed int) == 100.00%... == 50.00% (.. ™= 0.00% (0..— N/A
10  bi_windup(struct intemal_state #) - 00% (0... == 0.00% (0. w=0.00% (0= N/A& - 10 | bi_windup{struct internal_state *) = 71.42% (.. == 50.00% (.. ™=0.00% (0..= N/A
11 build_bl_tree(struct intemal_state *) == 0.00% (0... == 0.00% (0. == 0.00% 0.00% (0. =N 11 |build_bl tree(struct intemal_state ¥) == 100.00%... == 75.00% (... == 50,00% (.= 100.00%.
12  build_tree{struct internal_state *, stru_.. == 0.00% (0... == 0.00% (D... == 0.00% (0_../w= 0.00% (0. == N 12 |build_treg(struct internal_state *, stru... == 100.00%... ™= 75.00% (... == 50,00% (.. ™= 100.00%.
S Fr e R e A AR N A AR R AR A e P AR I S T e —y = A A M ARG A [ ARG [ AR A
Total 2.95% (1... 1.32% (2... 0.95% (1... 0.00% (D... 1L.75... w Total 11.98% (... B.22% (1... 3.19% (4... 15.24% (...
@ In target testing mode, the coverage of the function including Asm code can not be measured. & In target testing mode, the coverage of the function including Asm code can not be measured.
=] Coverage 2 BEE= 0 |5 cowme = = L= B
Host coverage information of 'zlib_copy_copy’ project Host coverage information of ‘zib_copy_copy_copy' project
| Target Function | statement | ernch | mc/pC | Function Call|Function| & ¢ | Target Function | | Banch | Mc/DC | Function Call| Function] »
13 check header(struct gz_stream *) =005 (0. 0,005 (0... == 0.00% (0. oo L U . um - v e
zreadiveid *, veid *, unsi int - 0. - - L (0. =, i
14 compress(unsigned char *, unsigned... == 0.00% (0... = N/A = NA I o g._reac].\doud :Glﬂ , unsigned int) 0.00% (0... == 0.005% (D... m= D.003% (0. == 0.00% (D.
(e - - -
15 compress2(unsigned char *, unsigne... == 0.00% (0... == 0.00% (0... == 0.00% (0. L 9““;" il | OG0 OO
m——— . e e g = — .
16  compressBound(unsigned long) -—(00% (0. = N/A = NA 72 gzseekivoid *, signed long, signed int) == 0.00% (D... == 0.00% (0. 0L00% (D

73 gesetparams(void *, tigned int, sign... = 0.00% (0. == 0.00% (D... = 0.00% (0... == 0.00% (0..
74 gztellivoid #) = (.00% (0... = N/A = NSA = .00% (0.
75 geungetcisigned int, void ¢) —(1.00% (0... = 0.00% (0.
I 76 | gzwrite(void *, const void *, unsigne... == 0.00% (0... == 0.00%
77 inflate(struct z_stream s *, signed int) == 0.00% (0. ™= 0.00% (0.
78  inflateBackistruct z_stream s *, unsi... w2 05% (1. == 030% (1.
79 inflateBackEnd(struct z_stream s %) == .40.00% (.. == 50.00% (.
80 inflateBackinit_{struct z_streamn_s ¢, .. w13 63% (. == 0,00% (. =0 00% (0
81 inflateCopylstruct z_stream s *, stru... /== 0.00% (0... ™= 0.00% (0... ™= 0,00% (0... ™= 0.00% (0.

17 compress_blockistruct internal_state w0005 (0. == 0.00% (0. == 0.00% {0...
18 copy_block{struct internal_state *, ch... == (0.00% (D.
19 cre32(unsigned long, const unsigne... = 26.08% (.
20  cre32_biglunsigned long, const unsi... == 100.00%...
21 cre32_combine(unsigned long, unsi... == 100.00%.
22  cre32 lithe{unsigned long, const un... == 100.00%... ...
23 deflate(struct z_stream s *, signed int) == 0.00% (0... == 0.00% (0... ™= 0.00% (0...
24  deflateBound(struct z_stream _s *, un...|m= 0.00% (D... == 0,00% (0... == 0.00% (0...

Tatal T T T S s (L 1.93% (4. 1.67% (20 243% (B 14us v | Total 0.65% (Zo1] 0.24% (3er [0.00% (o [0.00% (0| 3.50. [
‘@ In target testing mode, the coverage of the function including Asm code can not be measured. @ In target testing mode, the coverage of the function including Asm code can not be measured.
[") Coverage 52 B E i = O
Host coverage information of 'zlib_merged' project
Target Function | Statement | Branch I MC/DC |Functi0n CalllFunctiDnl ”~

4 | _tr_stored_block(struct internal_state w0 00% (0. == 0 00% (0. =0 00% (0. == 0.00% (0=}

5 | _tr_tally(struct internal_state *, unsig... == 0.00% (0... ™= 0.00% (0... == 0.00% (0_.— N/A - [

6  adler32(unsigned long, const unsign... ™= 98.05% (... == 87.50% (_..== 75.00% (.= N/A —

7 |adler32_combine(unsigned long, un... == 100.00%... ™= 100.00%... == 100.00%... = N/A —

8  bi_flush(struct internal_state #) - 0% (0. |0 00% (0. = 0.00% (0. = N/A — [

9 bi_reverse(unsigned int, signed int) == 100.00%... == 50.00% (... == 0.00% (0..= N/A —

10  bi_windup(struct internal_state #) -7 425 (|- 50 00% (= 0.00% (0. = N/A —

11 build_bl_tree(struct internal_state *)  |== 100.00%. .. == 75.00% (. == 50 00% (== 100.00%. . |[=—
12  build_tree(struct internal_state * stru (== 100 00%... == 75 00% (. == 50 00% (. |[==100.00%. . |[=—
13 check_header(struct gz_stream #) - 0% (0. 0 00% (0. 0 00% (0. =—(000% (0. -

14 | compress(unsigned char * unsigned... == 100.00%... = N/A = N/A == 100.00%... ==Y

15 | compress2(unsigned char *, unsigne.. == 95 23% (. == 87 50% (.. == 75.00% (.. == 100.00%... ==Y

1o mmmmmearelanmd S mriamad lamat — A ANDS —IRIMA — klJA —IRlIA — VS
Total 18.37% (... 11.44% (... 5.82% (7... 17.37% (... 37.71... »

& In target testing mode, the coverage of the function including Asm code can not be measured.
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! The [Merge Project Coverage] function may not work properly when two or more
different functions in the project to be merged have the same function name.
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15.3. Unit Test View
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The [Unit Test] view section is located on the right of the screen. The [Unit Test] view combines the test

and coverage information and provides it in a single view.

[ codescroll Controller Tester RTV(Rerncte Target Vierifier) + Target Plugin (x4 = o ®
|EiIE Edt Search Project Target Window Help
" = =,
5 zlib BE B x» 2 B 0 4.@ YR | B
Mew Froject New Test Import Export Froperties Freferences
{8 Tg | Show Coverage i Coverage - MC/DC L7 Stub ¢! Class Factory < Control Flow Graph - Call Graph = Function Call Hierarchy *") Error
o) compress.c [ adler32 ¢ =0 Uit Test t =1 - v =0
181 D016 (butf ) £ 16 sums unrolled =/ " 5
la buf += 18; Staternent Coverage
83[TF] } while (==n); e
4 Hop(adler); (655 / 0 / 288) 938
MOD(sum2) ;
i type file, function, test, state. issue
e * do remaining bytes (less , still just ene medul Name Result
9[T] 1F (Len) { d modulos if none remaining */ = )
118[TF) while (len 3= 16) { B - _tr_align 170712
11 len -= 16; _b-_ﬂ.uih_hlszk 0./0/12
DO18 (buf) B _tr_init 1/0/0
buf += 16 _tr_stored_block 1/0/8
tr_tally 0/0/3,
s[TF while {len--} { tr
adler +u bt adler32 0/4
sumd += adler; ~ ;’..‘-'.’._'.:;"'_.'-_' 1N/0/0
} ) CiEst] sdler32_combine M/0/0
top(adler); bi_flush 57076
Bz} bi_raverse 1/0/2
' bi_windup 1/0/%
return recombined sums build_bl_tree 0/0/8
return adler | (sum2 << 16); build_tree 1 /04T
} 8 chack_header 21/0/2
. 1/0/0
T adler . 0/0
ukeng adlerl; compressBound 370/ 0
uLong adler2; compress_black 1/0/7
¢ zoff t lend; eopy_block 0/0/5
0/1
unsigned long sumi; "“;: b brdt
unsigned long sumz; ercsl_big . ;i
unsigned rem; crc32_combine 0/2
B ere32_little 9/0/1
* the derivation of this formula is left s an exercise for the reade 5 deflate 271/0/5
DT I /070
::: E :u :lsm; : deflateCopy. 0/0/%
HOD(sum2 )3 daflateEnd 19/0/7
suml += (adler2 & @xffff) + BASE - 1; 8 deflatelnit 20/0/0
sumd += ((adler] 5> 16) & 8xFFFF) + ((adlerd >> 16) & BxFFFf) + BASE - rem 5/0/0
if (suml » BASE) suml -« BASE; 2 /070
if (suml > BASE) suml -= BASE; 0/0
If (sum2 > (BASE << 1)) sumd -= (BASE << 1); d
if (sum) > BASE) sumd -= BASE; ] at ot
return suml | (sumd << 18); deflateSetDictionary. 7/0/T)
4 i tHeade 0/0
v 57070
€ > m 100
T TEarT T ERCICERE

Toolbar menu in the Unit Test view

Toolbar icon

=l Collapse all
== Show as Unique Test Name
El Total
B
8 Failure/Error
g Failure
£
EE

=] Success

LS

Error

o

t2 Function changed
E¥ Run not guaranteed

® Host/Target result different

Description
Hides all test view trees.
Displays by unique test name.

Displays all the tests.

Displays only the tests that the test result is Failure/Error.

Displays only the tests that the test result is Failure.

Displays only the tests that the test result is Error.

Displays only the tests that the test result is Success.

Displays only the tests that the function to be tested has been changed.

Displays only the tests that the test execution is not ensured.

Displays only the test that the host result and the target result are different.
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Pull-down menu in the Unit Test view (V)

i EH~ v= 8

Show coverage at all elements

Menu name Description

Displays the coverage in all items.

Show coverage at all elements (function, test, test case)

Dashboard in Unit Test

Unit Test ntegration Test Be EH~ =08
m v Statement Coverage
(655 / 0 / 283) 938 43.0%
(1719/3995)
type file, function, test, state, issue
Menu Description

m Runs unit tests.

(878 / 0/ 359) 1227 Shows success, failure, error and total of test case.

Selects the coverage type to be displayed in the [Unit Test] view.

v Statement Coverage .
(statement, branch, MC/DC, function call)

43.7%

) ' Shows the selected kind of full coverage.
(1952/4466)

Search

In the Unit Test view, you can search functions, tests and test cases by file, function, test, status
(success, failure, error) and issue name.

Unit Test ntegration Test Heg B~ ~= 0
m v Statement Coverage
(655 / 0 / 283) 938 43.0%

(1719/3995)

|t}-‘pe file, function, test, state, issue |

Status search keyword

In the Unit Test view, you can filter the tests that are displayed by the status search keyword. It provides
searchable keyword recommendation and auto-complete function.

Keyword Description

$TEST SUCCESS$ Test success
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$TEST FAILURES$ %TEST ERROR% Test failure/error

$TEST FAILURES Test failure
$TEST ERROR% Test error

$TEST HAS NOT FUNCTIONS
$TEST NOT GUARANTEES

$TEST RESULT DIFFERENTS

Function changed
Run not guaranteed

Host/Target result different

User Manual - 3.3

* ‘Run not guaranteed’ is a case where test code is generated, but there is no guarantee
that it will run normally. This is the case when using a type that is difficult to specify as a

parameter or return value.

Structure of the Unit Test view

The Unit Test view presents the hierarchy structure of [Function]-[Test]-[Test case]. If there are more

than 100 test cases in a test, they are grouped in groups of 100 to represent a group.

Unit Test Integration Test

BE k- == 0

| v statement Coverage|

(655 / 0 / 283) 938 43.0%
(1719/3995)

type file, function, test, state, issue

Mame

Result Coverage A

v adler32_combine(unsigned long, unsigned long...)

[case] 1
[case] 2
[case] 3
case| 4
case

ixIR(x]Q(x]
o e (@
W | |
@ B |2

5
6
7
8
case| 9
case| 1@
[case] 11
v bi_flush{struct internal_state *)
v 4 bi_flush{struct internal_state *)_@
1 signaled
2
3 Signaled
4 signaled
5
Case| 6 Signaled
7 Signaled
8 Signaled
9
10
11

mrso/mn 100.0% (12712

v 4 adler32_combine(unsigned long, unsigned long, si M/0/0 11

(5/0/6) 11 100.0% 2/2
5/0/6) 11

Tu bi_reverse(unsigned int, signed int)

> G4 bi_windup(struct internal_state *)

> G4 build_bl_tree(struct internal_state *)

> B4 build_tree(struct internal_state *, struct tree_desc_s
> B4 check_header (=truct zz_stream )

>

kd compress(unsigned char *, unsigned long * 2
> > compress2(unsigned char *, unsigned long *...)
» compressBound(unsig

ned long)

> compress_block(struct internal_state *, struct ct_data_s

» M rary hlack/ctcict Sntbonnal ctboba & choe

Item icons in the Unit Test view

Item icon Description

) 0/0/T)7 100.0%

70725 100.0% (5/5
@/0/35) 8 100.0% (717
o/0/8 8 100.0% 11/1"

21/0/2) 23 44 4% ¢
3/0/0)3 100.0% 1/1
B/0/0)6 95.2% 120,27
(3/0/0)03 100.0% /-
asosme 77.5% 5220

m/n/& s ANN NOF o
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None Function
lest Test

case Test case, Test case group

Item status color in the Unit Test view

The execution information of functions, tests, and test cases in the Unit Test view is represented by
colors.

Color Description

Function/Test: If the execution result of all the test cases under it is success.

Creen Test case: The result of execution is success.

Function/Test: If only test cases with failure and no test cases with errors exist under it.
Blue ) S

Test case: The result of execution is failure.
Red Function/Test: If test cases with error exist under it.

Test case: The result of execution is error.

Function/Test: All test cases have not been executed under it and test cases that are not
Orange guaranteed to run exist.
Test case: Run not guaranteed.

Function/Test: All test cases under it have not been executed.

Black 15t case: Not been executed.

Function node

The Function node provides the function name, the coverage and the test case execution results
(success, failure, error and total).

«¥s For the coverage for each function node, the test execution result of the other function
may be applied depending on the call relationship between functions.

Double-click on a function node to check the location of the function in the Source Code Editor window.
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Unit Test Integration Test

B&E- v-0

| v statement Coverage|

(655 / 0 / 283) 938 43.0%
(1719/3995)

type file, function, test, state, issue

Mame

Result Coverage (A

I v adler32_combine(unsigned long, unsigned long...)

mrso/mn 100.0% r12/18)

~ ml adler32_combine{unsigned long, unsigned long, si
1
2
3

10
11
v bi_flush{struct internal_state *)
v bi_flush{struct internal_state *)_&
1 signaled
2
3 Signaled
4 Signaled
5
6 Signaled
7 Signaled
8 Signaled
9
10
11
b4 bi_reverse(unsigned int, signed int)
b4 bi_windup(struct internal_state *)
b4 build_bl_tree(struct internal_state *)
b4 build_tree(struct internal state *, struct tree desc_s

bd check_header (=truct zz_stream )

kd compress(unsigned char *, unsigned long *...)}
> B4 = compress2(uns
» compressBound(un
» compress_block(=truct in
~ M orams hlack /oot fedaen

d char *, unsigned long *...)

gned long)
rnal_state *, struct ct_data_s

ctmta ¥ rhae

Context menu of the function node

Create Test
Copy Test
W Delete

Show Call Graph
Show Control Flow Graph
Show MC/DC

Host Cutput Value -= Expected Value
Target Cutput Value -= Expected Value

Set related file

Relevant issues settings...

gig Import Test Data
gy Export Test Data

Generate binary for debugging
£t Add Stub..

Select Function
Deselect Function

mm Generate coverage report..

170/ 1

5/0/6) 11
5/0/6) 11

100.0% (2/2

3/0/2)5
3/0/5 8
0/0/88
o/0/n7
21/0/2) 23
3/0/0)3 100.0% (1
B/0/0)6 95.2% (20,27
3/0/003 100.09% 1
1/0/ns 77.5% (c220
mn/ns8 5 4M/ANMN NOS
Ctrl+C
Delete
bl
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Context menu Description

Create Test Creates a test of the selected function.

Copy Test Copies tests of the selected function.

Delete Deletes tests and test cases of the selected function.
Show call graph Shows the function call graph of the selected function.
Show control flow graph Shows the control flow graph of the selected function.
Show MC/DC Shows MC/DC of the selected function.

Host output value -> Expected value  Pastes the host output value to the expected value.

Target output value -> Expected value Pastes the target output value to the expected value.

Set related file Selects the files containing that test.
Relevant issues settings Associates the selected test with the issue of the management tool.
Import Test Data Imports the test data saved in local.
Export Test Data Exports the test data to local.
Add Stub Adds the stub to the selected test.
Select Function Selects the checkbox of all the functions selected by a mouse.
Deselect Function Deselects the checkbox of all functions selected by a mouse.
Generate coverage report Exports the selected test coverage to the selected path.

Test node

The test node provides coverage, test case execution results(success, failure, error, total).
Double-click on a test node to open its Test Editor.
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Context menu of the test node

Add Test Case

Generate test cases automatically

Host Cutput Value -= Expected Value

Target Output Walue -= Expected

Initialize Test Case

Duplicate
Duplicate multiple times...
Delete

Rename...

Set related file

Relevant issues settings...

Import Test Data
Export Test Data
Large test data

C. [

Generate binary for debugging
Add Stub...

Select Test

Deselect Test

Generate coverage report._..

User Manual - 3.3

Context menu
Add Test Case

Generate test cases
automatically

Host output value -> Expected
value

Target output value -> Expected
value

Initialize Test case
Copy

Paste

Duplicate

Duplicate multiple times
Delete

Rename

Set related file

»
Value
Ctrl+C
Ctrl+V
Ctrl+D
Delete
Fe
3
»
Description

Adds the test case to the unit test selected.

Creates the test case in various ways.

Pastes the host output value to the expected value.

Pastes the target output value to the expected value.

Delete all the test cases.

Copies the test and test case.

Pastes the test and test case.

Duplicates the test and test case.

Duplicates tests and test cases as many as the number entered.
Deletes the test and test case.

Modifies the test name.

Selects the files containing that test.
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Relevant issues settings
Import test data
Export test data

Large test data

Add Stub
Select tests
Deselect tests

Generate coverage report

* Rule for importing test data

User Manual - 3.3

Associates the selected test with the issue of the management tool.
Imports the test data saved in local.
Exports the test data in local.

Exports it locally or registers the file written by the user to the target test
as a test case.

Adds the stub to the selected test.
Checks all checkbox of the tests selected.
Checks all checkbox of the tests selected.

Exports the selected test coverage to the selected path.

When importing the test data, if you select multiple test data numbered with the test name, it
imports those files by merging them.

Import test data

You can import the test data in various formats (csv, xlIsx, txt, json).

Add Test Case

Generate test cases automatically

Host Qutput Value -» Expected Valus

Target Output Value -= Expected
Initialize Test Case

Copy

Paste

Duplicate

Duplicate multiple times...
H Delste

Rename...

Set related file

Relevant issues settings...

Import Test Data
Export Test Data
Large test data

C. [

Generate binary for debugging
£} Add Stub..

Select Test

Deselect Test

mm Generate coverage report...

Value

Ctrl+C
Crl+V

Cirl+D

Delete
F2

» Basic format data

E23
g2y External format data

1. In the context menu of Unit

Test view, click [Import Test Data] and select either [Basic format data]
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or [External format data].
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2. If you select [Basic format data], the test data with the format (csv) exported from the Controller

Tester is imported.

3. If you select [External format data], the test data is imported from the files in various formats (csv,

xIsx, txt, json).

B \mport Test Data O x
Import Test Data

Select the format of the data file, and select the data file to import.

File format:

CT csv file ZTFH 2.7 Description: Controller Tester json format.

CT excel file 7t 27|

CT multiple test excel file 7t%
multiple_test_data_importer_ir
multiple_test_data_importer_Lt
multiple_test_data_importer_w
text file 7HH 27|

Data file

File extension: json

open script location

Browse...

Remove

oK Cancel

Generate test cases automatically

It creates a test case by using Flat/Pairwise/Random combination, Generates with Function Generator,

and Search-based Test case Generation (CS Labs).

Name

~ @ adler32(unzigned long, const unsigned char *...

L~ INCEEE-T. —
o Add Test Case

<
<@
Q:

Generate test cases automatically

Host Qutput Value -> Expected Value
Target Qutput Value - Expected Value
Initialize Test Case

Copy Ctrl+C
Paste Ctrl+v
Duplicate Ctrl+D
Duplicate multiple times.

Delete Delete
Rename... F2

Set related file
Relevant issues settings.
Import Test Data
Export Test Data

Large test data

Generate binary for debugging

1 Add Stub.

Select Test
Deselect Test

m  Generate coverage report.

Result. Coverage
7/0/6)13 97.0% (100/102
7/0/6)13

Flat Combination
Pairwise Combination
Random Combination

Generate with Function Generator

Search-based Test case Generation (CS Labs)

11/0/0) 11 100.0% 11a/13

11/0/0 11

In the context menu of Unit Test or Integration test view, click [Generate test cases automatically]

and select one among [Flat Combination], [Pairwise Combination], [Random Combination],

[Generate with Function Generator] and [Search-based Test case Generation (CS Labs)].
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Method Description
Flat Combines simply based on variables having the largest number of test data.

Combines so that each selected parameter data is paired at least once with the
Pairwise parameter data other than itself.
% The number of variable partitions must be more than 2 and less than 52

Combines the test data as many as the number of test cases that the user defines
Random any value between the minimum value and the maximum value for the variable
partition of input parameters.

Generate with Creates a test case by using six function types. (Ramps, Random, Range, Sine,
Function Generator Toggle, and Single Value)

Search-based Test

case Generation A1EdiEs d 1981 Lase 1Y VSIIY LAnSK
(CS Labs) % Currently, only C language supported

2. If you select [Random combination], the Random combination window is displayed so that the user
can enter the number of test cases.

B Random Combination >

Mumber of Test case |5

Cancel

3. If you select [Generate with Function generator], you can select the function type (Ramps, Sine,
Random, Toggle, Range, Single value and None) and change the settings of the function selected
via the settings of the function generator. In the properties window of the project, you can set the
function generator information in [Test] -> [Generate test cases automatically] -> [Function
Generator].

Page 104 of 249



Suresofttech

. Generate with Function Generator
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— *
Test Parameter  Type Function t... Function type: |Sine | v
adler unsigned |..  Sine
buf_rmem([0 unsigned ... Mone
- ol .g ) Amplitude: |I3-.I3- |
l=n unsigned i.. Mone
Period: | 1 | [samples]
Phase: |I3-.I3- | [deq]
Offset: (0.0 |

sample interval:
Sample count:
Start value:
Type Min:

Type Max:

a. Common settings

0

0

a0

0.0
4204967295

Function Generator Setting

Cancel

You can change the value in [Project] -> [Properties] with the setting value common to each

function.
Setting Description
_Sample The interval of samples to be sampled from the function
interval
’s\l:rrr?pblir of The number of samples to be sampled from the function(The number of test cases)
The default value at which the function is started (the values are created based on the start
Start value
value)
Minimum The minimum value of variable partition (if the return value of the function is less than the

value of type minimum value of type, the minimum value of type is returned.)

Maximum The maximum value of variable partition (if the return value of the function is greater than the
value of type maximum value of type, the maximum value of type is returned.)

b. Ramps function

It is a function that creates a pulse by using Pre, Post and Hold values. If the number of samples is

greater than the period of the function, the function is called recursively.
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Setting Description

Pre delay The time to last Pre/Post sample value

Rise samples The time to rise from Pre/Post sample value to Hold sample value
Hold samples The time to last Hold sample value

Fall samples The time to fall from Hold sample value to Pre/Post sample value
Post delay The time to last Pre/Post sample value

Pre/Post delay value Pre/Post delay sample value

Hold value Hold sample value

c. Random function

It is a function that creates a random value between the minimum value (Min) and the maximum
value (Max).

Setting Description
Min The minimum value of random range

Max The maximum value of random range

d. Range function

It is a function that creates values that increments or decrements by a certain interval (Step Size)
between the minimum value of type and the maximum value of type.

Setting Description

sS,itzeep The size of increment or decrement value

Hold The number of times that the Step size holds

Risin The function type that rises by the Step size
9 Ex)if the step size is 30, 0,30,60......

Falling The function type that falls by the Step size

Ex) if the step size is 30, 100,70,40......

If the result value of function meets the minimum/maximum value of type, the function type that
Alternate changes to rise or fall.
Ex) if the step size is 30 and the maximum/minimum value are 0~100, 0,30,60,90,60,30,0......

e. Sine function

It is a function that creates Sine value. If the number of samples is greater than the period of the
function, the function is called recursively.

Setting Description

Amplitude The amplitude of Sine function
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Period The period of Sine function
Phase The phase of Sine function

Offset The offset of Sine function

f. Toggle function

It is a function that creates FirstValue and SecondValue repeatedly.

Setting Description
First value The first value that is repeated in Toggle function

Second value The second value that is repeated in Toggle function

g. SingleValue function

It is a function that returns only a constant single value.

Setting Description

Value  The value to be created

h. None

It does not create a function.

Relevant issues settings

User Manual - 3.3

It associates the selected test with the issue in the issue management tool registered. The Controller

Tester supports the following issue management tools: JIRA, Trac, Redmine, Mantis, Bugzilla.

1. In the context menu of Unit Test view, click [Relevant issues settings...].
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Add Test Case

Generate test cases automatically 3
Host Output Walue -> Expected Value

Target Cutput Walue -= Expected Value

Initialize Test Case

Copy Ctrl+C
Faste Ctrl+v
Duplicate Cirl+D
Duplicate multiple times...

W Delete Delete
Rename... F2

Set related file

Relevant issues settings... I
gug Import Test Data »
g Export Test Data

Large test data »

Generate binary for debugging
i+ Add Stub...

Select Test

Deselect Test

mm Generate coverage report..

2. Enter the information of the issue management tool in the configuration file
(IssueManagement.ini).

| < | UnitTester - O X

Home Share View [7]

€« > v 4 <« AppData » Roaming » CodeScroll » UnitTester v O Search UnitTester -]

~

A MName Date modified Type Size

# Quick access
[ Desktop
4 Downloads
Documents
[=] Pictures

.metadata

122
| 1] issueManagement.ini

7 PM Fll_afcl(ler
:07PM_ Configuration sett... {xs

% % % %

CodeScroll Cont
cT32
B Music

@ OneDrive

[ This PC
[ Desktop
Documents
4 Downloads
B Music
[&=] Pictures
B videos
‘o Local Disk (C:)

S4 N Drive (M Ve Y
Zitems  1item selected 0 bytes

3. Add the issues to be associated with the test.
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B s<t associate issue O >

Select the issues to associate with the 1 selected tests.

|t_\,-'p-e filter text |
ZLIE-5 [ add
B Add associated issue x

Enter the ID of issue to add

[z |

ok || cencel |

lssue management tool information

Type:  JIRA Open Cenfiguration Folder

Address: http://211.116.223.80:3080 Update information

| oK || cancel |

-

4. Check the checked issue list and click [OK].

B set associate issue O X

Select the issues to associate with the 1 selected tests.

|t}-‘pe filter text |
ZLIB-5 l Add... ;
Edit...
Remove
lssug management tocl information
Type:  JIRA Open Configuration Folder

Address: http://211.116.223.80:8080 Update information

oK || cancel |
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15.4. Integration Test View
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The [Integration test] view provides the integration test unit that can group the unit tests. The unit tests

under the integration test run in order with the context maintained.

1B Codescroll Controller Tester RT(Remote Target Verifier) + Target Plugin (c64)
|fle E8t Sewch Proect Iaget wind

3 zlib

elp

T T ey g P ¥ B [ s s

New Project New Test Import Export Properties Preferences

©# Tm  Show Coverage
(8 sdlerszc 13 =
Do16(buf);
buf += 16;

HoD(sumz);

}

do remaining bytes
if (len) {
while (len >= 16) {
len -= 165
D016 (buf);
buf += 167
1
while (len--) {
adler 4+ “bufes;
2 4= adler;

1
HOD(adler) ;
POD(sum2) ;

return adler | (sum? e< 1€);
}

32_combine(sdlerl, sdlerd, lenZ)

unsigned long sun2;
unsigned rem;

ivation of this forsula is le
igned) (len2 & BASE) ;
exfiff;

iy

HOD(s1m2);

suml +» (adlerd & OXFFFF) + BASE - 1

sun2 += ((adlerl >> 16) & GxfFff) + ((adler2 >> 16) & Bcffff) + BASE - res
if (suml > BASE) suml -= BASE;

+
F (omd > base) s - s
 (sum2 > (BASE cc 1)) sum2 -« (BASE << 1);
 (sum2 > BASE) Sumz -= BASE:

eturn susl | (susz << 16);

41 adler3?_cambine{unsigned long,

S Coverage JMC/DC L Stub b Class Factory <& Control Flow Graph - Call Graph T2

Function Call Histarchy ) Error

a Unit Test Integration Test | = =
m Call Coverage
33/0/1) 34 44.1%
type il
Mame. Result overage
v [ INTEGRATION_@ 33701, N/A
v [H ¢ 11/0/0
17070
aso
~ bi_flush 0/0/1
i8] 1 Signaled
2
3
58 4
5
&
7
8
9
18
1
R |

Toolbar menu in the Integration test view

Toolbar icon

=l Collapse Al

" Move Up Test
5 Move Down Test
U Create

&= Shows as Unique Test
Name

£l Total

B .
B Failure/Error

Description

Hides all test view tree nodes.
Moves the selected test up.
Moves the selected test down.

Creates an integration test.
Displays with unique test name.

Displays all the tests.

Displays only the tests that the test result is Failure/Error.
& Failure
£Ed Error

:'EJ Success

Displays only the tests that the test result is Failure.
Displays only the tests that the test result is Error.
Displays only the tests that the test result is Success.
Ez Function changed Displays only the tests that the function to be tested has been changed.
v Run not guaranteed Displays only the tests that the test execution is not ensured.

Displays only the test that the host result and the target result are

® Host/Target result different different
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Pull-down menu in Integration Test view (V)

B | E| B EHr = 8

Show coverage at all elements

Menu Description

Show coverage at all elements Displays the coverage in all items(Integration test, test, test case).

Dashboard in Integration Test

Unit Test Integration Test O L EEEy =8
m v Call Coverage
(33/0/1) 34 44.1%

(165/374)

type file, test, state, issue

Menu Description

m Runs integration tests.

(878 / 0/ 359) 1227 Shows success, failure, error and total of test case.

Selects the coverage type to be displayed in the [Integration Test] view.

v 5Statement Coverage .
(statement, branch, MC/DC, function call)

43.7%

) ' Shows the selected kind of full coverage.
(1952/4466)

Search

In the Integration Test view, you can search the integration tests, tests and test cases by file, function,
test, status (success, failure, error) and issue name.

Unit Test Integration Test B LGB e = B
m v Statement Coverage

(33/0/0) 33 43.0%

(1719/3995)
(1719/3995)

ltyp—c— file, test, state, issue I

Status search keyword

In the Integration Test view, you can filter the tests displayed by the status search keyword. It provides
searchable keyword recommendation and auto-complete function.

Keyword Description
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$TEST SUCCESS$

$TEST FAILURE$ %TEST_ ERROR%
$TEST FAILURES

$TEST ERROR$
$TEST_HAS NOT FUNCTION$
$TEST NOT GUARANTEES

$TEST RESULT DIFFERENTS%

User Manual - 3.3

Test success

Test failure/error
Test failure

Test error
Function changed
Run not guaranted

Host/Target result different

Structure of the Integration Test view

The Integration Test view presents the hierarchy structure of [Integartion tes]-[Test]-[Test case].

Unit Test

type file, test, state, issue

Integration Test

Mame

B L@ EEy = 0

v Call Coverage

44.1%

(165/374)

(33/0/1) 34

Result Coverage

v INTEGRATION_®©

[case] 1
[case] 2
(case) 3
[case] 4

case] 5

v [1eS1] adler32_combine(unsigned long, unsig

(33/0/1) 34
(11 /0/0) 11

N/A

tase | &
[case] 7
case] 8
[case] 9
10
11

> [1est] adler32_combine(unsigned long, unsig

(11070 11

Item icons in the Integration Test view

Item icon Description

None Integration Test
est Test
lesi® Global variable test
Test case, Test case group

Item status color in the Integration Test view

The execution information of functions, tests, and test cases
by colors.

Color Description

in the Integration Test view is represented
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Green
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Integration Test/Test: If the execution result of all the test cases under it is success.

Test case: If the result of execution is success.

Blue

Function/Test: If only test cases with failure and no test cases with errors exist under it.

Test case: If the result of execution is failure.

Function/Test: If test cases with error exist under it.
Test case: If the result of execution is error.

Red

Function/Test: All test cases have not been executed under it and test cases that are not
Orange guaranteed to run exist.
Test case: Run not guaranteed

Function/Test: All test cases under it have not been executed.
Test case: Not been executed

Black

Context menu in Integration test view

Create Test .

Create sub-integration fest

Copy
k] Paste

Duplicate

Duplicate multiple times...

Paste as sub-integration test

W Delete
Rename...

Select Test

Deselect Test

Generate binary for debugging

Crl+C
Ctrl+
Cirl+D

Delete
Fz

Context menu
Create Test

Create sub-integration
test

Copy

Paste

Duplicate

Duplicate multiple times

Paste as sub-integration
test

Delete
Rename
Select tests

Deselect tests

Description

Creates the dialog for creating a test
Creates a sub-integration test

Copies the test and test case

Pastes the test and test case

Duplicates the test and test case

Duplicates tests and test cases as many as the number entered

Pastes the integration test copied into the integration test selected as a sub-
integration test

Deletes the test and test case
Modifies the test name
Checks all checkbox of the tests selected

Checks all checkbox of the tests selected
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Generate coverage

Exports the selected test coverage to the selected path
report

Create Integration test and Rename

The integration test can be created in the toolbar menu. The name of the integration test is assigned
automatically and can be changed by using [Rename] context menu.

* Create
Unit Test Integration Test T al@E|l2 e v 8
| v  Statement Coverage‘

(33/0/0) 33 43.0%
(1719/3995)

type file, test, state, issue
Name Result Coverage
v [ INTEGRATION_® 33/0/0) 33 100.0% (12/1
b adler32_combine{unsigned long, unsigned long, signed 11/0/0) 11
1
2

[case] 3

[case] 7
[casel 8
[case] 9
[case] 10
[Ease] 11

* Rename
Unit Test Integration Test 4| E B E = O
m | b Statement Coverage|

(33/0/0) 33 43.0%

(1719/3995)

type file, test, state, issue

Mame Result Coverage
(33/0/0) 33 e
v [ INTEGRAT F——— i (33/0/0) 33 100.0% (12,12
v adl b-i . Rename O x
1 Create sub-i
]

] Copy MNew name:
Tl Paste

Duplicate

Duplicate m oK | | Cancel ‘
Paste as sub

¥ Delete Delete

[case]
[case] ]
[case] {
[case]

case| ¢

Rename... F2
] Select Test

> [IEst] adl
> [Eest] adl

(11/0/0) 11

Deselect Test Es -
- (17070 11

Generate binary for debugging

Sub-integration test

You can create a sub-integration test under the integration test by using [Create sub-integration test]
context menu or pasting an existing integration test into other integration test using [Paste as sub-
integration test] context menu.
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Unit Test Integration Test

type file, test, state, issue
MName
v INTEGRATION_@

v INTEGRATION_1

w [iest] adler32_combine(unsigned long, unsigned long, signe

[case] 1
[case] 3
[casel 4
[casel 5

> [fest] adler32_combine(unsigned long, unsigned long, signed

User Manual - 3.3

B4 S| E|EEr Y= 0

v  Statement Coverage

43.0%

(1719/3995)

(33/0/0) 323

Result Coverage
(33/0/0) 33 100.0% (1210
(11/0/0) 11
22/0/0) 22
(11/0/0) 11

Add a test and change the order of run

There are four ways to add tests to the integration test.

oD~

You can select an integration test and create it by using [Create Test...] context menu.

You can add by dragging and dropping the test in the Unit Test view to the integration test.
You can select the test of Integration Test view and copy/paste it by using the context menu.
You can select the test in the Unit Test view and copy/paste it by using the context menu.

There are two ways to change the execution sequence for the test.

1. You can select a test or test case and change it by moving with a mouse.

2. You can select a test or test case and change it by selecting either “Move test up” or “Move test

down” in the toolbar.

Unit Test Integration Test

type file, test, state, issue
MName
v INTEGRATION_@

v [Iest] adler32_combine(unsig

[case] 1

e
e
e
e
e
e
e

[Ease] 11

> [fest] adler32_combine(unsig

v Call Coverage
(33/0/1) 34 44.1%
(165/374)
Result Coverage
(33/0/1) 34 N/A
signed (11/0/0) 11
signed (Mmso0/001

E|E‘.§|§3 H v= 0

The coverage result of Integration Test

If you select the integration test, the result can be checked in the coverage view.
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Unit Test |ntegraﬁonTest] B4 i@ B Er =0

| v statement Coverage|

(33/0/0) 33 43.0%
(1719/3995)

type file, test, state, issue

Name Result Coverage
+ [ INTEGRATION_® (33/0/0) 323

w [[@est] adler32_combine(unsigned long, unsigned long, signed 11/0/011

1

2

3

4

5

6

7

8

9

10

11
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It shows the coverage of the function to be tested after test has been run as a percentage.

|='] Coverage &3

Host coverage information of 'zlib' project

e il = B

1
2
3
4
5
B
7
8
9

10
11

Total

Target Function | Statement Branch MC/DC IFunctiun CaIII Funr:ti...l "
_tr_alignistruct internal_state ) -2 T2% ... . T0.00% . (.40 000 . | 100.00.. (=Y
_tr_flush_blockistruct internal_state . == 54 75% . == g2 505 . == 35 355 . (== 70 000 ==Yy
_tr_initistruct internal_state #) 1 00.00%... = N/A = M/A - 0000, |y
_tr_stored_block(struct internal_stat._. (== 100005 (== 100 00%.. == 100.00%._ == 100.00.. ==Yy
_tr_tally(struct internal_state * unsi_. == 22575 ==(Q00% (. ==0300% (. = MN/A -
adler32(unsigned long, const unsig... ™ 93.05% ... == 37.50% ... == 75.00% .. = MN/A =
adler32_combine(unsigned long, u... (== 100.00%... == 100.00%... ™= 100.00%... = M/A -
bi_flush(struct internal_state # = 00.00%. . == 100.00%... == 1 00.00%..[— N/A -
bi_reverse(unsigned int, signed int) ™= 100.00%... ™= 100.00%... ™= 100.00%...— N/A -
bi_windupistruct internal_state #) = 00.00%. . == 100.00%... == 1 00.00%..[— N/A -
build_bl_tree(struct internal_state *) |== 100.0:05%...|== 75.00% ... == 50.005% ... == 100.00... ==Y

43.02% (... 28.51% (... 19.07% (... 44.11% (... 100.0...

& In target testing mode, the coverage of the function including Asm code can not be measured.

Coverage type provided in Controller Tester

Cover

Statement

Branch

MC/DC

age Description

Percentage of branch executed by the test

Percentage of source code statement executed by the test

100% branch coverage includes 100% decision coverage and 100% statement coverage

in MC/DC view)

Function

call

Function

Percentage of the function called by the test among all the functions

Label icon in Coverage view

Icon

i

© Function containing Asm code

Description

Function changed

Toolbar menu in Coverage view

Toolbar icon Description

Percentage of functions that have been called at least once in all functions

Coverage considering the condition coverage and the decision coverage complexly(described
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E: Shows coverage for each test.
IlE: Shows full coverage.
3] Shows full coverage(including the external coverage).

Show Coverage

The Coverage view shows the coverage information of the test or test case selected in the Unit Test
view and Integration Test view. If you click [Show full coverage], the coverage information for all tests
can be checked by merging them. And if you click [Show full coverage (Include External Coverage)], it
shows also the coverage imported externally by merging them.

The coverage for the items selected in the tree is displayed at the bottom of the Coverage view.
Total 43.02% (171...| 28.51% (603/2115) | 19.07% (239/1253) 44.11% (165/... 100.00% (114/...

In the Coverage view, the coverage for each function is displayed for the items selected in the Unit or
Integration Test view.

[+") Coverage &3 e El L= O
Host coverage information of 'zlib' project

Target Function | Statement Branch MC/DC IFunctiun CaIII Funr:ti...l "

? _tr_alignistruct internal_state #) -2 2% | 0000 . | AQ 000 . (e 0000, ey

2 | _tr_flush_blockistruct internal_state  |=m 54 7g% == g2 50% . == 35 36% . == 70 00% =y

3 | _tr_init(struct internal_state ¥ = 00 00%. . |= N/A — NSA 000 . |y

4 | _tr_stored_block(struct internal_stat.. (== 100.00%_ == 100005 (== 100 00%. == 100 00 |(w=Y

5 |_tr_tally(struct internal_state * unsi.. ™= 22 2% == 00% (. ==000% (.. = N/A -

6 adler32{unsigned long, const unsig... ™ 98.05% ... == 87.50% .. == 75.00% .. — N/A =

7 |adler32_combine{unsigned long, u... ™= 100.00%... == 100.00%...[== 100.00%... = N/A -

8 | bi_flushistruct internal_state % = 00.00%. . == 100.00%... == 1 00.00%..[— N/A -

9 | bi_reverse{unsigned int, signed int) == 100.00%... == 100.00%...[== 100.00%... = N/A -

10  bi_windup(struct internal_state #) w1 00.00%. .| == 100.00%... == 100.00%...[— N/A -

11 |build_bl_tree(struct internal_state *) |== 100.00%... == 75.005% ... == 50 00% .. [==100.00.. ==Y
Total 43.02% (... 28.51% (... 19.07% (... 44.11% (... 100.0... «

& In target testing mode, the coverage of the function including Asm code can not be measured.

In the Coverage view table, you can the control flow graph, the function call graph and MC/DC for each
function via the context menu.
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[z MR =

| Target Function Staternent Branch MC/DC IFunctiDn CaIII Functi...| "
d TTTTTT . R70.00... "®40.00... 7 100.00...° Y
2 | _tr_flush_blockistru SiIlLs 62.50% ... w35 365 . (= 70005 .. (mmY
3 |_trinit(structinterm  ohow Call Graph N/A [ ON/A == 100.00. ==Y
4 | _tr stored_blockstr Show MC/DC 100.00%. == 100.00%._[== 100.00_. (==Y
5 |_tr_tally(struct internal_state #, unsi.. == 22 22%  ==(00% (.. ==000% (.. = N/A -y
6 adler32{unsigned long, const unsig... = 98.05% ... == 37 50% .. == 75.00% ... — N/4& -
7 |adler32_combine{unsigned long, u... == 100.00%... ™= 100.00%...[== 100.00%... = N/A -
8 | bi_flush(struct internal_state #) | 00 005, (= 00 00%. == 00.00%... — N/A =
9 | bi_reverse(unsigned int, signed int) ™= 100.00%... ™= 100.00%... ™= 100.00%... = N/A -y
10  bi_windup(struct internal_state #) = 30.00%... == 100.00%... /== 100.00%...[— N/A -y
11 |build_bl_tree(struct internal_state *) |== 100.00%...[==75.00% ... ==50.00% ... == 100.00... (==Y
Total 43.02% (... 28.51% (.../19.07% (... 44.11% (... 100.0... «

@& In target testing mode, the coverage of the function including Asm code can not be measured.

If you enable [Show Coverage] icon in the main toolbar and click the wanted test case in the Unit/

Integration Test view, it shows which part of the source code is covered by using the color information.

The green color indicates that the code is executed and all branches are covered, the red color indicates

that the code is not executed, and yellow color indicates that the portion of the branch is covered only.

You can check T/F of the branch statement covered in vertical column left to the source code editor.

[ CodeScroll Controller Tester RTViRemote Target Vierifier) « Target Plugin (064) - o x
File Edit Seach Broject Jaget Window Help
1 = T N A ra - e H a
3 2lib = B x A = e Heost @) X B [ clocbal search cwl-3) ||
New Project NewTest Import Expart Properties Freferences
[ & T | Show Coverage 3 Coverage —JMC/DC (i1 swb (&) Class Factory < Control Flow Graph <% Call Graph T Function Cail Hierarchy ™) Emor
¢ adler32c 1 =0 Unit Test B & =0
”15; while (8) ~ v Statement Coverage
2 s eien ron(a) 8 % aist [ Run » ] =
& define 1KD4(a) 2 ¥ BASE (18 /0/6) 24 2.9%
58 sendif 118/3995
-:-\ type file, function, test, state, issue
57 ong Name Result Coverage -
58 ulong adler; Eal 3 5 led
58 const Bytef *buf; 5 3 Signaled
- LInt len; 58 4 Signaled
- ( 5
unsigned long sunZ,
unsigned nj
lit Adler-32 into component sum
sun2 = (adler >3 16) & BxFfff; cosgl 9 Signaled
adler &= Bxffff; EASE] 18 Signaled
in case user Likes doing a byte at a time, keep it =
iF (Len == 1) { r 3
1 adler += buf[8]; i :
72(F] if (adler >= BASE /070 100.0%
4 sum2 += adler; € >
S[F] if (sumd >= BASE
sdlerd2junsigned long constu_ 51 =g
turn adler | (sum2 << 16); .
. | et I ) Test info izlibyadler32_test0) i
80 /* & initial Adler-32 value (deferred check for len y
silF] et 1 D Test Structure CL @ i Testinfo Edit
h T 8 view and edit the inforrnation in the test ‘Change the notation edit the partition
[2 i case shert lengths are provided, omewhat Fas Name i s St Numeral system
T < " a
|-} 1 [.‘;k (linf-) t v Parameter/teturn ® 10 Numersl Systern ()16 Numeral Systen
S ey v o adier : uong ] :
S ] o adier : unsigned leng Varable Partition
} ~ o buf © const Bytel =
T¥] if (adler >= BASE) w o [0 : Bytel Add
adler -= BASE; v o [0] : Byte
HOD4{ sum2) ; /* enly added s0 many BASE's *f o aned ¢ & Single Valug Add
return adler | (sum2 << 16); @ [0 - unsigned < S
w o len | unt Partition List
o len : unsignedint & o
Length equires ane medula cperation * w o returmivar © ulong
TF] while (len >= W) { o returnviar © unsigned e = — Default
n -= _ —
a - X /16, F* wux s divisible by 168 *f BMSIN cal Cock ‘18"
[ = After call code . foefans
P Test info | Test Case| Test Code| Configuration
W o 0ev [
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15.6. MC/DC View

The [MC/DC] view shows the information of MC/DC coverage(Modified Condition/Decision Coverage).

MC/DC coverage

MC/DC is the improved condition/decision coverage allowing each individual conditional expression to
independently affect the result of the whole conditional expression without being affected by the other
individual conditional expressions and it is stronger than the conditional/decision coverage.

If there is no change in the other conditions and it affects the result when the own state has changed,
the state can be said to satisfy MC/DC, and the conditions for creating the truth table are as follows.

« The state of decision(decision statement) must satisfy at least once all possible results(true, false).

+ All individual conditional expressions belonging to the decision must satisfy at least once all
possible results(true, false).

« Each conditional expression belonging to the decision affects independently the result value of
decision it belongs to without being affected by the other individual conditional expressions.

MC/DC view table

+ View combination lists satisfying the target coverage
The following figure is a view that can identify easily the combinations which need to be covered to
achieve the target coverage.
The left section shows the list of Decisions for the selected functions, below which the list of
combinations satisfying the target coverage are displayed.
The right section shows the truth table of the selected Decision or combinations and whether or
not it is covered. The covered combination is displayed in green and the uncovered combination is
displayed in red.
In the Preferences page, you can change the target coverage rate and the screen view mode. And
you can select all for the truth table and use ‘Ctrl + C’ or Copy clipboard function from the context
menu.
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~ZMC/DC 2] B ¥ = O
zlib »> Default Module == inflate.c == inflatelnit2_
v © Decision 0 DO = {((CofIcn)||c)

1] 1 2 3

-4 (0,1,2,3) (100%] L CO: version == 0 T|F|F|F

~ © Decision 1 L C1: version[0] 1="1.2.3"[0] x | T|F|F
—4 ©.1) (100%) L C2: stream_size |= {int)(sizeof(z_stream)) x | x| T|F

w O [Decision 2 T T T F
—g (0,1) (100%)

5 © Decision 3

» © Decision 4

5 © Decision 5

5 € Decision &

» @ Decision 7

£ * | # If a decision or a condition has too many combination lists, only the top 20 is s

» View combination lists satisfying the coverage for each condition
The following figure is a view that can identify a one-pair combination satisfying one condition. The
left section shows the list of combinations that satisfies the coverage for each condition. The right
section shows the truth table for the selected combinations and whether or not it is covered.

—JMC/DC 2 H ¥ = O
zZlik == Default Module == inflate.c == inflatelnit2_
wv © Decision 0 D0 = ((cojcnfica)
v 4 0 L CO: version == 0
= (0, 3) L 1 version[0] 1="1.2.3"[0]
w -4 Cl L C2: streamn_size |= (int)(sizeof(z_stream))
& (1,3)
Q2
% (2 3)
Decision 1
Decision 2
Decision 3
Decision 4
Decision 5
Decizion @
Decision 7

= x X H o
M| M| M| T W

<

000000

& If a decision or a condition has too many combination lists, only the top 20 is s
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15.7. Stub View

In Controller Tester, if there are no libraries used in the target function when executing a test, if the
libraries are not yet developed, or if the variables not declared are used, it creates automatically the
stubs instead. The stubs are created when running the test and the body is not implemented.

You can add stubs directly in addition to the stubs created in Controller Tester. Multiple stubs can be
created for the same function and the stubs created can be linked to each test.

You can control the behavior of each stub by using user macro within the stub. The value used in the
user-entered macro can be controlled in Edit a test case tab for the test linked.

93 stub 33 T EBEYS =0
Manage stub items of zlib project. (114 items)

type filter text * Stub code  Configuration

putLong(struct _iobuf #, unsigned long) - 2::: 'g:%”d='_U5E' :L”j;ticnf R
putShc-r!:MSE(struct|nterna|_5tatg *, unsigne: 377/ :ﬁ]si:::*ﬂ—;a;ﬁl 411;64§éém PT oF
read_buf(struct z_stream_s * unsigned char ¢ 477/ @File: zutil.c
scan_treestruct internal_state * struct ct_dat 505
send_all_trees(struct internal_state *, signed i
send_tree(struct internal_state *, struct ct_dat
set_data_type(struct internal_state #)
syncsearch(unsigned int *, unsigned char *, 1
tr_static_init()
uncompressiunsigned char *, unsigned long
updatewindow(struct z_stream_s *, unsigned
zealloc(void #, unsigned int, unsigned int)
zcfree(void *, void #)
& (1) zcfree 1
zError(signed int)
zlibCompileFlags() v < »

W
¢ 00O OCOOOOTDOPO®O®

e @

< > ‘Ctrl + Space’ key pressed, show macro keyword [

Function type

Type Description
© Function Function without deficition
® Function Function with definition

® \/ariable Global variable

Stub type

Type Description
A User stub User-defined stub
4 Build stub Auto-created stub

23 Old version stub Stub with 2.3 or less version
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Menu

Menu

¥ Create
X Delete
(£ Import
&3 Export
=) save

! Enable

Xl Disable

Description

Creates stubs.

Deletes stubs.

Imports the stub file exported.
Exports a stub file.

Saves the change stub information.
Enables stubs.

Disables stubs.

Create stubs

e Create stubs in Stub view

1.

2. Check the functions to be created as stubs and select [OK].

Click the pull-down menu (V) in Stub view and click [Create] menu.

THEES Y20 Hu
Create...

iture: void zcfree(wd
ytureHash: 4113644488

Delete
Import...
Export...

Cenfiguration

User Function

B CEF % '

zutil.c e

Enable
Disable

I

User Manual - 3.3
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B create stub

Create Stub

Select the functions to create stubs

| Function Path

| 1 [l @ _fr_align(struct internal_state #) frees.c

2 O @ _tr_flush_block(struct internal_state *, char * unsigned lon...| [ trees.c

3 | @ _tr_init(struct internal_state #) trees.c

4 | @ _tr_stored_block(struct internal_state *, char *, unsigned lo...||Z trees.c

5 | @ _tr_tally(struct internal_state *, unsigned int, unsigned int) frees.c
;6 O @ adler32{unsigned leng, const unsigned char *, unsigned i...|[E adler32.c

7 O @ adler32_combine{unsigned long, unsigned long, signed |... |Z] adler32.c

8 O @ bi_flush{struct internal_state #) trees.c

9 | @ bi_reverse(unsigned int, signed int) trees.c

10 | @ bi_windup(struct internal_state #) frees.c

11 1 @ build_bl_tree(struct internal_state #) frees.c

12 | @ build_tree(struct internal_state *, struct tree_desc s #) frees.c

13 | @ check_header(struct gz_stream *) gzio.c

14 O @ compress{unsigned char *, unsigned leng *, const unsign...|[=] compress.c

15 O @ compress2{unsigned char *, unsigned long *, const unsig... | =] compress.c

. [ | - - " . [} (=

Select All | | Deselect All

+ Create stubs by drag-and-drop in the Test Navigator

T Test Navigator
! Oo%e
3 MasiMarc
v I 2lib
v (T Default Module
v L adler3ze
@ adler32

Histub 2

BES Y=| 6

A

2_combine

v

TIELE R

lib project. (1 items)

type filter text
v @ adler3
4 (0) a

Stub code  Configuration

Kind: User Function

Signature: ulong adler32(ulong &
3 SignatureHash: 191688526

4 File: adler32.c

S return 8;

long, const unsigned char *, | 12

< >
> ‘Ctrl + Space’ key pressed, show macro keyword i

» Create stubs by drag-and-drop in the Test Navigator

1. Select the functions to be created as stubs.

Cancel

User Manual - 3.3
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[ trees.c 52 = 8

381 */ -~
382 “wvoid _tr_init(s)

383 deflate_state *s;

384 {

385 tr_static_init();

386

387 s->1_desc.dyn_tree = s->dyn_ltree;

388 s-»1 desc.stat_desc = &static_1 desc;

389

398 s->d_desc.dyn_tree = s->dyn_dtree;

391 s-»>d_desc.stat_desc = &static_d_desc;

392

393 s->bl_desc.dyn_tree = s->bl_tree;

394 s-»bl_desc.stat_desc = &static_bl_desc;

395

396 s->bi_buf = 8;

397 s-»bi valid = @;

398 s-»last_eob_len = 8; /* encugh lockahead for inflate */
399 #ifdef DEBUG

400 s->compressed_len = @L;

481 s->bits_sent = @L;

4a82 #endif

4e3 v

< >

2. Right-click it and select [Create Stub] context menu.

trees.c 7 =3

381 *) IS

382 “wvoid _tr_init(s)

383 deflate_state *s;

384 {

385 ftr stot peindadS

386 Undo Ctrl+Z

J87 5->1 de: Revert File

388 s->1_de:

389 - Save Ctrl+S

390 s->d_de:

301 s->d_de: Open With »

392 Show In Alt+Shift+\W >

393 s->bl_d¢

394 s-»bl_dt Cut Ctrl+X

395

396 s-3bi_bt Copy Ctri+C

397 s->bi_wvi Paste Ctrl+\

398 s->last, For inflate */

399 #ifdef DEBUK Source Alt+Shift+5 >

468 s->compr .

P 5—>bit2_ Surround With Alt=Shift-Z »

482 #endif Search Text N

403 v

< + Create Stub >

(7 stub 57 Preferences... + [lﬁ‘]l BES Y= 0O

* Create and Link in Test Editor
1. In the test structure of Test Editor, select the stubs or sub nodes.
2. Select [Add New Stub...] button on the right section.

L] _tr init{struct intemnal_state . 3 =

EC.
o

Test Info (zlib/_tr_init_test0)

Test Structure Q = Test Info Edit

Test structure using a tree view and edit the information in the test. Manage the stub items added to test.

Mame In  Out Mame Description Add New Stub...

Test global code
User code Add Stub...
> Global Wariable
> Test target function
User code
v Stub
Hast
Target

Remove Stub

Test Info | Test Ca&e| Test Code| Conﬁguration|

3. Check the functions to be created as stubs and select [OK].
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B create stub d

Create Stub

Select the functions to create stubs

! | Function | Path ”~
| 1 [l @ _fr_align(struct internal_state #) frees.c
2 O @ _tr_flush_block(struct internal_state *, char * unsigned lon...| [ trees.c
3 | @ _tr_init(struct internal_state #) trees.c
4 | @ _tr_stored_block(struct internal_state *, char *, unsigned lo...||Z trees.c
5 | @ _tr_tally(struct internal_state *, unsigned int, unsigned int) frees.c
;6 O @ adler32{unsigned leng, const unsigned char *, unsigned i...|[E adler32.c
7 O @ adler32_combine{unsigned long, unsigned long, signed |... |Z] adler32.c
8 O @ bi_flush{struct internal_state #) trees.c
9 | @ bi_reverse(unsigned int, signed int) trees.c
10 | @ bi_windup(struct internal_state #) frees.c
11 1 @ build_bl_tree(struct internal_state #) frees.c
12 | @ build_tree(struct internal_state *, struct tree_desc s #) frees.c
13 | @ check_header(struct gz_stream *) gzio.c
14 O @ compress{unsigned char *, unsigned leng *, const unsign...|[=] compress.c
15 O @ compress2{unsigned char *, unsigned long *, const unsig... | =] compress.c v
. [ | - - " . [} . (=

" Select All| | Deselect All

1
cocl

Delete stubs

» Select and right-click unnecessary stubs and select [Delete] menu.
(it Stub 53 T MBS ¥ = 0
Manage stub items of zlib project. (1 items)

type filter text Stub code Cenfiguration

v & adler32(unsigned long, const unsigned char *, U syyp key: |1?ﬂ?593554463421469 |
% (3) adler32_1

Related Files: |P:#Example Projectscidipwzlib-1.2.)

& (0) ad Create

#H Delete Test:

ey Export. _tr_init{struct internal_state *)_0-Host

“ Disable adler32_combine(unsigned long, unsigned long, sigr
adler32_combine(unsigned leng, unsigned long, sigi
€ >
Description:

< 3 Save
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Edit stubs

* You can check the macro information by pressing ‘Ctrl + Space’ in the Stub Code screen. After

editing the stub code, press ‘Ctrl + S’ or [Save] button in the toolbar to save it.
S > cc
Stub code  Configuration X e
1/// @Kind: User Function
[0 "
2/// @5ignature: uleng adler32(ulong : ’ e
3/// @signatureHash: 191688526 > a cr
4/// @File: adler32.c > cr

>

onoun
-
1]
-

CS_ASSERT(_b)
C5_ASSERT_MSG(_b, _msg)
CS_INT_OUTPUTIv, _s):
CS_UINT_COUTPUT( v, _s)
CS_FLT_OUTPUT v, _s)
CS_STR_OUTPUT( v, _s)
CS_INT_INPUT(_t, _s)
CS_UINT_INPUT(_E, _s)
CS_FLT_IMPUT(_t, _s)
CS_STR_INPUT(E, _s)
CS_ADDR_FTR(_3)
_CS VIRTUAL ADDR( b, ).

>

~
®oOo® O O® O O® O®E X ® ® ® o =

oM M m M M M M M M M M -

£

‘cin .

s mn e ama e s e

* In the stub setting screen, the description can be edited.

Stub code  * Configuration

Stubkey:  [1707593554463421469 |

Related Files: | P:#Example_Projecticsdipwzlib-1.2.

Test:

_tr_init(struct internal_state *)_0-Host
adler32_combine{unsigned long, unsigned long, sigi
adler32_combine{unsigned long, unsigned long, sigi

£ >

Description:
adler32() stub|

Save

Link between stubs and tests

Each stub can be linked to the host/target test.
If you select “Stub” in the test structure editor, you can edit all the stubs included in the host and the
target.

Page 127 of 249



Suresofttech User Manual - 3.3

w Stub
w Host
& adler3z v
v Target
& adlerz? 1

If you select “Host” or “Target”, you can only edit the stubs in the selected test environment.

» Dragging and dropping into the test editor in Stub view

17 Stub 32 + [‘E‘]l = <='E(> ~ = 0 _tr_init(struct internal_state || adler32_cor
Manage stub items of zlib project. (1 items)

Test Info (zlib/adler32_combine_test0)

type filter text Stub code  Configuration The information has been changed after executl
~ @ adler32(unsigned long, const unsigned char =, | sy key: ‘1707593554463421469 | Test Structure
& (3 adler3z_1 ’ ) S
2 (0) adler32 2 Related Files ‘P.'NExample_PrDjecthwdiszlibe.2.:| Test structure using 3 tree view and edit the in
Name

Test global code
User code
Global Variable
Test target function
User code
Stub

Host

A & adibeaz

Target

& adlerz2_1

t internal_state *)_0-Host

Description:

~

Save
S e Test Info | Test Case‘Test Code | Configuration

* If linked by drag & drop, it is linked to all the targets and all the hosts.

* Link with [Add Stub...] button in Test Editor.
1. Select stubs from the test structure in Test Editor.
2. Select [Add Stub...] button on the right section.
k| compress{unsigned char * unsi.. 3 =

Test Info (zlib/compress_test0)

C.
o

Test Structure Q, = Test Info Edit

Test structurs using a tree view and edit the informaticn in the test. Manage the stub items added to test.

Mame In Out

Mams Description Add New Stub..
Test global code

User code Add Stub...
Global Variable
» Test target function Remove Stub
User code
v Stub
Host
Target

Test Info | Test Case| Test Code| Configuration|

3. Among the existing stub list, check the stubs to be linked and select [OK].
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B 2dd stub

' Add Stub
Select stubs to add the test.

If the stubs of the same function have been already existed, they are overwritten with the

[Input Filter Text

Stub name Description
8 3dier3z adler320) stub
O & adlersz_z
] 1 adler3z_3
O i adler32 4
1= Stub code
1/// @Kind: User Function
2 Signature: ulong adler32(uleng adler, const Bytef * buf, uInt len)
3 SignatureHash: 191688526
L4 File: adler32.c
5 n @;
conc

Unlink between stubs and tests

User Manual - 3.3

Select the stubs linked in the Test editor and select [Remove Stub] button or select the stubs in the test

structure tree and right-click it to unlink them.

k| *compress{unsigned char * unsi._. &3

Test Info (zlib/compress_test0)

Test Structure Q =
Test structure using 2 tree view and edit the informaticon in the test.
Mame In Out
Test global code
User code
Glebkal Wariable
> Test target function
User code
v Stub
v Host
& adlersz 4
v Target
& adlerzz 4

Test Info Edit

Manage the stub items added to fest

Mame Description

2 adler3z 4

& adlersz 4

Add Mew Stub...

Add Stub...

Remove Stub

C.
o

Test Info | Test Case| Test Code | Configuration

v Ctuh
- 3 Disconnect Stub l
& adlersZ £
v Target
& adler3z 4

Export stubs

1. Select and the stubs to be exported and right-click and select [Export...] menu.
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5% Stub 53
Manage stub items of zlib project. (1 items)

|t}-‘pe filter text |

~w @ adler32(unsigned long, const unsigned char *, L
3 (3) adler®™ 1 ~dlasian bl
& (0) adler Create
& 0) adler 3 Delete
& ) adler A Export..
) Disable

2. Specify the saving location of the stub file in the directory dialog and select [OK].

Save >

A4 Documents ]
v Export
w zlib
Stubs
UnitTests
export_stub
Tource
» ; Downloads
» J': Music
» [&=] Pictures
> [ Videos
5 . | acal Disk (C:) ¥

Falder: | Mew folder |

| Make Mew Folder I Ok | | Cancel |

Import stubs

1. Select [Import...] menu from the pull-down menu (V) in Stub view.
tH|EES Y28 Hu

+  Create...
Caonfiguration ¥ Delete
User Function g2y Import..
rture: void zcfree(vg
rtureHash: 41134445p K3 BXPOTL.
zutil.c [‘E‘] ave
¥ Enable
> Disable

2. Select the stub file to be imported and select the [Open] button.
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=

B import... X
« v A » ThisPC > Documents » export_stub w|®| | Search export_stub ¥
Organize New folder =~ m @
-
[ Desktop A " Name Date modified Type Size
& Downloads [ funcA_1_1_382453298_20200402104949_5.c  4/2/2020 10:49 A CFile 1k8
Documents [] funcB_1_1 365675679 2020402104049 5.c 4 C File 1KB
=] Pictures (7] main_1_1_3935363592_20200402104949 5.c  4/2/2020 10:49 AM  C File 1KB
CodeScroll Cont
€T3.2
D Music
B videos
@ OneDrive
[ This PC
[ Desktop
Documents
File name: ~| |*e ~

User Manual - 3.3

The old version stubs or the stubs that are the same as build stubs existed in the project

cannot be imported.

B import stub

Mot imported stub file list:

TeampleTest C 3176540677 _20200402121638.c] The function included in the stub

Save..

Use/Not use stubs

You can set whether to use the created stubs.

1.

v @ adler32(unsigned long, const unsigned char *, 1
& (3) adler32_1 - adler32() stub

& 0) adler3z 2
& 0) adler3z_3
& (0) adler3™ *

X . %

Create

Delete

Export...

Drisable

Select the stubs and right-click and select [Disable] menu.

2. The stub image decorator is added and the color of the stub name changes to gray as shown in
figure below.

Page 131 of 249



Suresofttech User Manual - 3.3

~ @ adler32{unsigned long, const unsigned char *, L
{8 (3) adler32_1 - adler32() stub
'8 (0 adler3z_2
'8 (0 adler3z_3
@b (0) adler3z 4
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15.8. Class Factory View

The Class Factory view shows the class list belonging to the project. The auto-created test code creates
an object by using the class creation function located in the Class Factory view. If you modify the object
creation code in the Class Factory view, it is applied to the object creation of all the tests that use that
factory.

¢ Class Factory 32 F] = 8
Manages the list of class factories in MasiMaro project.

type filter text Factory code:

If you don’t want to use the class factory, you can select and change the constructor to be used directly
in the test information editor.
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15.9. Control Flow Graph View

The [Control Flow Graph] view shows the control flow information for the function selected in graph

format.
If you click [Show Coverage] button in the main toolbar, the covered section is displayed in blue color
and the uncovered section is displayed in red color.

I Codescroll Controller Tester RTViRemote Target Verifier) + Targst Blugin (x64! - o e

|g-e £dit Search Project Taiget Window Helg
1, = |
% zlib =1 B x 2 B o Host @) Y IE4 [ Global Search (Ctl-3 D w |
New Project Mew Test Import Export Properties Preferences i
i & Tg | show Coverage =) Coverage —JMC/DC (% Stub (¢ Class Factory < Control Flow Graph Call Graph T3 Function Call Hietarchy ) Ermor
& b Control Flow Graph 3 pEd @ EEelas =2 8
[ i »» Default Module »> inflate.c >> inflateEnd
&
S =
] mh
Declaration Aot
* IF
= #LIF
= IF # Daclarati
b * Swtement
# block.return
& entry
* exit
B & « &
| BT

Toolbar menu

Menu Description
+ Unfold All Shows all group nodes.
=l Fold All Hide all group nodes.

| Show Legend

2 Copy to System Clipboard
5% Show Outline

2 Show Overview

& Link with Editor

& Export View Content

=) Print View Content

Shows the legend(the node type in the currently displayed graph).
Copies the currently displayed graph into clipboard.

Displays the graphs in a tree format.

Shows the overview of a graph.

Shows the selected items in the graph in the editor by one-click.
Exports the contents of view in a report.

Prints the contents of view.
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Pull-down menu

Menu Description

+ Unfold All Shows all group nodes.

=l Fold All Hides all group nodes.
Show Call Graph Shows the function call graph for the function selected in the current view.
] Show Legend Shows the legend(the node type in the currently displayed graph).

oz Show Outline Displays the graphs in a tree format.

2 Show Overview Shows the overview of a graph.
S Link with Editor Shows the selected items in the graph in the editor by one-click.
(2] Export View Content Exports the contents of view in a report.

Creates the graph model file for the graph displayed on the current screen.
Four kinds of formats supported:

* Graph Modeling Language XML (*.xgml)

Save as Graph Format * Graph Modeling Language(*.gml)

* yWorks Binary Graph Format(.ygf)
e Trivial Graph Format(*.tgf)

Save as Image Format Saves the currently displayed graph as an image format file(jpg, gif).

) Copy to System Clipboard Copies the currently displayed graph into clipboard.

Preferences Opens the preferences.

Node Pop-up menu

Menu Description

Show Call Graph Shows the function call graph for the function selected in the current view.

History function

The node that had been selected in the current graph can be seen again by using the arrow button(Go
back, Go forward) in the lower-left corner of the view.

'4m,|1?r:-

Zoom out/in function

You can change the zoom out/in ratio by entering a number at the bottom of the view or by adjusting the
slider.

() e[ = [ G

You can reset the zoom out/in ratio by using * [Initialize zoom out/in ratio] button at the lower right
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corner of the view, and change the zoom out/in ratio accordingly to the view size by using 2 [Fit to view
size] button.
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15.10. Call Graph View
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The [Call Graph] view shows the function call information for the selected function in a report format.

(Ex: When calling function ‘B’ from function ‘A’, it is expressed ‘edge from node ‘A’ to node ‘B’, and it is

represented as one edge even if called multiple times.
If you select the node (function), it shows the function call information for that node.

B Codescroll Controller Tester RTV(Remote Target Verifier) + Target Blugin (xfd) - o e

| B goit seach Eroject Taget Window Help

3 zlib = B x 2 B o Host @) Y B3 [ Global Search (Cxl-3 i m
Mew Project New Test Import Export Properties Preferences
i® Tg | show Coverage =" Coverage - MC/DC {iYStub (¢ Class Factory 43 Control Flow Graph | =% Call Graph | T3 Function Call Hierarchy  ®*) Eror
& < Cal Groph 51 & IEas =2 s
[ it = Default Module »» inflatec =» inflate
Search: [inflate Found 3 matches

I Cre3z_Nitle

4 200 = €

cre3z_big

Uncompress

Foot

® adler3?
Tuzdtables by

i ® crcbig
* crodzline
# fixediables
#* gzread
.
® inflate fast
* inflate_table

* UNCOMpress
#* updatewindow

updatswindow

a3l

inflate_table

w
>

| IEERDT i

Toolbar menu

Menu
%" Edit Layout

) Copy to System
Clipboard

o= Show Outline
Q‘ Show Overview
‘G Link with Editor

e Export View
Content

= Print View
Content

Description

Changes to make the node position of graph modifiable(it cannot be automatically

edited when the graph is updated).
Copies the currently displayed graph into clipboard.

Displays the graphs in a tree format.

Shows the overview of a graph.

Shows the selected items in the graph in the editor by one-click.

Exports the contents of view in a report.

Prints the contents of view.
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Pull-down menu

Menu Description

Show CFG Shows the control flow graph for the function selected in the current view.
o= Show Outline Displays the graphs in a tree format.

2 Show Overview Shows the overview of a graph.

S Link with Editor Shows the selected items in the graph in the editor by one-click.

Creates the graph model file for the graph displayed in the current screen.
Four kinds of formats supported:
* Graph Modeling Language XML (*.xgml)
Save as Graph Format * Graph Modeling Language(*.gml)
* yWorks Binary Graph Format(.ygf)

e Trivial Graph Format(*.tgf)
Save as Image Format Saves the currently displayed graph as an image format file(jpg, gif).

) Copy to System Clipboard Copies the currently displayed graph into clipboard.

Preferences Opens the preferences.

Node Pop-up menu

Menu Description

Show CFG Shows the control flow graph for the function node selected.

Expand Shows the call relationship after the selected function one more step.
Collapse Hides the call relationship after the selected function.

Set to Start Node Specifies the start function for checking the call path for two functions.

Specifies the end function for checking the call path for two functions.

Set to End Node Shows all paths possible in the current graph.

Search function

When you enter a search word in the top of the view, the functions with the name containing the entered
search word are highlighted.
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£l Gl oD s -
i v+ Dot Bl o 3 L+ » ka0
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= ' e
@ b
N LR

History function

The node that had been selected in the current graph can be seen again by using the arrow button(Go
back, Go forward) in the lower-left corner of the view.

= ' rl.h"‘-”'

Zoom out/in function

You can change the zoom out/in ratio by entering a number at the bottom of the view or by adjusting the

slider.

ol el = &= & @

You can reset the zoom out/in ratio by using *: [Initialize zoom out/in ratio] button at the lower right
corner of the view, and change the zoom out/in ratio accordingly to the view size by using &3 [Fit to view
size] button.

Show/Hide function

By using the menu displayed when right-clicking a node, you can show or hide the edge out from that
node. If you select [Hide], it hides the call relationship for all functions called by the function
corresponding to the selected node. The Hide menu of the node having no function call information is
disabled. If you select [Show], it shows the functions called by the function corresponding to the selected
node one more step. Likewise, if there are no call relationships, the Show menu is disabled.

Highlight Path between Nodes function

By selecting the start node and end node, it highlights all paths exited between two nodes so that you
can see easily the interesting section in the complex function call relationship.

Page 139 of 249



Suresofttech User Manual - 3.3

15.11. Error View

You can check the analysis error information of the project in detail.

Y Emor &4 = B8
Errors in the zlib project.
Type filter text | (=l Open log in editor :
L ccl.exe: warning: command line option ”
Message Log locafi... Ermor '-fpermissive' is walid for C4++/0bjC++
Eﬂlvaluel underlarad firct 1ica in | ramnrece 2 Tech but not for ©

‘e Go to error location
In file included from
P:WProduct_Workspacehct_3_1 82%\zlib\.csda
tadsrch\build\compress_2.c:7:8:

£ Show error details...

cs_test¥compress_testB8¥User code start:
In function 'compress_test®':

_test¥compress test@¥lUser code
start:1:1: error: 'wvalue' undeclared
{(first use in this function)

cs_test¥compress_test@¥lUser code
start:1:1: note: each undeclared
identifier is reported only once for each

functicn it appears in W
Log type
Type Description
Build Errors occurred during build

L&l statement analysis Errors occurred during statement analysis
= Link Errors occurred during linking

K€ Pre-processing Errors occurred during pre-processing

Error type

Type Description
Source Errors occurred int the source file
Stub Errors occurred in the stub file

Test Errors occurred in the test editor

Go to the error location

In the context menu, select [Go to error location] to go to the location where the error has occurred so as
to correct the error easily.
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Show error details

Double-click the error information or select [Show error details
information for the error.

B Error details

— [m] *
¢ Log: o Build
. Error. Test
Log location: | PaProduct_Workspacewct_3_1_02wzlibw.csdatawlogwbui |
Message: walue' undeclared (first use in this function) ir
&
" Resolution:

A compile error has been cccurred in the test code.
" |The test code is included in the file which the functicn under test has been defined(t
| To check if the types, variables or functions used in the test code can be used or not
. Please correct the compile error by checking the error message

2. If it is difficult to correct it, please contact support@suresofttech.com by attact

€

>
* Product information
© | Product version: 3.0.2.202002210735 ~
i | Product installation: C:#Program FilesCodeScroll Controller Tester 3.2
- | Teolchain: GCC 5.3 (32bit)

Java version: 1.8.0_202-b08

0% Windows 10-amde4-64 v
|

Buttons

Button Description

i Previous Shows the previous error information.
<5 Next Shows the next error information.

E= Copy Copies the error information.

‘& Go to Error Points to the location of the error.

User Manual - 3.3

...] in the context menu to check the detail
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15.12. Debug Information View

The debug information view shows information to help you determine the cause of an error in a test

case.

» Trace function calls in test cases with errors
» Actual value of variable/expression added to inspect debug information

If you select a test case that has [Inspect Debug Info] in the unit test view, debug information is
displayed in the Debug Information view.

% Debug Information &2 @ = 8
Test Case (test/func_test0) #1

Stack trace: List of variable/expressicn:

v o [Project: test] test run Variable/Expression Value Location
= i int # -
= func3(signed int *) at test.c42 p (testl .c: 40) 12319812 before line

= func2() at test1.c:30
= func(signed int) at test1.c12

» The Stack trace shows the function call trace when the test case in error was executed. The
location where the error occurred is displayed at the top.

« The variable/expression list shows the actual value of the variable/expression added to inspect the
debug information.

If the actual value of the added variable/expression is not displayed:

- When [Inspect Debug Info] of the test case is not executed after adding a new variable/
expression

- When the line where the variable/expression was added was not executed when the
test case was executed (it was not executed depending on the condition or an error
occurred before execution)

o =

Debug Information View toolbar menu

icon description

= List of variable/expression to debug
In the list of debug variable/expression, you can check and remove variable/expression.
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[=[=]=]

Remove

! List of variable/expression

List of variable/expression
This is a list of variable/expression added to inspect debug info.
Unnecessary variable/expression can be removed using [Remove], [Remaove All.
Variable/Expression Type Location
a (testl.c: func3) line:dd Integer before line
a (testl.c: func3] line:da Integer after line
b (testl.c : func?) line:27 Integer before line
p (testl.c: func3) line:d0 Integer before line

[ ok

] [ Cancel

Adding variable/expression to debug

You can add variable/expression to debug in the following ways.

1. Double-click the line area in the source code editor

User Manual - 3.3

2. Select [Add Variable/expression to debug...] from the line area context menu in the source code

editor

3. After specifying a variable or expression in the source code editor, select [Add Variable/expression

to debug...] from the context menu.

When the above operation is performed, the [Add variable/expression to debug] window appears.
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P

n Add variable/expression to debug

Add variable/expression to debug

2 You can add variable/expression only to the shaded area. (0: before line, O: after ling)

84 int test()

85 {

86 int a, b;

a7 a = func(®);
a8 b = fune(l);
2

90 if (a < b) {
91 return g(@);
92

a3

4 g(1);

95 a=a+b;
96

a7 while{a<@) {
98 a--;

99 }

100

101 return 8;
102

103

Fl

# Entering an invalid variable/expression can cause compilation errors or runtime errors.

Variable/Expression:
Type: () Integer (0) Unsigned Integer (©) Double (0) String

When you select a test case, you can inspect the debug info at once,

You can double-click on the line area to add or remove variables/expressions to debug at that location.

oK

o eE]

Cancel
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You can double-click on the line area to add or remove variable/expression to debug at that location.

marker description

— Variable/expression added before the line

w Variable/expression added after the line

You can add markers only in the shaded area.

B4 int test()

851

86 int a, b;

87 a = func(@);

88 b = func(l);

89

a0 if (a <b) {
ol return g(@);

92 }

a3

oy g(1);
a5 a=a+ bh;

a7 while(a<@) {
s 98 a--;
99 L

101 return 8;
102}
103

If you can add a variable/expression to debug both before and after the line in the shaded area, a dialog

will pop up asking where to add it.
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- Add variable/expression location to debug EI
Please select a variable/expression location to add.

befare line
[T after line

| SelectAll || DeselectAll |

| ok || canca |

You can add or remove variables/expressions anywhere you can add to the target function through the
[Add All], [Remove All] buttons at the top of the source viewer.

After specifying the variable/expression and type and clicking the [OK] button, you can see that the
marker has been added to the source code editor.

[g] testl.c &2 = B
- .
= int test() B
{
int a, b;
a = func(e);
b = func(l); =
if (a < b) {
return g(8); =
} a
gl1);
a=a+ b;

while(a<@) {
a--;
b

return @;

et
1 m_ |
oomom

If the test case is selected in [Unit Test View], you can immediately perform [Inspect Debug Info] while
adding a variable/expression to be debug.

3 Entering an invalid variable/expression can cause compilation errors or runtime errors,

Variable/Expression:  val

Type: @ Integer () Unsigned Integer () Double () String

IInspect debug info: func(signed int)_0 #5 I

[ ok [ Cancel

! If you enter an invalid variable/expression, a compilation error or a runtime error may
occur when performing [Inspect Debug Info].
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15.13. Fault Injection View
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The [Fault Injection] view provides the feature for inserting the code needed to test additionally into the

specific area of the function to be tested.

1. In [Test Navigator], drag and drop the function that you want to insert a fault into [Insert Code

view].
. CodeScroll Controller Tester RTV(Remote Target Verifier) + Target Plugin (x64)
File Edit Search Project Target Window Help

% zlib

: & Ty Show Coverage

&

g Test Navigator s Y5 | =0

3 stub_sample ~ ~
3 target
v =& zlib
v (g Default Module
v |4 adler32.c
o adler32
@ adler32_combine
» L, COMpress.c
» L cre32e
» L, deflatec
» Lg gzin.c
» L infback.c
» L inffast.c
» L inflate.c
» L, inftrees.c
» L4, minigzip.c
» Ld, trees.c
» LJ uncompr.c
» L zutilc

B¢ Fault Injection 3
Function of the specific lo
» @ adler32(unsign
» @ adler32_combine(

to insert the code.

< >

@ 1 item selected

New Project New

2. In the tree structure left to the view, click the checkbox for the node that you want to insert a fault

and enter the user code in the right edit window.
3. Click [Run Unit Test] button to run the test that the fault inserted is applied.
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=¢ Fault Injection &2

Functicn of the specific location to insert the code.

~ @ adler32(unsigned long, const unsign: »

v block : 62~67

[] Staterment : 71~71
[ Statement : 73~73
[ staterment : 74~74
[ statement : 76~76
[ return : 77~77

[ return ; 82~-82

[ block : 87~88

[] statement : 91~91
[ block_return - 92-93
[ block - 98~99

[ block : 101~102
[ block - 104~105
[ block : 111~113
[ block - 116~117
[ block : 119~120

M embiiem - 474 474

Twalue = 666;

Context menu in the Fault Injection view

= Fault Injection &3

Functicn of the specific location to insert the code.

~ @ adler32(unsigned long, const unsigne & 1
v block
O] statet F €
[ Statel Copy
[ State Paste

[] statel $¢ Delete
[ returr

[] returr Select
[ block Deselect

[ StatermeEmtgT=97T
[ block_return : 92~93

[ block : 93~99

1 block : 101~102
[ block : 104~105
[ block : 111~113
[ block : 116~-117
[ block : 119~-120

—

L T TN e I 4" A

Menu name Description

of Cut

E= Copy
ITEI Paste

* Delete
Select

Deselect

Cuts the code inserted by user.

Copies the code inserted by user.

Pastes the code inserted by user.

Deletes the code inserted by user.

Selects the checkbox for the selected node.

Deselects the checkbox for the selected node.
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15.14. Input/output Data Graph View

The Controller Tester provides the data for input value/expected value/output value in graph format.

The horizontal axis of the graph indicates the number of the test case and the vertical axis indicates the
data of the test case.

¢ Input/Output Data Graph 33 Sy T = O
_tr_align_test0
2,000,000,000 £,000,000,000 ~
1,500,000,000 1.500.000.000
1,000,000,000 1,000.000.000
500,000,000 500.000.000
0 0
-500,000,000 —500.000.000
-1,000,000,000 -1,000.000.000
-1,500,000,0004 -1.500. 000,000
-2,000,000,000 —-£,000.000,000
i 2 3 4 5 3] 7 g 9 10 11 12 13
Test Case
— s_mem[0].last_eob_len —=_mem[0].bi_valid s_mem[0]. bi_bof | -
<

Toolbar icon in Input/output Data Graph view

Toolbar icon Description
£ Refresh Refreshes the input/output data.

&5 Save graph Saves the input/output data.

Click [Save graph] to display the notification window that can enter the path for saving the graph. Enter
the path to save, the file name and the file format and click [OK] to save the graph.

/B save graph P

Path: | Ltreportwimagejpg | [search..{

oK Cancel

Graph settings

Select [Select input/output item] in the pull-down menu (V) to display the Graph settings window.

Page 148 of 249



Suresofttech User Manual - 3.3

» For the items selected in the checkbox, the [Input], [Output value] and [Expected value] are
displayed in the Input/output Data Graph. However, if the expected values are specified as ~, &, |
and ! etc., the expected value is not applied to the Input/output Data Graph view.

* [Number of test cases showed in a view] allows you to specify the number of test cases to be

displayed on one screen.

! W7 select input/output item x
1| Input Expect.. Output..
1 int s_mem[0] last_eol_len s_mem([0].last_sob_len O
| unsigned short s_mem[C].bi_... i .5 mem[0].bi_buf 0
[ int s_mem[0].bi_valid s_memn[0].bi_valid O
[
]
. Number of test cases showed in a view:
Confirm Cancel
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15.15. Console View

Enter the instruction or batch file in [Pre-command for test run] and [Post-command for test run] of

[Project] -> [Properties] -> [Test] -> [External Command] and execute the unit test to display the
execution result for the external instructions before and after the test execution in the [Console] view.

Toolbar icon in the [Console] view

Toolbar icon Description
=# Clear Console Clears the console contents.
B Scroll Lock Locks the scrolling of the [Console] view screen.

=] Display Selected Console Shows the selected console.

If [Display Selected Console] is selected, the following two menus are displayed: [Pre-command for test
run] and [Post-command for test run].

B~-=0

® 1 Pre-command for test run

2 Post-command for test run
&

3 Target Log Collector command

4 Target test command

If you select [Pre-command for test run], the execution result for the external command before running
the test is displayed in the Console view.

El Consale &2

Pre-command for test run

P:\Eclipse\eclipse-rcp-2819-89-R-win32-x86_64\eclipse>cd P:\Example_Projecth\c\dipizlib-1

BIEY| B~ = B

'ﬂ_ll'

P:\Example Projecti\chdipizlib-1.2.3>make clean all
rm -f *.0 *~ example minigzip \
libz.* foo.gz so_locations \
_match.s maketree contrib/infbacka/*.c
cc -0 -c -o example.o example.c
make: cc: Command not found
make: *** [<builtin»: example.o] Error 127

If you select [Post-command for test run], the execution result for the external instructions after the test
execution is displayed in the Console view.
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El Consale &3

Post-command for test run

L'i"'
&l
o
I
1

P:\Eclipse\eclipse-rcp-2819-89-R-win32-x86_64\eclipsermake clean all
make: *** No rule to make target 'clean'. Stop.

P:\Eclipse\eclipse-rcp-2819-89-R-win32-x86_64\eclipsercd P:\Example Project\ch\dip\zlib-1

P:\Example Projectic\dipi\zlib-1.2.3:make clean all
rm -f *.o0 *~ example minigzip \
libz.* foo.gz so_locations
_match.s maketree contrib/infbackd/*.o
cc -0  -c -o example.o example.c
| make: cc: Command not found
make: *** [<builtin>: example.o] Error 127
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The Analysis Perspective provides a Ul for analysis information that can be confirmed from the test

results.

The components that make up the analysis perspective are:

Metrics View

Metrics Chart View

Metrics Top Chart View
Metrics Bar Chart View
Metrics Diagnosis Chart View

Unused Function View

Source-Header Relation View

Global Variable Relation View

Function Call Hierarchy View

Source Code Editor section

Views that are not included by default can be opened from [Window]> [Show View]> [Other...] on the top

menu.
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16.1. Metrics View

The Metrics view shows the result that measures the metric for the project. It shows the summary

information for the overall metric and the metric information for each items included in the project
(module, file, class, function).

i Metrics 32 Bvledm =0
Metrics of ‘zlib_merged’ project

~ Project Summary

Total Files 40(13/27)
analyzed Files 23 (1310)
Number of Functions 113
Line of Code 7018
Comments Ratic 52 %
~ File Metric
Metric: plLOC ~|[0 | ~ [ 100000 H |3+ | @
| File name pLOC Loc FICRO b
S0 V| el ko S G A 1 11 B b B S S B . TS s el S
1358 limes 192 lines 569 %
333 lines 252 lines 27 % v
23 of 23 rows ||==| | == E 1 of 1 page > == | |==| Goto |1 S page

Icons

Icon Description
) Module (a logical portion that divides the project for each function)
File (Source file and header file belonging to the project)
® Class

@  Function

Toolbar menu

Menu Description
Show Diagnosis Displays a diagnostic image of the value in the left of the metric value.
i Change Mode Changes the view mode (---:----I module, = file, (C] class, @ function).

(T Export View Content Exports the contents of view as a report.

=) Print View Content Prints the contents of view.

Pull-down menu

Menu Description
Sorts based on the selected item (even if clicking the column name in the table, it is
Sort by
sorted equally).
Changes the order and width of the columns (allows you to change the order by dragging
Columns . ,
and dropping the table’s column name).
Configure Opens the diagnostics preferences page (allows you to set the diagnostic step and the
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diagnosis ranges or images for each metric).
Set to H|de_/ Sets whether to hide or show the metrics.
Show metric
Met.nc View Sets the number of lines per page in the Metric view.
Option

Filtering

[zl Metrics 53
Metrics of 'zlib_merged” project
» Project Summary

~ Function Metric

Metric: |FUNST «~ |20 =~ [ 100000 = |3 | | @ | Filter matched 42 of 114 items

Function name FUNST FUCYC
@ gz_open 3 61 - 17
@ destroy 4 23 W 13
@ gzread L 68 < 20
® check_header oy 39 & 16
@ gzwrite 4 20 o6
@ grseck La 34 < 23
@ do_flush 1y 22 o 8
® main iy 35 - 14
<

42 of 42 rows [|==| == < 1 of 1 page = B == Goto |1 > | page

User Manual - 3.3

The filtering allows you to view only those items within the desired range for the specific metric.

Select a metric, enter the range value and click [Filtering] button in the right section to see those values

corresponding to the entered information.

If you want to return to the status before filtering, click [Initialize the Filtering Criteria] button on the right

side of [Filtering] button.

Paging

[zmi Metrics 23
Metrics of ‘zlib_merged’ project
» Project Summary

~ Function Metric

Metric: | FUNST ~ |0 = ~ [ 100000 H (3] €

Function name FUNST FUCYC
@ bi_windup 0 o 3

@ adler32 i3 101 & 13
® adler32_combine s @5

@ compress2 0 19 & 4

@ compressBound &l &

@ compress el @1

@ uncompress i 22 o &

@ gzdopen i3 4 ¢ 2

P 7R -

<

100 of 114 rows < | | << | | = 1 of 2 page > || == ||=»] | Goto |1 | page | s

The Paging allows you to view many items conveniently.
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16.2. Metrics Chart View

The Metrics Chart shows the metric view in a line chart. The x-axis is each item, and the y-axis is the
metric value of the item. You can compare the distribution of values between different metrics each other

in the project.
E Metrics Bar Chart &) Metrics Top Chart [ Metrics Chart §2 [/ Metric Diagnosis C.. = 8

Metrics of 'zlib_merged' project

Function - FUCYC

1000

100 |

Yalue

Rank
Toolbar menu
Menu Description
=3 Show Log Scale Changes the y-axis of chart to log units.

[72) Change Mode Changes the view mode ('---:---J module, = file, C class, @ function).

Pull-down menu

Menu Description

Sorts based on the selected item (even if clicking the column name in the table, it is

Sort by sorted equally).

Set to Hide/Show

\ Sets whether to hide or show the metrics.
metric
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Metrics View

\ Sets the connection function with Metric view.
Options

Select Metric

If you select the checkbox left to the metric name in the right table, the checked metrics are displayed in
the chart. If you click the metric name in the checked metric, the items are sorted based on that metric
value.
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16.3. Metrics Top Chart View
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The Metrics Top Chart view shows the top items of the metric value in a pie chart. You can see the ratio

of the top items in the total.

B Metrics Bar Chart | §) Metrics Top Chart 52 | % Metrics Chart ||| Metric Diagnosis C...

Metrics of 'zlib_merged’ project

Function Metrics

Top 10 Highest 'FUNST' Values

Function name

Bother

l inflate

WinflateBack

P deilate

l inflate_fast
inflate_table

[P adlersz

B:end_tree

Bozread

B deilate slow

B compress_block

Menu Description

i Change Mode Changes the view mode (ﬁ’ module, = file, © class, @ function).

Pull-down menu

Menu

Metrics Hide/Show
Setting

Metrics View Options

The selection of the pie chart and the selected item in the table are connected together.

Description

Sets whether to hide or show the metrics.

Sets the number of top items to be displayed and sets whether to show the sum of

the resting items.
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16.4. Metrics Bar Chart View

The Metrics Bar Chart view shows the metric values in a bar chart. You can check the value size for

each item in the bar chart.

BL Metrics Bar Chart % | ) Metrics Top Chart [ Metrics Chart Metric Diagnosis .. = B
LTI
Metrics of 'zlib_merged' project
Function Metrics Metric: | FUCYC
Function name FUCYC =3
@ inflate 270.0¢
@ inflateBack 178.00
@ deflate 28.00
@ inflate table 38.00
@ inflate fast 32.00
@ gzseek 23.00
@ zlibCompileFlags 21.00
@ deflate_slow 20.00
@ gzread 20.00
@ send_tree 19.00
@ gz_open 17.00
@ check_header 16.00
@ deflate_fast 15.00
@ gen_bitlen 14.00
@ main 14.00
@ adlerz 12.00
P P 12 An M
< >
Icons

Icon Description

0 Module (a logical portion that divides the project for each function)

File (Source file and header file belonging to the project)

® Class

@  Function

Toolbar menu

Icon Description

[72) Change Mode Changes the view mode (--:---' module, = file, (C class, @ function).

Pull-down menu

Icon Description
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Metrics Hide/Show Setting Sets whether to hide or show the metrics.

Metric View Options Sets the number of items to be displayed.
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16.5. Metrics Diagnosis Chart View

The Metric Diagnosis Chart view shows the number of items included in the diagnostic range in a pie
chart. You can check the number of items within each diagnostic range in the project.

B Metrics Bar Chart &) Metrics Top Chart [ Metrics Chart | ['] Metric Diagnosis C.. 32| = B

B~ -
Metrics of 'zlib_merged' project

Function Diagnosis Metric: | FUCYC  w

Distribution of Diagnosis Diagnosis Table
Message Range - Image Count
B simpletwithout . [0.00, 10.00) 4 92
. More complex(m... [10.00, 20.00) . 13
.Cumplex(high risk) [20.00, 5000) <=2 B
Greatly complex(..  [50.00, max) =2 3

Bl rione value

Toolbar menu

Menu Description

[72) Change Mode Changes the view mode ('-'i’t] module, = file, C class, @ function).

Pull-down menu

Menu Description
Configure Opens the diagnostics preferences page (allows you to set the diagnostic step and the
Diagnosis ranges or images for each metric).

Metrics Hide/

Sets whether to hide or show the metrics.
Show

Metric View

Options Sets whether to display the items having no diagnostic value.

The selection of the pie chart and the selected item in the table are connected together.
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The Unused Function view shows the functions included in the selected project by classifying them

according to the specified criteria. It shows the currently unused functions and the criteria for classifying

can be added.

<) Unused Function 23

Total 42 functions - in "zlib' project

Bl ¥ = 0O

Mame

v £ Unused (42 items)

]

[ R R IR IR R I R I I R

Menu

_tr_tally

adler32_combine

CoOMmpress
crc32_combine
deflateBound
deflateCopy
deflatePrime

deflateSetDictionary

deflateSetHeader

deflateTune
deflate fast
deflate_slow
deflate_stored
get_crc_table
gzclearerr
gzdirect
gzeof

nrflich

Description

Module

Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module
Default Module

Default Module
MNafanlt Modola

File

freec.c
adler32.c
COMPress.c
cre32.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
deflate.c
cre32.c
gzio.c
gzio.c
gzio.c

a7in -

e Copy to System clipboard Copy unused function view image to system clipboard.

Save as PNG

Icons

Icon Description

Save unused function view as image.

£ Classification criteria

& Function group

@  Function

Pull-down menu

Menu

Description

Function View Options Sets the number of functions to be displayed for each group.
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16.7. Source-Header Relation View

User Manual - 3.3

Source-Header Relation view shows <include> and #include relations between the source file and

the header file

“= Source-Header Relation 3
13 files included by 'zutil.c’ - in 'zlib' project

{} | |elg| = O

v [ zutil.c
[# _mingw.h
[ msvertver h
[# stddefh
[# string.h
[ w32apih
[# strings.h
[n) zlib.h
[B sdkddlverh
[B] zeonfh
[ wcharh
[# errnah
[B) zutilh
[# stdlib.h

Icons

Icon Description
lg  Source file
[ Header file

& System header file

Toolbar menu

Menu
{} Show System Header
&' Show Includers

*is Show Files Included

Description
Shows the system header.
Shows the files that includes the selected file.

Shows the file included in the selected file.

Show Includers, Show Files Included
You can display the files that includes the selected file or the files that the selected file is included by

using the menu displayed when right-clicking a file in the view.

‘= Source-Header Relation 32
13 files included by 'zutil.c' - in 'zlib’ project

{3 e olg| = O

v [g zutile

% I:;T\:ﬂ Show Includers

[B stddef Show Files Included

[ w32apih
[# strings.h

&) Zlih

[B sdkddleverh
[R zconfh

[ wcharh

[# ermo.h

[n) zutilh

[B stdlib.h

& stringh Show Includers
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16.8. Global Variable Relation View

The Global Variable Relation view shows the function where the global variable is defined and used. If a

function is selected, it shows the global variables defined or used in the function, and if a global variable
is selected, it shows the functions where the global variable is defined or used.

e Global Variable Relation 52 B = g
‘compress_block' - & relations in project ‘zlib'
Name Definition Use

~ @ compress_block
@ _dist_code
® _length_code
@ base dist
@ base length
@ extra_dbits
® extra_lbits

LLCCL g

Menu Description

=) Copy to System clipboard Copy global variable relation view image to system clipboard.

Save as PNG Save global variable relation view as image.

Icons

Icon Description
@  Function

&  Global Variable

Show Relation

You can view the relation for the selected items again by using the menu displayed when right-clicking
the related item in the view.

E: Global Variable Relation &3 :E B=8
‘compress_block' - 6 relations in project 'zlib'
Marme Definition Use

w © compress_block
® _dist_code
@® _length_-od-
@ base_dis Show Relation
@ base_length
@ extra_dbits
@ extra_lbits

Show Relation

LLLCLLCK
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16.9. Function Call Hierarchy View

The [Function Call Hierarchy] view shows the information for the function called by the selected function
or the called function in the hierarchy structure.

You can change the call information for the selected function by using the context menu that appears
when selecting and right-clicking the function displayed in the hierarchy structure and double-click it to
open the editor for the source file that the function is defined and to go to the location of the selected
function. (However, not included if it is a system function)

e Function Call Hierarchy 32 = | e oS [ = O
Calls from 'read_buf' - in 'zlib'
w @ read_bufistruct z_stream_s * unsigned char * unsigned int)
@ adler32{unsigned leng, const unsigned char *, unsigned int)
w @ crc32{unsigned long, const unsigned char *, unsigned int)
@ crc32_biglunsigned long, const unsigned char *, unsigned int)
@ cre32_little(unsigned long, const unsigned char *, unsigned int)
+H memcpy(void * const void *, size_t)

o Function Call Hierarchy &3 += | e ofi2 [ = O
Calls from 'read_buf' - in 'zlib’
w @ read_bufistruct z_stream_s * unsigned char *, unsigned int)

@ adler32(unsigned long, const unsigned char *, unsigned int)

S e i 2he  Show Caller Hierarchy rd L

@ cre32_bigi i unsigned int)
o cre32 littler e  Show Callee Hierarchy + unsigned int)

+ memcpyivoid *, const void #, size_t)
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Menu Description

++ Show System Sets whether to indicate the call information for the system function in a
Function hierarchical structure.

3}..0 Show Caller Shows the functions that call the selected functions in a hierarchical structure.
Hierarchy

’Hﬁi:;ahrz\r/]vyCallee Shows the functions called by the selected function in a hierarchical structure.

) Copy to System

clipboard Copy function call hierarchy view image to system clipboard.

Save as PNG Save function call hierarchy layer view as image.
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16.10. Source Code Editor section

The source code editor section is a pre-reserved area, located on the left of the screen.

I CodeScrol Contreller Taster ATV(Remate Target Verifier) « Targat Plugin (064) R = T s
Elle Edit Segrch Project Jarget Window Help
B3 2iib 1= B » A B & Host @) X&8 WHE: A
New Project Mew Test Import Export Sroperties Preferences
[ = Show Coverage ) Coverage —JMC/DC {3% Stub | Class Factory < Control Flow Graph <% Call Graph T3 Funetion Call Hierarchy ™) Evor
[ adlerd2 e I2 -] Unit Test tegrat EEE~T=n
“hl while (@) ~ v Statement Coverage
& define MOO(a) & %= BASE : . s
& define MOD4(n) o e BASE (18/0/6) 24 2.9%
sendif 118/3995)
- Result Coverage o
uLong adler; .
const Bytef *buf; 3 Signalad
uInt len; 4 signaled
{
unsigned long sum2; ¢
unzigned nj 7
* split Adler-32 into component sums * 8
sum2 « (adler 33 18) & @uFFFF; 9 signaled
adler 8= BxFFFF; 18 Signaled
* in case uszer likes doing = byte at a time, keep it fast */ ;
if (len == 1) { 3
adler += buf[e]; = 14
if (adler »= BASE 1170/ 0 100.0%

v
sum? += adler; < >
if (sum? e BASE

¥ adler32(unsigned long, const u =B
reti < 3
¥ R — Test info (zlibyadler32_testo) e
* a initial Adler-32 value (deferr for len == 1 speed) =/
- :b:f\ st ! “:L:) 2 value (deferred check for le peed) Test Structure C, @ @ TestinfoEdit
h Test structure using 2 tree view and edit the infarmation in the test Change the natation edit the partition =
* in case short lengths are provided, keep it somewhat Tast =/ Harme n Out *|  _got Numersl System
if (len < 18) | ~  Parameter/retum . ! @}l
while (len--} { (® 10 Mumeral System (O 16 Numeral System
adler += *bufe+; w~ o adler - ulong il
sumz += adler; @ adler : unsigned long Variable Partition
v o buf : const Bytef *
if (adler = B2SE) ~ o 0 : Byt [min = [Max Add
adler -- BASE; v
MO04(5um2) ; /* only added so many BASE's 2 [fj [-‘Jme.mqgm-d g [singhe value Add
return adler | (sus2 << 16); v o len : unt Partition List
o len - unsigredint o o | [ oelete
* do length Naax blocks requires just one modulo operation */ v o retumVar - ulong e
Idilli.:‘hﬂ >= W) { o' retumivar © unsigned I %! 215 Default
n - WX /265 /% wwx is divisible by 16 =/ Before call code g
ey 0 i Adter call code - *47-5551" v
? S e g Test Infe | Test Case| Test Code | Configuration
f TR
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In File menu, Create a new project or module, Editor-related operation, Refresh, Change Workspace,

Import and Export, View Properties of the selected item and Exit Tool etc. can be carried out.

File Edit Search Project Target Window
MNew >
Close Crl+Ww
Close All Ctrl+Shift+w
Save Ctrl+5
Save All Cirl+Shift+5
Rename... F2
Refresh Fs
Switch Workspace...

fay Import..

iy Export .

Froperties Alt+Enter
Exit
New:

o Create a project

o Create a module

Close/Close all/Save/Save all: Editor-related menu
Rename: You can modify the name of project or module.
Switch workspace

Export

Import
Exit: Exit tool.
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17.1. Create a Module

You can create a new module in the project. The information other than the module name is created the

same as the modules already existed in the target project.
B rew Module O >

Module

Create a new module.

Select the project:
1% stub_sample
=% zlib

Module name: ||

Einish Cancel

In [New] menu, click [Other...], select [Module] in [Other] and click [Next].
Select the project that you want to create a new module.
Enter the module name. The module name existed already cannot be used.

oD~

Click [Finish] to create the module.

* You can also create a module by using the [New] menu displayed when right-clicking a
project in Test Navigator view.
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17.2. Switch Workspace

You can switch the directory of workspace. When you witch the workspace, the tool restarts with the
switched workspace.
B switch Workspace *

Pick Workspace

Your workspace is where settings and varicus important files will be stored.

Workspace: F-#Product_Workspace w Browse...

- [] Use this as the default and do not ask again

Clone Cancel

Click [Browse...] to select the workspace directory to be switched or to enter it manually. You can select
the workspace directory selected previously in the list displayed when clicking [V].

If you select the checkbox [Use this as the default and do not ask again], you are not prompted again to
select a workspace directory the next time you execute the tool.

If you click [Clone], the selected workspace is copied to the other directory.
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17.3. Export
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Export a Project

The project can be exported including the project settings and the test.
The exported project can be imported with [Import Project].

* The exported project can be imported from CLI environment using projectlE.exe. Please

1.

refer to the projectlE document for details.

Click [File] -> [Export] menu.

, File | Edit Search Project Target Window

B E

Mew

Save All

Rename...
Refresh

Switch Workspace...

Impart...
Export...
Properties

Exit

Ctrl+w
Ctrl+Shift+W

Ctrl+5
Ctri+Shift+5

F2
F5

Alt+Enter

»

2. Click [General] -> [Export Project].
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. Export

Select
Export the project, including project settings and tests.

Select an export wizard:

|t}-‘pe filter text

» [= Coverage
w [= General
1= Export Project
» = Metrics
s [ Preferences
y [= Test

< Back Mext = Finish

3. Select the project to be exported and the export path and click [Finish].

Cancel

B export Project | *
Export Project
Export the project, including project settings and tests.
Project:
=2zlib Select All
Deselect All
1 of 1 selected.

Mext = Finish

Cancel

User Manual - 3.3
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Create a test result report
You can create the test result report in various formats by using Export.

1. Click [File] -> [Export] menu.
, File | Edit Search Project Target Window

MNew »
Close Ctrl+W
Close All Ctrl+Shift+w
Save Ctrl+S
Save All Ctrl+5Shift+5
Rename... F2
Refresh F5

Switch Werkspace...

Import...
Export...
Properties Alt+Enter

By &

Exit

2. Click [Test] -> [Create Test Report].
B eport a *

Select %
Generate test report. H

Select an export wizard:
|t}-‘pe filter text |

» [= Coverage

» [= General

5 [= Metrics

v [= Preferences

W [= Test
|=| Create Test Report
if) Export test

< Back Mext = Einish

User Manual - 3.3

3. Select the project that you want to create the report, and as an option, select Create Report for

each Test, Create Report for uncovered function, and Create Report containing the external
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coverage, and then select the report creation path and the report extension.

B export O X B export O hs
Export Test Result Export Test Result
Select Project and Opticn Select file type to be exported
Project [ use default location
zlio Select Al Location: |Z:Wreport Browse.
Deselect All
File Extension
[JHTML (html)
[IMs Excel (xdsx)
[ MS PowerPaint (pptx)
[Ims word (docx)
LAPDF (pdf}
1 of 1 selected
. Select All Deselect all
Option
[[]Generate reports for each test. (format: XLS)
[ Generate reports for uncovered function. (fermat: XLS)
[[]Generate reports including external coverage.
< Back [ Mext > Finish Cancel < Back Next = Cancel

a.
b.

In [Project], select the project that you want to create a report.
In [Option] group, select the desired checkbox among [Generate reports for each test],
[Generate reports for uncovered function], and [Generate reports including external
coveragel.
+ Generate reports for each test: Generates the report for each test in the selected
project.
* Generate reports for uncovered function: Generates the report for the uncovered
function in the selected project.
* Generate reports including external coverage: Generates the report containing the
external coverage in the selected project.
Selecting the checkbox [Use default location] specified “User Account\Export” directory by
default.
[File Extension] provides the report file format with html, pdf, docx, pptx and xIsx (3 if you
need to create the report with the extension of doc, ppt and xls, please contact the support
team). The report file extension can be selected in duplicate.

4. Click [Open Folder] button in the message “Report has been created” to check the report in the

folder where it is saved, or click [Confirm] to finish the export.
n Export Success >

P 1 Success Result files location: Z-#reportwstub_sample

: Open Folder Confirm

Export Test

The test information created in the project can be exported at once. Before a project is not analyzed or if
there is no test information (Unit/Integration Test, Stub) created, the export cannot be carried out.

1. Click [File] -> [Export].

Page 173 of 249



Suresofttech User Manual - 3.3

, File | Edit Search Project Target Window

Mew »
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F2
Refresh F5

Switch Workspace...

Import...
Export...
Properties Alt+Enter

Bs &

Exit

2. Click [Test] -> [Export Test].
B eqort ] X

Select F
Export test information H

Select an export wizard:
|t}-‘pe filter text |

5 [= Coverage

» [= General

» [= Metrics

» [= Preferences

v [ Test
1=/ Create Test Report
t.) Export test

3. Select the export path, the unit test items, the integration test items, the stub items, and the
options, and click [Finish].
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Export tests O x
P

Export tests

Export project's test infermaticns.

Export path: | Z:wexported_test Search...

Unit Test
Test
Test Data

Integration Test
Test
Test Data

Stub
(® Connected Stub
(O All Stub

Cption
(] Overwrite existing test files without warning
[ Export only checked tests in Unit/Integration Test View.

a. In [Export path], enter the path to export the test.
b. In [Unit Test] group, check whether to export [Test] and [Test Data] respectively.
In [Integration Test] group, check whether to export [Test].

* When exporting the integration test, it is exported with the test data in a set.

d. [Stub] group, select the stub to be exported among [Connected stubs] and [All stubs].

» Connected stubs: The stubs connected with the test to be exported. If the stubs have
no link with the test or the test to be exported is not selected, it does not export that
stubs.

« All Stub: It exports all the stubs created in the project.

e. In [Option] group, choose whether to overwrite the existing test file when they exist, and
whether to export only the tests checked in the Unit/Integration Test view.
4. Click [Open Folder] button in the message “Test has been exported successfully.” to check the test
exported in the folder where it is saved, or click [Confirm] to finish the export.
B export tests X

- \

The test has been exported successfully.
W' Open the path exported?

: Open Folder Confirm

* From 2.6.14 or later version, when exporting tests, [testinfo.export] file is created in the
project directory exported.
(testinfo.export: the file that records the exported information)
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Export Coverage

You can export the coverage information measured in the project as a file in the form of Coverage
Shared Data (*.csd) format.

1. Click [File] -> [Export].
, File | Edit Search Project Target Window

Mew ¥
Close Ctrl+W
Close All Ctrl+Shift+w
Save Ctrl+5
Save All Ctri+5hift+5
Rename... F2
Refresh F5

Switch Workspace...

Import....
Export...
Properties Alt=Enter

9]

Exit

2. Select [Coverage] -> [Export Coverage] and click [Next].
B eqort O >

Select /"

Export the project's coverage information as a Coverage Shared Data File H
Format(*.csd).

Select an export wizard:
|t}-‘pe filter teut |

w [= Coverage
=m Export Coverage
= General
= Metrics
= Preferences

>
>
>
» [= Test

< Back Mext - Finish

3. Select the project that you want to export coverage information and click [Next].
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B export Coverage O X

Export Coverage

Export project coverage

Select All
Deselect All
|
1 of 1 selected.
| <Back || mNea> |[ Ensh || cancel
4. Enter the directory path to export and click [Finish].
B eqort Coverage O >
Export Coverage
Select a directory to export the file for sharing coverage
information(*.csd).
Directory path: |Z:Wexport | |§r0wse|

Net> [ mnsh ][ cancel |

5. A file with the same name as the project name is created.

¥ || zwexportw

Size Modified
4 606 2020-03-31 16:29

User Manual - 3.3
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Metric

It exports the metric result of the project in a report file.

1. Click [Metric] -> [Metric] and then click the [Next] button.

Select /“

Export project's metric information to report. H

Select an export wizard:

| type filter text |

[» = Coverage

[+ [ General

4 [~ Metrics
| Metrics |

[+ [ Preferences

[» [= Test

<Back || Ned> || Fnsh || Cancel

2. Select the project and metric type to export metric information.
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B sport

Export Metrics
Export project's metric informations to report file.

Available Projects: _
= zlib Select Al |
Deselect All
i
1 of 1 selected. :
Metric Type
Class '
File |
' Maodule
]
| <Back | Net> [ Ensh || Cancel

3. Click the [Next] button.
4. Select the path and report format to export the report.
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B sport m| X

Export Report

Choose export destination and extension.

Use default location
Location: | ChUserswxwExport Browse...

File Extension

HTML (.html)

[IMS Excel (xdsx)

[IMS PowerPaint ( pptx)

[IMs weord (.docx) i
] PDF (.pdf)

| Select Al || Deselect Al

Mext = | Finish | | Cancel

5. Click the [Finish] button.

Toolchain
You can export the information of the toolchain created.

1. In the main menu, click [File] -> [Export]. The Export wizard is opened.
, File | Edit Search Project Target Window

Mew »
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+5S
Save All Ctrl+Shift+5
Rename... F2
Refresh F5

Switch Workspace...

Import...
Export...
Properties Alt+Enter

Bs B

Exit

User Manual - 3.3
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2. Click [Preferences] -> [ToolChain] and click [Next].
3. The list of toolchains registered currently is displayed.

4. Check the system header and the toolchain to be imported and enter the export path.
B Tcolchain Export O *

Toolchain Export

Select the toclchain and destination location.

Available Toolchain List:

Defa..  Teclchain N;me Description Exporting system header directory Exporting system header |
| CPP_TI_TMS320_6000_... CwWorkspace_CCStudicwSoC_Build_... :
O GCC 4.7 (32bit) cgooid. 7 2% 32bit

O GCC 5.3 (32bit) CHgCCHS.3.032bit

O Microsoft Visual Studio... C:wProgram Files (x86)

1 Microsoft Visual Studio... C:wProgram Files (x86)

O Microsoft Visual Studio... C:wProgram Files (x86)

O Microsoft Visual Studio... C:wProgram Files (x86)

O iar Mo configured value

Select All | | Deselect All
_ Exporting system header size: 0 / 500 (MB)

Selected the export location: | Browse...

< Back Mext = Finish Cancel

5. Click [Finish].
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17.4. Import

By using Import the existing project to workspace function, you can import the project not existed in the
workspace into the workspace.

Import Test

1. Click [File] -> [Import].
, File | Edit Search Project Target Window

Mew >
Close Ctrl+w L
Close All Ctrl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F2
Refresh F5
Switch Workspace...

i Import..

iy Export..
Froperties Alt+Enter
Exit

2. Select [Test] -> [Import Test] and click [Next].
. Import O *

Select

Import test information. Iﬁ

Select an import wizard:
type filter text

» [= Coverage
w [= General
% Existing Projects into Workspace
[, File System
> [= Preferences
v = Test
Import test
EE[ Import test using test code file

< Back Next = Finish Cancel
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3. Enter the information for the test to be imported and click [Finish].

4.

5.

B import tests O

Import tests

Import project's test infermations.

>

Import path: | Z#exported_testwzlib

Unit Test
Test
Test Data

Integration Test
Test

Test Data

Stub
(O Connected Stub
® All Stub

Cption

(] Overwrite existing test files without warning

(O If the same stub exists already, it is not imported.
(® If the same stub exists, it is added as a new stub.

= Back Mext = Cancel

User Manual - 3.3

If there are items that the name has been changed or the file has been deleted when importing the
test information, the notification windows is displayed, allowing you to select whether to import the
information except for that items. This notification window is displayed only if the information was
exported from 2.6.14 or later version at a time. If the information is exported from the other menu

and previous version, the notification is not displayed.
n Import

Filz is deleted, or renamed files exist..
with the exception of this file, Do you want to run the import?

O

X

iZMewported testilzlibWUnitTestseyncsearch testQ utest!
Zitexported_testwzlibsUnitTeststtupdatewindow_testD.utest
Z#exported_testwzlibWUnitTestsWset_data_type testO.utest
Zitexported_testwzlibsUnitTestsstr_static_init_test0.utest
Ztexported_testwzlibwWUnitTestsWuncompress_testD.utest
Iyexported_testwzlib¥UnitTestswzError_testl.utest
Ztexported_testwzlibWUnitTestswzlibCompileFlags_testO.utest
Zyexported_testwzlib¥UnitTestswzofree_testO utest
Z#texported_testwzlibWUnitTestsWzealloc_test0.utest
T#texported_testwzlibwUnitTestswzlib\Version_testO.utest

|

Cancel

If the same test exists in the project, select whether to overwrite the test. Select [Yes] to overwrite

and select [No] to cancel the import.
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. mport tests O *

Import tests

Import project's test informations.

Irmport path: | Z-wexported_testivzlib Search...

Unit Test
Test

B import X

There is a test with the same name as adler32_combine_test0.utest. Do you wish
to overwrite?

I Yes || Yes To All || No || No To All H Cancel

@TAIl'Stub

Option
Overwrite existing test files without waming
If the same stub exists already, it is not imported.
If the same stub exists, it is added as a new stub.

(1/114) UnitTest: adler32_combine _test0 utest
1

< Back Next = Finish Cancel

6. After the import has completed, it is applied to the selected project.

«¥s The status icon(?) ‘the test that cannot find the function to be tested in the source file to
be tested’ is displayed, the associated file can be set by using the [Set related file]
context menu.

‘ Add Test Case -
Generate test cases automatically b
Host Output Value -> Expected Value
Target Output Value -> Expected Value

Initialize Test Case

Copy Ctrl+C
Paste Ctrl+v
Duplicate Ctrl+D
Duplicate multiple times...

#  Delete Delete
Rename... F2

| setrelatediile |
Relevant issues settings...

Import Test Data >
Export Test Data
Large test data >

E [

Generate binary for debugging
% Add Stub..

P

Select Test
Deselect Test

=m  Generate coverage report..

Import information exported from 2.6.14 or earlier

1. Enter the path to import the test in [Import path].
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«~ v » ThisPC » Documents > Export v @) | Search Export

& Downloads Name Date modified Type
< Documents

= Pictures

CodeScroll Conti
T2

& Music

B Videos

& OneDrive
— S « Documents > Export » zlib v | Search zlib ]

~ = ThisPC
A Name
m Desktop 3 Quick access

Stubs
UnitTests

> % Documents

& Downloads

i testinfo.export 4/1/2020 2:18 PM
B Music % Documents
= Pictures v

item

= Pictures

1
CodeScroll Conty

CT3.2

d Music
B Videos
@ OneDrive
mer_'s ) L;
+ If [testinfo.export] file exists in the test path to be imported, select the directory containing

the file.
If you import the information exported separately from 2.6.14 or less version, select the
higher-level directory containing the information exported.
2. In [Unit Test] group, check whether to import [Test] and [Test data] respectively.
3. In [Integration Test] group, check whether to import [Test].
» The test and data must always be in the same directory, and if it is not, the data is not
imported.
4. In [Stub] group, select the stub to be imported among [Connected Stubs] and [All stubs].
» For the stubs created in 2.3 version, or the stubs migrated to 2.6, if the same stubs exist in
the project, the import cannot be carried out.
* For the stubs created in 2.6 version, if the same stubs exist, you can select either not to
import them optionally or to create as a new stub additionally.
* There is no feature to link the stubs to the test in 2.3 version, so you need to link
directly to the test when migrating to version 2.6 or later.
5. In [Option] group, select whether to overwrite the existing test files if they exist and how to handle
them when the same stub exists.

Import Test from Test Code file

1. Click [File] -> [Import].
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, File | Edit Search Project Target Window

New >
Close Ctrl+w
Close All Cirl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F2
Refresh F5
Switch Workspace...

s Import..

&y Export..
Froperties Alt+Enter
Exit

2. Select [Test] -> [Import test using test code file] and click [Next].

. Import

Select

Create tests from test code files.

O x

4

Select an import wizard:

|t_\,-'pe filter text

» [= Coverage
w [= General
% Existing Projects into Workspace
[, File System
> [= Preferences
v = Test
Import test
(] Import test using test code file

< Back Next = Finish

3. Click [Add...] and select the test to be imported.

|

User Manual - 3.3
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. Import test using test code file

Import test using test code file

Create tests using test code files. Flease select files.

User Manual - 3.3

Test files:

Ttexportitunittests_tr_align_testO.c
Twexportytunittestw tr_flush_block_testO.c
Ltexportftunittesti_tr_init_testO.c
Ztexportitunittests_tr_stored_block_test0.c
Ztexportitunittests_tr_tally_testO.c
Ziexportdunittestwtadler32_combine_test0.c
Ziexportitunittestatadler32_testO.c
Ztexportifunittestitbi_flush_test0.c
Ziexportitunittestwtbi_reverse_test0.c
Ztexportdtunittestwtbi_windup_test0.c
Zexportdtunittestwtbuild_bl_tree testO.c
Zexportitunittestwbuild_tree_testO.c
Zexportiunittestwtcheck_header_testO.c
Ztexportitunittestitcompress_block_testO.c
Iexportitunittestitcompress_test0.c
Itexportitunittestitcompress2_test.c
IexportiunittestitcompressBound_test0.c
Zitexportitunittestitcopy_block_test0.c
Ziexportitunittestwtcre32_big_test0.c

Iexportfunittesticrc32_com bine_test0.c
| Frevnnrtdh inittectere 22 little tacth -

Remove

= Back Mext =

==

4. Click [Finish] to apply the selected test to the selected project.

* The status icon(?) ‘the test that cannot find the function to be tested in the source file to

be tested’ is displayed, the related file can be set by using the [Set related file] context

menu.
Add Test Case
Generate test cases automatically b
Host Qutput Value -> Expected Value
Target Output Value -> Expected Value
Initialize Test Case

Copy Cirl+C
Paste Ctrl+v
Duplicate Ctrl+D
Duplicate multiple times...

¥  Delete Delete
Rename... F2

| setrelatediile |
Relevant issues settings...

Import Test Data >
Export Test Data
Large test data >

E [

Generate binary for debugging
5% Add Stub.

Select Test
Deeselect Test

Generate COVErage report...

Import Coverage

1. Click [File] -> [Import].
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, File | Edit Search Project Target Window

New >
Close Ctrl+w
Close All Cirl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F2
Refresh F5
Switch Workspace...

s Import..

&y Export..
Froperties Alt+Enter
Exit

2. Select [Coverage] -> [Import Coverage] and click [Next].
. Import O *

Select

Import external coverage to the selected project. \’
(Coverage shared data file, *.csd) H

Select an import wizard:
|t_\,-'pe filter text |

v [= Coverage

==, Import Coverage
> = General
> [= Preferences .
3 (= Test |

3. Enter the path of coverage file to be imported and click [Finish].
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. Import coverage O *
Import coverage

Select the file for sharing coverage information(*.ced).

File path: ZWexportizlib.csd ‘Browse._.!

User Manual - 3.3

* The imported coverage information can be checked by selecting [Show full coverage
(Include External Coverage)] in the toolbar menu of Coverage view.

| Coverage i3

Host coverage information of 'zlib' project

1 E

it} = O

1
2
3
4
5
<1
7
8
9

10
11

Total

Target Function | Statement Branch MC/DC IFunctiDn Calll Functi...l ~
_tr_align(struct internal_state *) -T2 V2% |0 00% | e AQ00% (w0000 Yy
_tr_flush_blockistruct internal_state __ |mm 54 7A%  |mew g2 S0% w35 365 . we 70 00% ey
_tr_init(struct internal_state ¥ = 00.00%... =/ N/A — N/A 0000, [y
_tr_stored_block(struct internal_stat... (== 100.00%...[== 100 00%...| == 100.00%... == 100.00... ==Yy
_tr_tally(struct internal_state * unsi.. == 222505 == 00% (.. ==000% (.. = MN/A -y
adler32{unsigned long, const unsig... ™= 93.05% ... == 37 50% ... == 75.00% . — MN/A =y
adler32_combine(unsigned long, u... (== 100.00%... == 100.00%... ™= 100.00%... = MN/A -y
bi_flush(struct internal_state # 1 00.00%... == 100.00%... == 100.00%... [ N/A -y
bi_reverse(unsigned int, signed int) ™= 100.00%... == 100.00%... == 100.00%... = N/A -y
bi_windup(struct internal_state *) 1 00.00%... == 100.00%... == 100.00%...[/= N/A -y
build_bl_tree(struct internal_state *) |== 100.005%...|== 75.00% ... == 50.005% .. == 100.00... ==Y

43.02% (... 28.51% (...|19.07% (... 44.11% (... 100.0...| «

& In target testing mode, the coverage of the function including Asm code can not be measured.

Toolchain

You can import the toolchain information exported by using the Import function.
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B import X
Select

Select the toolchain and destination location.

Select the import location: | Z:#exportitexported tch Browse...

Select the toolchain to import:

Status in import

Meed to configure

Default  Toolchain Name Description
il CPE T THiS350 6000 Soc.

GCC 4.7 (32bit)

GCC 5.3 (32bit)

O Microsoft Visual Studio 20...

O Microsoft Visual Studio 20...

O Microsoft Visual Studio 20...

O Microsoft Visual Studio 20...

O jar

MNeed to configure
Meed to configure
Meed to configure
MNeed to configure
Meed to configure
MNeed to configure
Meed to configure

Select all Deselect all

- [JOpen Toclchain preference page after wizard is finished.

< Back

1. In the main menu, click [File] -> [Import]. The Import wizard is opened.

Finish

2. Click [Preferences] -> [ToolChain] and click [Next].
3. If you select the file (*.tch) to be imported, the list of toolchains included in the selected file are

displayed.

Cancel

4. Select the toolchains to be imported from the toolchain list.

User Manual - 3.3

5. If the toolchain to be imported uses the same compiler as the existing toolchain, or if the toolchain

name is duplicated with the name of the existing toolchain, the import status becomes “Need to

modify”. You can change the toolchain name to be imported in the [Select how to resolve] window

displayed when clicking [Next>] button.
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B import

Resolve conflicts

The toolchain that have the same name exist.
Enter the new name.

Select how to resclve:

~

Toolchain MNew Mame

GCC 4.7 (32bit) GCC 4.7 (32bit)(1)
GCC 5.3 (32bit) GCC 5.3 (32bit)(1)

Except

< Back Mext =

6. Click [Finish].

Import Project

Using the Import Project function, you can import a project exported from another PC.

1. Click [File] -> [Import] in the main menu. The Import Wizard opens.

, File | Edit Search Project Target Window

Mew »
Close ctrl+w |
Close All Ctrl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F
Refresh F5
Switch Workspace...

[ Import..

5 Export..
Froperties Alt+Enter
Exit

2. Click [General] -> [Import Project] and then click the [Next] button.

Cancel
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3. Click the [Browse] button to locate the exported project directory. When you select a directory, the

toolchain associated with the project to import is automatically selected. If you don’t have a

suitable toolchain, you need to import the toolchain using the toolchain export/import feature

Page 191 of 249



Suresofttech User Manual - 3.3

before importing the project.
B mport = ==

Import a Project -
Import the exported project.
-

Project directory: DhyprojectlE_20200513113853

Project name: projectlE

Location: ChUsers\vagrant\Desktop\workspace\ CTh1

Select Toolchain

Default Toolchain Name Description

gec &4

vs2019 x64_x64

vs2019 x64 86

vs2019 xB6_B6

GCC 4.7 (32bit) Automatically generated.
GCC 5.3 (32bit) Automatically generated.

Eooooao

Toolchain Setting

<Back || Net> Finish

4. Click the [Next] button.
5. You can check the path information included in the project to be imported. Invalid paths are

marked in red and can be modified by clicking with the mouse or pressing the F2 key.

. Import
Check the paths included in the project =
/1y Invalid path: 15/15

Path(click to edit):

C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2.11\adler32.c
C\Usersiseo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2.11%erc32,c
C\Users\seo hyunji\Desktophtarget plugintzlib-1.2.11%zlib-1.2.11\deflate.c

C\Users\seo hyunji\Desktophtarget plugintzlib-1.2.11%zlib-1.2.11\gzclose.c
C\Users\seo hyunji\Desktopitarget plugintzlib-1.2.11%zlib-1.2. 11N\ gzlib.c
C\Users\seo hyunji\Desktopitarget plugintzlib-1.211zlib-1.2.11\gzread.c
Ch\Users\seo hyunji\Desktop\target plugin\zlib-1.211\zlib-1.2.11\gzwrite.c
C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2. 11\ infback.c
C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2 11\inffast.c
C\Usershseo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2 11\inflate.c
C\Usershseo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2 11\ inftrees.c
C\Users\seo hyunji\Desktop\target plugintzlib-1.2.11%zlib-1.2. 11\ trees.c
C\Users\seo hyunji\Desktopitarget plugintzlib-1.2.11zlib-1.2 11 \uncornpr.c
C\Users\seo hyun)i\Desktopitarget plugintzlib-1.2.11%zlib-1.2.11%zutil.c
C\Users\seo hyun)i\Desktopitarget plugintzlib-1.211%zlib-1.2. 13\ compress.c

6. If you edit one path, all paths that can be found in the relative path are automatically corrected.
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The number of modified paths is displayed at the top of the wizard.

B import = e =)

Check the paths included in the project — 1

(D Invalid path: 0/15 ; y
15 paths have been resolved. 7|

Path(click to edit):

C\Users\vagrant\Desktop\sourcetzlibl 211\zlib-1.2 11\adler32.c
Ch\Users\vagrant\Desktop\sourcelzlib1211\zlib-1.2 11\ compress.c
CihUsershvagrant\Desktophsourcelzlibl211zlib-1.211\erc32.¢
C\Usershwvagrant'Desktop\source\zlib1211\zlib-1.2.11\deflate.c
C:\Users\wagrant'Desktopisourcezlib1211\zlib-1.2.11\gzclose.c
Ch\Users\wagrant'\Desktop\sourcetzlibl 211'\zlib-1.2 11\ gzlib.c
ChUsers\wagrant'\Desktop\sourcetzlibl 211'\zlib-1.211\gzread .c
C:\Users\wagrant\Desktop\sourcelzlib1 211'zlib-1.2 11\gzwrite.c
C\Users\wagrant'Desktop\sourcetzlib1 211\zlib-1.2 11\infback.c
Ci\Users\wagrant'\Desktop\source\zlibl 211'\zlib-1.2 11%inffast.c
C\Users\wagrant'\Desktop\source\zlib1 211'\zlib-1.2 11%inflate.c
C:\Usershwagrant'Desktop\source\zlib1211\zlib-1.2. 11\ inftrees.c
Ch\Users\wagrant'\Desktophsourcetzlibl 211\zlib-1.2 11\ brees.c
Ch\Users\wagrant\Desktop\sourcetzlib1 211'\zlib-1.211uncompr.c
ChUsers\wagrant'\Desktop\sourcetzlibl 211\zlib-1.2 11\zutil.c

net> [ Fnish | [ cancel
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* If path is not in window absolute path format, the path is not checked for validity.

7. Click the [Finish] button.

File System

You can add the source files to the project by using Import File System function.

1.

In the main menu, click [File] -> [Import]. The Import wizard is opened.
, File | Edit Search Project Target Window

Mew ¥
Close ctrl+w |
Close All Ctrl+Shift+W
Save Ctrl+5
Save All Ctrl+Shift+5
Rename... F2
Refresh F5
Switch Workspace...

[ Import..

5 Export..
Froperties Alt+Enter
Exit
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2. Click [General] -> [File System] and click [Next].
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3. Select the top-level directory path containing the source file to be added by clicking [Browse...]

button.

4. Select the source file to be added.

5. Select the target project that the selected source file will be added to by clicking [Browse...]

button.
B import X
Import
Select source files.
Top Directory: | P:#Example_Projecti#c | | Browse...
Directory File
v me [type filter text |
» [ 7zip - -
; ' [CEtestc;
» [] CompileFlagOptionFarser
5> [ compound_test O test input.c
> [ CPPUMIT union.c
» [ dip
» [ gtest_sample
» [ imdisk_source
» [] imdisk_source 2.0.9
> [] mam
» [ many_files
» [ nvip
» [ perfermance
» [ PopPad3_VS6.0
Text file written list of source files
| Browse...
# The entered text file is separated by "' or newline character. Remove
1 itemns selected
Into project: |zlib Browse...

= Back

6. Click [Next].
7. Select the module that the source file will be added from the list of modules included in the project.

Mext >

Cancel
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B import m| *®

File System

Select modules to add.

Select module to add:

Deselect All

< Back Next > Einsh || Cancel

8. Click [Finish].

* You can also add the source file by, from Windows Explorer, dragging and dropping the
source file into the target project or module in Test Navigator view.
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18. Search Menu

User Manual - 3.3

Search Analysis Result

You can search the result created after analysis.

B search

4" Analysis Result Search] £57 File Searchl

Search string (* = any string, ? = any character):

w | [] Case sensitive

Search For
[ Global variable []Function []Any Element

Scope
(O)Workspace (@ Selected resource

Customize..

Search

Cancel

Search word

Enter characters to be searched.

The available wildcards are displayed in the Search dialog box.

« “*” Wildcard string: matches the set of characters containing the empty string.

« “?” Wildcard character: matches all characters.

Search target

Select the target to be searched. The global variable, function or all targets can be searched.

Search range

Select the searching range. It can be searched within the workspace or the selected item range.

File search

A file can be searched.
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B search O >

<" Analysis Result Search | E7 File Search

Containing fext:

| v | [] Case sensitive

* = any string, 7 = any character, % = escape for literals: * 7 %) [ Regular expression

File name patterns (separated by comma):

| * V| Choose...

(* = any string, 7 = any character, Ix = excluding x)

[] Derived resources

Customize... Replace... Cancel

Text included

Enter a character to be searched. To search a file, the field must be empty.
Click [¥] to select the characters searched recently.
The available wildcards are displayed in the Search dialog box.

« “*” Wildcard string: matches the set of characters containing the blank string.
» “?” Wildcard character: matches all characters.

e To search “*”, “?” or “\” character, enter a backslash before the characters in order to indicate that
you do not use these characters by “\ *” wildcards. (Ex: “\?” or “\ \")
File Name Pattern

Enter the pattern of all file names for the files to be searched by using the specific expression.
The wildcards that can use the file name pattern are displayed in the Search dialog box.

“*” Wildcard string: matches the set of characters containing the blank string.
o “?” Wildcard character: matches all characters.
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19. Edit Menu

In the Edit menu, you can carry out the functions such as Cut, Copy, Paste, Delete and Find/Replace the

items selected in the view or editor, or undo or redo the last action performed.
Edit Search Project Target Window Help

| Undo Ctrl+Z
1 Redo Ctrl+Y
Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+V
# Delete Delete
Select All Ctrl+A
Find,/Replace... Ctrl+F

The menu may vary depending on the selected view or editor.
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20. Project Menu

In the Project menu, you can execute the operations for the project (open, close, initialize).

Project  Target Window Help
Open Project
Close Project

E .2 Initialize Project...

Generate command line interface IMI file
Collect project log

1 Properties

Open Project

You can open a closed project selected in the Test Navigator view.

Close Project

You can close an open project selected in the Test Navigator view.

Initialize Project

You can initialize all the open projects in the workspace or the selected projects in the project list below.

If you initialize the project, all analysis results are cleared.
B initizlize m] X

Initialize will discard all analysis information.

(O Initialize projects selected below

= zlib

= zlib_copy

= zlib_copy_copy

& zlib_copy_copy_copy
1= zlib_merged

Garca

Generate Command Line Interface INI File

Based on the project information selected in the Test Navigator, you can create the configuration file
needed to execute the Controller Tester in CLI environment.

Collect Project Log

You can export the log file of the project selected in the Test Navigator view into the specified path.
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Properties

You can see the information or change the settings for the project selected in the Test Navigator view.
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21. Window Menu

In the Window menu, you can open the same new editor as an active editor, open a perspective or a

new view, and see the preferences.

Window Help
Mew Editor
Open Perspective >
Show View »

Save Perspective As..
Reset Perspective...

Close Perzpective i

Preferences

New Editor

It copies the selected source code editor or test editor.

Open Perspective

You can select and open the perspective registered in Controller Tester.

Show View

You can select and open the view registered in Controller Tester.

Save Perspective As

Saves the perspective reconfigured by the user as the other name.

Reset Perspective

Resets the perspective into the initial state.

Close Perspective

Closes the perspective currently open.

Preferences

You can check or change the settings currently applied to the tool.
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For more information, please refer to Preferences
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In the Help menu, you can set the license, and modify or revert the parser config and check the product
information.

Help

Welcome
(7 Help
Iy License...

{] Parser Config >

B About

Welcome

You can see the welcome page that appears when the tool is executed for the first time.

-----
.....

----- CONTROLLER TESTER

Unit/Integration Test Tool

Modify Parser Config

You can modify the parser config by entering the compressed file provided by SureSoft Technologies,
Inc.

How to use

1. Select [Help] -> [Parser Config] -> [Modification...] menu.

Help

Welcome r 3
@ Help Mew Proje
L4 License...

|| Parser Config » =] Modification...
B About G Revert..
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2. Click [Open...] to select the compressed analysis setting file and enter the changes of analysis
settings to [Comment] text as an option.
B Parser Config
Modification

Select a parser config file.

Parser config: || Open...

Comment:

oK Cancel

3. Click [OK].
B Parser Config
Medification

Select a parser config file.

Parser config: | Z:wparserConfig.zip

Open...
Comment:

000 compiler settings have been added.

Cance

Format of the parser config file

* The directory [parserConfig] must exist immediately when opening the compressed file as shown
in the figure below.

* The extension is “zip”.

5] ‘ ; ZparserConfig zipw

Size Packed Size
241 261 40758

Revert the Parser Config

You can revert the parser config by selecting one among the previous parser configs.
How to use

1. Select [Help] -> [Parser Config] -> [Revert] menu.
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Help
Welcome E
7 Help MNew Proje
L} License...
|1 Parser Config » = Modification. .
B About 5 Revert

2. Check the parser config to be reverted in the list of the existing parser configs and select [OK].
B Parser Config - X

Revert
Press 'Ok’ button.

Date Comment
O initial
2020-03-31 10:38:15 ook Compiler analysis settings updated. |

oo Compiler analysis settings updated.

OK | | Cancel

Information

You can see the information and version of the product installed.

B ~bout Controller Tester O X

CodeScroll Contreller Tester RTV(Remote Target Verifier) + Target Plugin
(x64)

Version: 3.2.2

() Copyright Suresoft Technelogies Inc. All Rights Reserved.
Visit http://www.suresofttech.com/

## CODESCROLL

cee

Installation Details

Click [Installation Details] to see the features installed and plug-in.
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23. Troubleshooting

If it conflicts with the security program at installation

Some security programs may stop running the tool installation package. If an error occurred, temporarily
stop the security program operation and proceed with the installation again.

If the product does not operate after specifying the
workspace when executing it

When executing the product for the first time, the global data of CodeScroll is stored in \APPDATAN\ path.
If access to this path is restricted, the product may not be operated.

To solve this problem, please use the feature to set the global data path.

Setting method: Enter the global data path to be set instead of —g default (default value) in CodeScroll.ini
file. (the same if a case of -g or —global and csc.ini file)

If the -g option is not given, the dialog for setting any global data path when executing the product for the
first time is displayed. If canceled here, it is set to the default path.

If it is installed and run in Windows Vista/7

It can only be run with the User Access Control (UAC) features disabled.

If you want to use it without disabling UAC, change the directory during installation so that it is not
installed under the Program Files.

In addition, the Windows accounts for installation and execution must be the same and must be installed
with an administrator account.

If an analysis is failed or Compile (pre-processing) error
occurred

It is the state of source code that the test cannot be run. Please check the compile/link flag and header
file/library settings.

You can check the settings in [Preferences] -> [Toolchain settings].

If all settings are correct (if it is possible to build without any problems in the actual development
environment (IDE etc.)), please contact SureSoft Technologies, Inc.

If it fails to run all test cases

This is because the test engine operation is blocked by the firewall. The test engine loaded in memory
when executing the test must be added as an exception to the firewall setting to run normally.
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If it fails to register toolchain automatically due to some problem with toolchain information installed on

PC, the toolchain auto-registration feature can be turned off. (--disableAutoToolchain option)

* Add --disableAutoToolchain option to CodeScroll.ini file

Upload data to VPES

g Test Navigator 52
0 stub_sample
T target

v New

X

1
1 Delete

L Rename.
i Import...
Export..

C. &

Refresh

Close Project
Quality Management Teols

Run Target Test
4 Import Target Test Log
Collect project log

Create Unit Test...

™ Run Test

% Rebuild and Run Test
Run RTV Test
Reanalyze

Merge Project coverage.

Properties

Delete
F2

E5)

Fi1

Alt+F11

Alt+Enter

?

Export STAT data...

Upload data to STAT...

Export VPES data...

Upload data to VPES...

When you select and right-click a project, [Upload data to VPES...] is indicated in the menu. For this

feature, please contact Technical support.

Collect Project Log

This feature collects the logs left in use of Controller Tester on a project basis in batch and exports them.

When you contact Technical support due to an error occurred, please send us the collected compressed

file so that we can solve the problem more quickly.
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T Test Navigator

v I Zlib

w [

Mew

Delete
Rename...
Import...
Export..

Refresh

Close Project
Quality Management Tools

Run Target Test

Import Target Test Log
Collect project log
Create Unit Test...

Run Test

Rebuild and Run Test
Reanalyze

Merge Project coverage...

Properties

Delete
F2

F5

F11

Alt+Enter

When you select and right-click a project, [Collect project log] item is indicated.

Technical support

If you find any problems, please contact the Technical support contact below.

* support@suresofttech.com
* +82-2-6472-2800

User Manual - 3.3
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24. CONTROLLER TESTER Target Plug-in

Introduction

Controller Tester Target Plug-in complements the functionality of the default Controller Tester.
Controller Tester allows you to automate testing in your own host environment. In other words, you run
the test in a software development environment (normal PC). Controller Tester Target Plug-in allows you
to run tests of Controller Tester in a real embedded target environment. This makes it easy to check
whether the test results are the same in the host and target environment and to run tests that cannot be
executed in the host environment because of factors dependent on the target environment.
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24.1. Target Environment Settings

To run tests in a target environment using Controller Tester Target Plug-in, you need to enter information
about the target environment.

Controller Tester Target Plug-in builds a test harness using information about the target environment
entered by the user and automatically gets the results of running in the target environment.

The target environment can be set in the project properties page or in the new target test project wizard.

Target environment settings

Target environment settings are divided into basic information and detailed settings.
P GNU Compilers » gcc 5.3 ¢ others #

After entering the basic information, detailed settings that require input are displayed.

Settings

Analysis Name Value

Build Toolchain Name Microsoft Visual Studio 2010 (32bit)

Run Status This toolchain is supported.

e C Compiler C:#Program Files (x86)#Microsoft Visual Studio 10.0%VC#bin¥cl.exe
System Header(C Compiler) C:#wProgram Files (x86)#%Micresoft Visual Studio 10.0%VCRATLMFCHI..
Library(C Compiler) C:#Program Files (x86)#Microsoft Visual Studio 10.0%VCHRATLMFCHLI...
C++ Compiler C:#Program Files (x86)#Microsoft Visual Studio 10.0%VC#binticl.exe
System Header(C++ Compiler) C:#Program Files (x86)#Microsoft Visual Studio 10.0%VCRATLMFCH..
Library(C++ Compiler) C:#Program Files (x86)#%Micresoft Visual Studio 10.0%VCRATLMFCHLI...

Description:

Target environment detailed settings

Target environment detailed settings are divided into the analysis, build, run, and etc.

Category Description

The toolchain information is displayed, and in the case of a target test project, the target

Analysis compiler related settings required for analysis are displayed.

Build The settings for building the test software are displayed.

Run Settings for running tests and getting results in the target environment are displayed.
etc. Other settings are displayed. (Program entry point, etc.)

Required settings for each category are indicated in red. Depending on whether the required settings for
each category are entered or not, the behavior when clicking the [Run] button is different as shown
below.
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Required settings

completed category Description
None Test run impossible
Analvsis If you click [Run], it overwrites the original source code with the test code. To
y perform the test, the user must manually build and run the test.
. . If you click [Run], it builds the test code. To perform the test, the user has to
Analysis, Build
manually run the test on the target.
Analysis, Build, Run Automatically run tests in the target environment.

Import target test results

Controller Tester Target Plug-in saves and imports the result of running the test in the target
environment in log format.

If you do not use the debugger, you need the settings for saving the target test results(Log interface) and
the settings for importing(Target Log Collector — Preferences).

Log interface

Log interface is a setting for saving the test results in the target environment. Log interface is written in
the form of a source code that is actually run in the target environment.

B properties for target O X
type filter text When running the target test, it will build and run the test code. Srprw
Inclusion and Exclusion
Info P GNU Compilers b gcc b 5.3 b others b nodebugger Import Target Envircnment Settings
v Target test Settings
Target set |
Test Analysis ‘ Batch script: | P#Example_Project#CTTP test#¥run bat Eares
Build 3 You must select an execution script ( bat) that will run the project on the target after the build
Run Log interface
etc.
filewrite ~ | | Restore Defaults

1#include "cs_TFX_types.h"” ~

2

SFILE “fpw;

4char filePath[] = "C:\\Users\\x\\AppData\\Reaming\\CodeScroll\\TargetLogCollect:

5

6void cs_io_initialize()

8 fpw = fopen(filePath, "w');

9%

10

11void cs_io_finalize()

12{

13 fclose(fpw);

12}

15

16void es_io_flush() {}

18void cs_io_putbyte(char v}

19{ v
< >

Apply and Close Cancel

Log interface structure

Function Description

viod cs io initialize() Initial function for transfer

void cs io finalize() Transfer end function

void cs io flush() Remaining data transfer function

void cs_io putbyte (codescroll byte v) 1-byte data transfer function

Page 211 of 249



Suresofttech User Manual - 3.3

Import target log automatically

The target log, which is the result of the test execution, can be automatically imported through the target
log collector. For the target log collector settings, please refer to [Target Log Collector] in Target Log
Collector and Target Test Preferences.

Import target log manually

If the target log cannot be imported automatically, you can import the target log manually.

Import from a log file

1. After selecting an analyzed project, click [Target] -> [import Target Test Log] -> [Import from Log

File...] in the global menu.
Target  Window Help
#  Run Target Test | E'_;_

. *4 Import Target Test Log > Import from Log File...
Import from Target Log Archive...

=

Import from Target Log Collector...

2. Select a target test log file and click the [OK] button.
B import a target test log ®

Import a target test log
Select the log file of target test.

path: | Browse...

OK Cancel

Import from a target log archive

1. After selecting an analyzed project, click [Target] -> [import Target Test Log] -> [Import from

Target Log Archive...] in the global menu.
Target  Window Help
#  Run Target Test | E_l'-_

-

. *4 Import Target Test Log > Import from Leg File...
Import from Target Log Archive...
Import from Target Log Collector...

2. Select a target log archive file and click the [Next] button.
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B import from Target Log Archive m] K

Import from Target Log Archive

Import the target test results from the archive in the target log collector archive directory.

Path || Browse...

< Back Next = Finish Cancel

3. Check a target test log file and click the [Finish] button.
B import from Target Log Archive m] K

Select Test Logs
Select the target test logs to import.

Select target test logs: [ show excluded logs Show applied logs
Project Test code generation time Status
target 2020-04-01 13:57:26 Applied
target 2020-04-01 13:52:13 Applied
target 2020-04-01 Applied
target 2020-03-31 1 Applied
target 2020-03-311 Applied

3 You can import the target test logs that are neither appliediv) nor excluded(X) on next time.

< Back Next > Cancel

Import from target log collector

1. To getlogs from the target log collector, you need to select ‘Use the default target log collector’
from [Preferences] -> [Target Test] -> [Target Log Collector].
2. After selecting an analyzed project, click [Target] -> [import Target Test Log] -> [Import from

Target Log Collector...] in the global menu.
Target  Window Help
#  Run Target Test | E_l'-_

- R

=3 Import Target Test Log > Import from Log File...
Import from Target Log Archive...
Import from Target Log Collector...

3. Click the [Yes] button to import all the new target test logs or click the [Show details] button.
B import Target Log X

@0k Do you want to apply the target test logs to project 'target'?

k. " 4

: Show details Yes Mo

4. If you click the [Show details] button, check the target test log to be imported and click the [OK]
button.
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B import a target test log b

Select Test Logs
Select the target test logs to import.

Select target test logs:

! [ Show applied logs

Project Test code generation time Status

target 2020-04-01 13:52:13 Applied
target 2020-04-01 13:50:45 Applied
target 2020-03-31 17:43:35 Applied
target 2020-03-31 17:41:48 Applied

3 You can import the target test logs that are neither applied(v) nor excluded(X) on next time.

| OK | | Cancel

Result

After the import is completed, you can check the target coverage information in the coverage view.

&) Coverage 22 e = 8
Target coverage information of 'target’ project
| Target Function Statement I Branch MC/DC | Function CalllFuncthl
1 | add(double, double) = 100.00% __== 100.00% _|[== 100.00% _[==10000% ==Y
2 |divide(double, double) = 100.00% __== 100.00% _ [== 100.00% _[==100.00% ==Y
3 longNameFunctionTestiongMameFun... == 100.00% _.|=— N/A = N/A = 100.00% ==Y
4 longNameFunctionTestiongMameFun... == 100.00% _.|=— N/A = N/A = 100.00% ==Y
& longhNameFunctionTestiongMameFun... == 100.00% ... — N/A = N/A = 100.00% ...==Y
6 main() 5459 (.. == 20.00% (.. = N/A = 55.55% (.. ==Y
7 multiply(double, double) — 50.00% (... == 50.00% (... == 0.00% (0... == 50.00% (.. ==Y
8 |subtract(double, double) = 100.00% .= N/A = N/A w1 00.00% .. ==Y
Total 67.34% (... 53.84% (... 50.00% (... 73.91% (... N/A

* [Import Target Test Log] may fail because the target test run information and the host
test information are not valid if the host test case, source file, function information, etc.
are changed before importing the log of the target test result.
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24.2. C/C++ Target Test Project

The C/ C ++ target test project (hereinafter referred to as the target test project) is a project for target
environment testing. Target testing projects do not support host testing.

Create a target test project

C/C++ Target Test Project with Source Files

1. Create a project by selecting [File]-> [New]-> [Other ...] in the global menu and clicking [C/ C ++
Target Test Project with Source Files].

B new [m] *
Select a wizard —
Create C/C++ target test project with source files.

Wizards:
type filter text

(= C/C++ Project
(= C/C++ RTV Project
w [= C/C++ Target Project
E? C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
[5] C/C++ Target Test Project with Source Files
] Create a C/C++ target test project with Build Information
(= Other

< Back Mext = Finish Cancel

2. Enter a project name and select a toolchain to use.

B new project m] X

New Project

Create a C/C++ target test project with source files.

Project name: ‘scurce,target ‘
Location: ‘ P:#Product_ Workspacewct 3_1_02 ‘
Select Toclchain

Select Ststus Toolchain Name Descripticn

F CPE TI_TN5320_6000_SaC_Unit

o v GCC 4.7 (32bity

v GCC 5.3 (32bit)

(] v Microsoft Visual Studic 2010 (32bit)

(] v Microsoft Visual Studic 2010 (32bit_6...

O v Microsoft Visual Studio 2015 (32bit)

O v Microsoft Visual Studio 2015 (32bit_6...

O [x] gees

O [x] gec 5.4

O [} iar

Toolchain Setting

< Back Next = Einish Cancel

3. After selecting the basic information of the target environment, enter the detailed settings for each
category and click the [Next] button.
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B new project u] X
Target Environment Settings
& Please fill out the target environment information. (% Red: a required field)
» GNU Compilers » gcc b 5.3 b others b please select a debugger Import Target Environment Settings
Settings
—_
Analysis MName Value
Run Toolchain Name GCC 5.3 (32bit)
ey Status This toolchain is supported
C Compiler C:#gecHS.3.0432bitwbinsgcc.exe
System Header(C Compiler) CHgCeH OWinclude;CHgECHS 3.0,
Library(C Compiler)
C++ Compiler C#OCOHS 3 D#32bitwbingg«+ exe
System Header(C~~ Compiler) CHgCCH OWincludettc- - cHgocs.
Librany(C++ Compiler)
Description:
< Back Next > Finish Cancel

4. Select the source files under test and click the [Finish] button.

B new project m] X

New Project

Choose scurce files

Top Directory: ‘DWExamp\e,Prcye:tw:Wmamwﬂib—] 28 | Browse.
Directory File
w [m] zlib-1.2.8 ~ |type filter text ‘
> [ settings
5 [ amiga adler32.c ~
o [ asd00 COMpress.c
> [ contrib cre32.c
s [ dec deflate.c
> [ examples gzclose.c
> [] msdos gzlibc
> [ nintendods gzreed.c
. [ old gzwrite.c
s O anx infback.c
o [test inffast.c
> [ watcom v ?nﬂate < ~
Text file written list of source files
| Browse.
3 The entered text file is separated by ;' or newline character. Remove

15 items selected

< Back Next = Cancel

C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)

1. Create a project by selecting [File]-> [New]-> [Other ...] in the global menu and clicking [C/C++
Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)].
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. New [} X
Select a wizard —
Create a new target test project from CodeWarriori*xml), Green Hills MULTI [
[*.gpj) or NEC PM=+(*.prw, *.prj). =

Wizards:
type filter text

» [ C/C++ Project

» [= C/C++ RTV Project

~ [= C/C++ Target Project
?f C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
[£] C/C++ Target Test Project with Source Files
5 Create 3 C/C++ target test project with Build Information

» [ Cther

= Back Mext > Finish Cancel

2. Enter a project name and select a toolchain to use. After selecting the toolchain, import the

embedded project file to test. Currently, embedded projects supported by Controller Tester are
CodeWarrior, Green Hills, and NEC.

B new Project u] X

New Project
Create a new target test project from CodeWarrior(*.xml), Green Hills MULTIC+.gpj) or NEC PM=(.prw, *prj).

Project name: ‘Embeddedjargetju\ld ‘

Location: ‘PWProdu(t,Wovkspa:ewctj,l,oz ‘

Select Toolchain

Select  Stafus  Toolchain Name Description
CPP_TI_TM$320_6000_SoC_Unit

GCC 4.7 (32bit)

GCE 53 {32hH

Microsoft Visual Studio 2010 (32bit)
Microsoft Visual Studio 2016 (32bit_64bit)
Microsoft Visual Studio 2015 (32bit)
Microseft Visual Studio 2015 (32bit_64bit)
gees

gec 54

far

oooooooRkon
CX- - RN NN

Toolchain Setting
Import Setting

Embedded Project File: Browse.

< Back Next > Finish Cancel

3. After selecting the basic information of the target environment, enter the detailed settings for each
category.
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Create a C/C++ Target Test Project with Build Information

1.

B new project u]

Target Environment Settings

& Please fill out the target environment information. (% Red: a required field)

» GNU Compilers » gcc b 5.3 » others b please select 2 debugger

Import Target Environment Settings

Settings
—_
Analysis Name Value
Run Toolchain Name GCC 5.3 (32bit)
ey Status This toolchain is supported
C Compiler C:#gecHS.3.0432bitwbinsgcc.exe
System Header(C Compiler) CHgCeH OWinclude;CHgECHS 3.0,
Library(C Compiler)
C++ Compiler C#OCOHS 3 D#32bitwbingg«+ exe

System Header(C~~ Compiler) CHgCCH OWincludettc- - cHgocs.
Librany(C++ Compiler)

Description:

< Back Next > Finish Cancel

B new O *

Select a wizard
Create C/C++ target test project with the build information |

Wizards:
type filter text

» (= C/C++ Project

» [ C/C++ RTV Project

~ [= C/C++ Target Project
Ef C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
[E] C/C++ Target Test Project with Source Files
i Create a C/C++ target test project with Build Information

» [= Cther

= Back Next > FEinish Cancel

User Manual - 3.3

Create a project by selecting [File]-> [New]-> [Other ...] in the global menu and clicking [Create a
C/C++ Target Test Project with Build Information].

2. Enter a project name and select a toolchain to use. After selecting the toolchain, Specify the path

of the created Makefile and build script as the build directory and write the build command. You
can choose a script file to set the build-environment from the [Advanced] menu.
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B new project u] X
New Project
Create 3 C/C-~ target test project with 2 build command. (e.g. makefile or build script)
Project name: [Target_Build |
Location. [ P#Product Workspacewct_3_1_02 |
Select Toolchain
Select  Stafus  Toolchain Name Description
| [] PP T ThiS338 000, S0, Unit
] v GCC 47 (32bit)
v GCC 5.3 (32bit)
O v Microsoft Visual Studio 2018 (32bit)
] v Microsoft Visual Studio 2018 (32bit_64bit)
O v Microsoft Visual Studio 2015 (32bit)
O v Microsoft Visual Studio 2015 (32bit_64bit)
m] a gees
m] ] gec 54
O (] iar
Toolchain Setting
Import Setting
8uild Command
mazke clean all
Build Directory: |
Note: The final project name is determined by combining the entered project name
with the module name extracted from the build information. (e.g. [project name] extracted module name)
Advanced
< Back Next » Finish

After selecting the basic information of the target environment, enter the detailed settings for each
category.

B new Project

Target Environment Settings

€ Please ill out the target environment information. ¢ Red: a required field)

» GNU Compilers » gcc » 5.3 » others »  please select a debugger Import Target Environment Settings

Settings
Analysis | Name Value
Run Toolchain Name GCC 5.3 (32bit)
T Status This toolchain is supported.
€ Compiler C:#gechs 3 O¥32bitwhingce exe
System Header(C Compiler) CHgOCHS ! O¥include CHGECHS 3.0,

Library(C Compiler)

C== Compiler CHOCCHS. 3.0 320 HbINEg -~ £
System Header(C++ Compiler) CWgCCw!

Library(C++ Compiler)

Owincluderc - cHgre.

Description:

! Toolchains with invalid compiler paths cannot be selected when creating a target test
project.
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24.3. Target Test Run Settings

You can check the target test execution settings on the target test page in [Project]-> [Properties].

Coverage kind

You can select the type of coverage(Statement, Branch, MC/DC) to be measured for the target test.

Target for coverage measurement

In addition to the functions under test, you can select functions to measure coverage.

All functions called by the target Measures coverages for all functions called by the function
function under test.

The functions called by the previous Includes functions whose coverage was measured from the
test run previous test.

Testcase run

You can choose how to run the test case.

Loads and runs all test cases on target at once.

UL ElEs Each test case is affected by the previous test case run results.

Repeats loading and running each test case on target.

SULEMDLZEIC It takes longer than running at once but uses less memory.
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24.4. Target Log Collector

The target log collector is a server that collects target test results and sends them to Controller Tester.
Collecting target test results methods are largely divided into communication and file scanning.
Supported communication protocols and scannable file formats are as follows.

Protocol TCP, UDP, UART

File format Target log(text), memory dump(Hex, Intel HEX)

Installation

The target log collector is automatically installed when Controller Tester is installed.

Run

When [Use the default target log collector] is checked in [Preferences] -> [Target Test] -> [Target Log
Collector], the target log collector starts collecting target test results.

If you use TargetLogCollector.zip after extracting it, run TargetLogCollector.exe in the unzipped directory
at the Windows command prompt.

Target Log Collector L g g

@ Auto-detect of target log is off.
Use the default target log collector
3 If check 'Use the default target log collector, the target log cellector which is installed with Contraller Tester run automatically.

2Nt | Target log collector info:

[ Target Log Collector X
ﬁ' The default target log collector has been run.
] Target Log Collector - |
Ty Test L
Theme (CS Labs) Auto-detect on
E
Toolchain

[Apply and Close Cancel

Settings

It can be set through the ‘settings.ini’ file in the target log collector installation path, and the options are
as follows.

[LogReceiveServer] Settings for receiving target test results

port TCP, UDP communication port

protocol Communication protocol for receiving target test results
timeout Connection timeout

lastString String representing the end of the data

serialPort Serial communication port

(Windows: COM#, Linux: /dev/ttyS#)
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baudRate
dataBits
stopBits

parity
flowControl
[ScanLog]

dir

fileExtension
[LogSendServer]
port

Serial communication settings
Serial communication settings
Serial communication settings
Serial communication settings
Serial communication settings
Settings for file scanning

Directory to scan

File extensions to scan(Scan all files if blank)

Settings for communication with Controller Tester

Target log file transfer port

User Manual - 3.3

«¥s timeout: If there is no data transmission for the specified number of seconds from the

last reception, the received data is saved.

dir: When a target log file (text, hex) is entered in the specified directory, the target log
collector recognizes it.
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24.5. Preferences
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Target Test

You can set whether to open the target test step notification dialog when the target test is run.

. Freferences

type filter text
Analysis
Editor
Exclusion
Performance
Perspectives

Register external commant

Report
Source File Types
~ Target Test
RTV Senver

Target Log Cellector

Test
Theme (C5 Labs)
ToolChain

O X

Target Test l=Rs v

Target test run
Prompt for executable target test step

Restore Defaults Apply

Apply and Close Cancel

Target Log Collector

Set target log collector information to use and whether to automatically detect target test results. If you

turn on automatic target log detection by clicking the [Atuto-detect on] button, a new target test result is

received from the target log collector at a specified automatic detection cycle.

B preferences

type filter text
Analysis
Editor
Exclusion
Performance
perspectives

Register external comman:

Report
Source File Types
Target Test

RTV Server

Target Log Cellector
Test
Theme (CS Labs)
ToolChzin

<

o e

Target Log Collector (=4 T v

@ Auto-detect of target log is off.

[Juse the default target log collector Open confiquration directory

3 If check "Use the default target log collector, the target log collector which is installed with Controller Tester run automatically.

Target log cellector info:

1P address: [127.001 |

Port [2020 |

Autc-detect cycle(sec) ‘ 60 ‘

Auto-detect on

Restore Defaults Apply

Apply and Close Cancel

Target Log Collector Setting Description

Auto-detect cycle(sec)

IP
Port

Cycle to check for new target test results
IP on the server or PC where the target log collector runs

Target log collector's communication port
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25. CONTROLLER TESTER RTV(Remote
Target Verifier)

Introduction

Controller Tester RTV helps you perform automated testing in your target environment.

After installing the Controller Tester RTV server in your target environment and completing the default
configuration, you can use the Controller Tester RTV client to perform the target test as easily as you
would in a hosted environment.

For information on how to install the Controller Tester RTV server in your target environment, please
contact the Technical support contact on bottom of the Troubleshooting page of this document.

Supported Operating Systems

Server: Linux (RHEL, Ubuntu, Debian, Fedora based)
Client: Windows 7/10
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25.1. RTV Server Settings

In order to use Controller Tester RTV, you need to add a target server with Controller Tester RTV server
installed.

The target server can be added in [Window] -> [Preferences] -> [RTV Server].

[ preferences [m] X

type fifter text RTV Server G-
> Analysis
Editor Server name P port Description Add
Exclusion 6060
Language 6060
performance 5060
Perspectives . Gy
Register external comman:
Source File Types
v Target Test
RTV Server
Target Log Collector
5 Test
Theme (CS Labs)
5 ToolChain
key

Edit

Remove

‘Apply and Close] Cancel

Add a RTV server

1. Click [Add] in [Window] -> [Preferences] -> [RTV Server].

[ preferences o X
type filter text RTV Server pror v
> Analysis
Editor Server name P Port Description g |
Exclusion 6060 Edit
Language 6060
Performance 8060 Remove
Perspectives . 5060

Register external commani
Source File Types
v Target Test
RTV Server
Target Log Collector
5 Test
Theme (CS Labs)
> ToolChain
key

‘Apply and Close] Cancel

2. In the [Add RTV Server] window, enter the target server information.

Add RTV server =
|

Add RTV server
Enter the RTV server information

Server name: ‘

Description ‘

Connecticn Test

oK Cancel

o =

The server name only accepts characters that can be used as Windows file names and
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can not be modified after adding the target server.
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3. Click the [Connection Test] button to check the connection status with the target server you

entered.

. The RTV server connection test

@ Connection successiul

4. If the connection test with the target server is successful, click the [OK] button to add the target

server.

B Add RTV server

Add RTV server

Enter the RTV server information

Server name: \ RTW_Server

IP: ‘211 116.222.223

Port: [a060

Description \ RTV server for test

‘Connection Test

5. You can see that the target server has been added.

B Preferences

type fifter text RTV Server

[m] X

G

> Analysis

Editor Server name P

Port

Description

Add...

Exclusion

Language

Performance

Perspectives

Register external comman:

6060

6060
6060

T —

Edit.

Remove

Source File Types
v Target Test
RTV Server
Target Log Collector
> Test
Theme (CS Labs)
> ToolChain
key

“Apply and Close)

Cancel

Edit a RTV server

1. Double-click the server in the target server list, or select the server and click the [Edit] button.
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[ preferences

type fifter text

5 Analysis
Editor
Exclusion
Language

Perspectives
« Target Test
> Test

> Toolchain
key

Performance

Register external comman:
Source File Types

RTV Server
Target Log Collector

Theme (CS Labs)

RTV Server

Server name P

Port

6060
6060
6060

Description

Add

Edit |

Remove

Apply and Close]

Cancel

2. On the [Edit RTV server] window, edit the server information and then click [OK].

IE:

Port:

B edit RTV server

Edit RTV server

Enter the RTV server information

s

Server name: | 211.116.222.233

[p11.116.222.233

|6060

Description: | RTV Server

Connection Test

Cancel

3. You can see that the target server information has been edited.

[ preferences

type fifter text
5 Analysis
Editor
Exclusion
Language
Performance
Perspectives

« Target Test

> Test

> Toolchain
key

Register external comman:
Source File Types

RTV Server
Target Log Collector

Theme (CS Labs)

o X
RTV Server Frovv
Server name e port Description Add
6060 Edt
6060 RTV Server |
6060 Remove

6060

Apply and Close] Cancel

Remove a RTV server

If you no longer use the target server, you can remove it.

User Manual - 3.3

When you remove a target server, the toolchain or project resources associated with the target server
are deleted from the client environment(Can not be deleted if a target toolchain added from that target

server exists).
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1.

Select a server from the list of target servers and click the [Remove] button.

B preferences

type fifter text
5 Analysis
Editor
Exclusion
Language
Performance
Perspectives
Register external commani
Source File Types
v Target Test
RTV Server
Target Log Collector
> Test
Theme (CS Labs)
> ToolChain
key

RTV Server

Server name

port Description
6060
6060, RTV Server

Add

Edit.

5060
6060

| gemove |

‘Apply and Close]

Cai

ncel
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Click the [OK] button in the [Remove RTV Server] window(Depending on the size of the target
server resource, it may take a minute or two).

. Remove RTV Server

@ Are you sure you want to remove RTV server( )2

Garca

x

You can see that the target server has been removed.

[ preferences.

type filter text

> Analysis

RTV Server

Editor
Exclusion
Language
performance
Perspectives
Register external comman:
Source File Types
v Target Test
RTV Server
Target Log Collector
> Test
Theme (CS Labs)
> ToolChain
key

Server name

Port Description

Remove

Add

Edit

Apply and Close

Cancel
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25.2. RTV Toolchain Settings

RTV toolchain

To build and run a test in a target environment with Controller Tester RTV, you need to set the toolchain
(compiler) information for the source file being tested.

This chapter describes how to add, edit, and delete the target toolchain information that has previously
extracted from the target-environment where the RTV Server is installed.

(For extracting toolchain information from your target environment, please contact the Technical support
contact at the bottom of this document Troubleshooting page.)

Add an RTV toolchain

1. Click the [Add RTV Toolchain] button in the [Window] -> [Preferences] -> [Toolchain] window.

B preferences o %
type filter text ToolChain v D
Analysis
Editor St.. Toolchsin Name  Target Co.. Conversion Tool.. Description Add Toolchain.
Exclusion : " ;
oo v CPPTITMS320.. Notinus.. Microsoft Visual A TV Toolchain
; v/ GCC 47 (32bit) In using
performance v GCC53(32bit)  Inusing Edit
Perspectives
v Microsoft Visual... In using
Register external comman: Duplicate...
v/ Microsoft Visual.  In using
Source File Types
Target Test v/ Microsoft Visual..  In using Remove
v Test v Microsoft Visual... In using
Coverage # gecs inusing  GCC 5.3 (32bit)
Export test date B geesa inusing  GCC 5.3 (32bit)
External editor v ar Notinus.. GCCS5.3 (32bit)
Perspective Open Confiuration Folder
Type Partition Detail
Unit Test View
Virtual Address
Theme (CS Labs)
ToolChain
key
< >

[Apply and Close Cancel

* If you do not have a target server, the [Add RTV Server] window will appear first.

2. If you select the target server in the [Add RTV Toolchain] window, you can see the list of target
toolchain extracted from the target server. Select the toolchain you want to add and click the [OK]
button.

B Add RTV Toclchain O *

RTV Toolchains
Select RTV teolchain

RTV server: |211.116.222 233 ~

RTV Teolchains:

[ glgee 54 @
O gigeca?

[ gees

gec 54 v

3. The toolchain information is imported from the target server (Depending on the size of the system
header, it may take 1 to 2 minutes). When the operation is completed, you can see that the target
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toolchain has been added.

B Preferences

type filter text
5 Analysis
Editor
Exclusion
Language
Performance
Perspectives

Target Test
v Test
Coverage

Perspective

Theme (CS Labs)
> ToolChain
key

Register external commans
Source File Types

Export test data
Eternal editer

Type Partition
Unit Test View
Virtual Address

a X
ToolChain v
5 Toolchain Name Target .. Conversio.. Description Add Toolchain...
¥/ CPP_T|_TMS320_6000_SoC_Unit Netin.. Microsoft adl BTV Toslchain
v’ GCC 4.7 (32bit) In using
v GCC 5.3 (32bit) In using Edit.
¥ Microsoft Visual Studio 2010 (32bit) In using ——
v Microsoft Visual Studio 2010 (32bit_64bit) I using Lo
¥ Microsoft Visual Studio 2015 (32bit) In using Remove
¥/ Microsoft Visual Studio 2015 (32bit_64bity I using
o5 gees Inusing _GCCS3
= gec 5.4 Inusing GCC53.
ar Notin.. GCC53
Open Confiquration Folder
Detail
Toclchain Name gec 5.4
C Compiler Just/bin/gee
C++ Compiler Jusr/bin/g++

Conversion Teolchain Name
Status.

Description

RTV server

GCC 5.3 (32bit)

This toolchain is supported

211.116.222.233:6060

apply and Close Cancel

User Manual - 3.3

4. If you select the target toolchain added, you can see that the information of the target server is

displayed on the [Detail].

Edit an RTV toolchain

1. Select the toolchain to be edited and click the [Edit] button.

B cdit Toolchain O 24
Toeolchain(Method Manage)
Manage toolchain information.
Toolchain Information
Mame: | goc 5.4 |
Description: | |
Env Script: | Browse. .
Configuration: ¥ Unknown{current usage)
C C++
Compiler |fu5rfbinfgcc | Browse...
Linker: |fu5rfbinfgcc | Browse...
Archiver: | | Browse...

System Header:

<

C#tUsersttxtAppDatatRoamingCodeScroll#1. 1#targetSource®211.116.222.233% | add.
CwUserswawAppDataiRoamingwCodeScrolli 1. 1 WtargetSourcew211.116.222.233%| ——
C#UserswxwAppDatawRoamingWCodeScroll#1. 1%targetSourcew211.116.222.233%| | gdit
C#WUserswxwAppDataRoamingWCodeScrollW1 1 WtargetSourcew211.116.222 233 ©
C#UsersixwAppDatawRoamingWCodeScroll#1.1%targetSource®211.116.222.233% | Remoye

Up

Down

Libraries:

Automatically extract toolchain information from entered compiler.

Add...
Edit...

Remove

v

Extract Toolchain Info

< Back

conc

2. Edit the RTV toolchain information.
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3. Click the [Finish] button.

Duplicate an RTV toolchain

The duplication for an RTV toolchain is not provided.

Remove an RTV toolchain

Select the toolchain to delete and click the [Remove] button.

! i you have a project associated with the toolchain you want to delete, you can not use
the project normally after deleting the toolchain.

Import/Export an RTV toolchain

The target toolchain can not be imported/exported because it can be added through the target server.
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25.3. Create a RTV Project
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Create an RTV project to test the source files that exist in the target environment.

When building source files in the target environment, you can extract the information needed to create

the RTV project.

This chapter describes how to create an RTV project by using pre-extracted source file build
information(using the Controller Tester RTV Server Utility) in the target environment, or extracting

information at the same time as building the target source file.

To create an RTV project, run the [Create Project Wizard].
Click [File] -> [New] or Shortcut.

Crl+w
Ctrl+Shift+W

Ctrl+5

Cirl+Shift+5
Rename. F2
Refresh F5
Switch Workspace.

Impert...
Export

EE

Properties Alt+Enter

Exit

>

File Edit Search Project Target Window Help

C/C+=+ Project with Source Files

C/C++ Project from Embedded{CedeWarrior, Green Hills, NEC)
C/C++ Project from Visual Studic Project

C/C++ Project from Existing CodeScroll Project

Create a C/C++ project with CPI File

Create a C/C++ project with Build Information

C/C+=+ Project from RTV Build

C/C++ Project from RTV Build Cemmand

|
B
i3]
ol
]
B
o
o

C/C++ Target Test Project with Source Files
C/C++ Target Test Project from Embedded(CodeWarrior, Green Hills, NEC)
Create a C/C++ target test project with Build Information

Other.

Ctrl+N

jtrjinj'
_tr_stor

C/C++ Project from RTV Build

It is selected when creating an RTV project using pre-extracted source file build information (using the

Controller Tester RTV Server Utility) in the target environment.

1. Enter the project name in [Project name].

B new Project m} x
New Project
Create a new project from the RTV server.
Project name [RTV_Project_1| |
Location: | P#Product_Workspacettct 3_1_02 |
Select Toolchain
Default Toclchain Name RTV server Description
O gees 211.116.224.99
gec 54 211.116.222.233
Toclchain Setting
< Back Mext > Finish Cancel

2. Alist of target toolchains appears in the [Select Toolchain]. Select the RTV toolchain to use.
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3. After selecting the toolchain, then click the [Next] button. You can see the list of source file builds
pre-extracted from the target server.

B new Project [m] x

New Project
Select the build project cn the RTV server

RTV server: 211.116.222.233

Build Project List

Filter: | Show only creatable project ~
Target Project Build Time Build Location Q
[ [ARRAYZ]AI Sources 2020-03-31 11:03:37 /homey/test/test/test09

[ [ARRAYZ]a.cut 2020-03-31 11:03:37 /home/test/test/test02

[ INEWNEWMERGEJAI_Sources  2020-03-27 15:15:08 /home/test/test/test0S

[ [NEWNEWMERGE]a.cut 2020-03-27 15:15:08 /homey/test/test/test0s

[ [ZLBJAN_Sources 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [ZuBINetLinked 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [ZLBJexample 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [ZLiBlexamplesd 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

O [zuEllibz.a 2020-03-27 12:32:07 /homey/test/test/zlib-1.2.11

O [ZuBIminigzip 2020-03-27 12:32:07 /homey/test/test/zlib-1.2.11

[ [ZuB]minigzipss 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [5PROJAI_Sources 2020-03-27 11:43:35 /home/test/test/testo3 -
< >

Next > Finish Cancel

* Among the generated projects, ‘All_Sources_Project Name’ is a project that combines all
the source files of the modules captured by csbuild. Since this project is a combined
project without considering whether it is built or not, it may not be able to perform the
test normally.

4. In the [Build Project List], select the item for which you want to create the RTV project and click
the [Next] button.

B new project m] s

New Project
Select the source file.

RTV server  [211.116.222.233 |

Target Project: [[ZLIB]libz |

Directory File
~ [ home |t)-'pe filter text ‘
~ [m] test
~ [m] test zutil.c Py
Zib-12.11 gzwrite.c

gzclose.c

deflate.c

gzread.c

COMpress.c

inftrees.c

trees.c

uncempr.c

infback.c

gzlib.c

cre32.c o

15 items selected

< Back Next = Cancel

5. After selecting source files to be tested, click the [Finish] button to create the project.

C/C++ Project from Target Build Command

It is selected when creating an RTV project by extracting information at the same time as building the
source file. The user builds the source file on the target server using the build command and then
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creates the RTV project.

1. Enter the project name in [Project name].

. Mew Project

New Project

Create a new project from the RTV server.

Project name:

Location:

Select Toolchain

[RTV_Project1| |

[pwProduct Workspacesct 3_1_02 |

Default Toelchain Name RTV server Descripticn
(] gces 211.116.224.99
goc 54 211.116.222.233
Toolchain Setting
< Back Mext > Finish Cancel

User Manual - 3.3

2. Alist of target toolchains appears in the toolchain list. Select the RTV toolchain to use.
3. After selecting the toolchain, click the [Next] button. The build will be performed on the target

server from

which the selected toolchain was imported.

B new Project [m] x
New Project

Please enter a Build command

RTVserver:  [211.116.222.233 |
Build Dlr(émryl V|
Build Comman

Build Log

Use default location

Location: P-#Product WorkspaceWct_3_1_02# metadata Browse.

Open Directory
......... szt Next > [ ez

4. Enter the path to build from the target server (for example, the directory where the make file is
located), and enter the build command.

6.

In [Build Log], specify the path to the build results file.

The default location is the .metadata directory of the workspace. If you uncheck [Use default
location], you can change the path.
After entering the required information for the build, click the [Next] button. It builds the source file
on the target server with the entered build command (depending on the build target, it can take a
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lot of time).
7. When the build is complete, a list of built projects appears.

B rew Project | b4

New Project
Select the build project on the RTV server.

RTV server:  [211.116.222.233 ]

Build Project List

Filter: |Show only creatable project v|
Target Project Build Time Build Location @
O [ARRAY2]AI_Sources 2020-03-31 11:03:37 /home/test/test/test09

[ [ARRAYZ2]a.0ut 2020-03-31 11:03:37 /home/test/test/test0d

O INEWNEWMERGEJAI Scurces  2020-03-27 15:15:08 /home/test/test/test0s

O [NEWNEWMERGE]a.out 2020-03-27 15:15:08 /homey/test/test/test0S

[ [zuB)All_Sources 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [ZLB]NotLinked 2020-03-27 12:32:07 /homeytest/test/zlib-1.2.11

[ [ZLElexample 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [ZLBJexampless 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [zLEllibz.a 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

O [ZuBIminigzip 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

O [zUBIminigzip64 2020-03-27 12:32:07 /home/test/test/zlib-1.2.11

[ [SPROJAIl_Sources 2020-03-27 11:43:35 /home/test/test/test03 .
< >

* Among the generated projects, ‘All_Sources_Project Name’ is a project that combines all
the source files of the modules captured by csbuild. Since this project is a combined
project without considering whether it is built or not, it may not be able to perform the
test normally.

8. In the [Build Project List], select the item for which you want to create the RTV project and click
the [Next] button.

B new Project a X

New Project

Select the source file

RTV server:  [211.116.222.233 |

Target Project: [[ZLIB]libz.3 |

Directory File
v & home || type filter text ‘ |
v [m] test
~ (W] test zutil.c Py
Zib-1.2.11 grwrite.c

gzclose.c

deflate.c

gzread.c

COMpress.c

inftrees.c

trees.c

uncompr.c

infback.c

gzlib.c

cre32.c )

15 items selected

9. When creating the RTV project, select the source file to be included and click the [Finish] button to
create the project.

Target build command

To create a project from build information, you must use the cs command on the build command.
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cs command

The cs is a utility that automatically extracts the project configuration information of the source files that
are built so that the Controller Tester RTV project can be created.

How to use cs

Prefix the existing build command with cs.

* EX) make — csbuild capture make

h3.cs option

new: Generate the necessary information before extracting build commands. Specify the toolchain with
the -—toolchain option and the project name with the --project option.

* EX) csbuid new --toolchain=gcc5.4 --project=PRJ
! The -toolchain option is required.

capture: Creates an RTV project by performing build command extraction.

* EX) csbuild capture make

convert: Convert a STATIC project to an RTV project.

* EX) csbuild convert
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25.4. Refresh/Add RTV Source Files
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RTV Refresh target source file

If the source file is modified and rebuilt on the target server, the [Refresh RTV Source File] allows the

revised content to be reflected in the project.

!

2.

If the source file is modified but not rebuilt, the changed contents will not be reflected.
If you modify the source files on the target server and then rebuild, you must perform a

full build.

In the [Test Navigator] view, click the [Refresh RTV Source File] context menu.

TR Test Navigator

v B

W

L E

v By

MNew
Delete
Rename...

Import...
Export...

Refresh

Close Project
Quality Management Tocls

Run Target Test

Import Target Test Log

Refresh RTW Source File...
Add RTV Source File...
Collect project log

Create Unit Test...
Run Test

Rebuild and Run Test
Run RTV Test
Reanalyze

Merge Project coverage...

Propertiss

Delete
F2

F

F11

Alt+F11

Alt+Enter

When you create an RTV project, you can see the latest build information for the source files you

selected (display a change notification if the build has changed). Click the [Finish] button to

confirm your changes.
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B Update to RTV server scurce m] X

Update to RTV server source
Refresh the source file features of the RTV server.

The build up of the RTV server has been changed.(Changed target build time: 2020-03-27 12:32:07)
Current target build information
Server name:  211.116.222.233
IP: 211.116.222.233
Build Time: 2020-03-27 12:32:00
Build Location: shome/test/test/zlib-1.2.11

==

3. After confirming the changes, click the [OK] button.

[ Update to RTV server source O X

Update to RTV server source
The Source File has been changed to the source file of the RTV server.

Change:
source file content
(ETTTTE 2R 25 home testest b T 2T Tadlersa Wiodified "}

Add target source file

You can add source files to your RTV projects via the [Add Target Source File] if new source files are

added and built on the target server, or if only some source files are selected when you create the RTV
project.

! if the source file is added but not rebuilt, the changed contents will not be reflected.
If you build the target server after adding the source file, you must perform a full build.

1. In the [Test Navigator] view, click the [Add Target Source File] context menu.
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> gt
(=
It

e 2

W W W W

SLESE

R ki ki ke

b

G E

v v v

TR Test Mavigator

Mew

Delete
Rename...
Import...
Export...

Refresh

Close Project
Quality Management Tools

Run Target Test
Impaort Target Test Log

Refresh RTW Source File...
Add RTV Source File...
Collect project log

Create Unit Test...
Run Test

Rebuild and Run Test
Run RTV Test
Reanalyze

Merge Project coverage...

Properties

Delete
F2

F5

F11

Alt+F11

Alt+Enter
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2. When you create the RTV project, you can see the latest build information for the selected source

3.

file (show change natification if the build has changed). Click the [Next] button to confirm the new

file list.

B Adding files from the RTV server build

Adding files from the RTV server build

Add a source file from the RTV server build
(when adding scurce files, perform a refresh.)

Server name:
IP:
Build Time:

Current target build information

211.116.222.233
211.116.222 233

2020-03-27 12:32:00

Build Location: /home/test/test/zlib-1.2.11

The build up of the RTV server has been changed.(Changed target build time: 2020-03-27 12:32:07)

< Back Next >

Cancel

In the [New file], select the file you want to add and click the [Finish] button.
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[ ~dding files from the RTV server build

Adding files from the RTV server build
The project selected in the table is reflected in the project.

New file:

source file content Select All
[0 211.116.222.233;//home/test/test/zlib-1.2.11/inflate.c New Clear Al
O 211.116.222.233;//heme/test/test/zlib-1.2.11/inftrees.c New
O 211.116.222.233//heme/test/test/zlib-1.2.11 /trees.c New
[0  211.116.222.233://heme/test/test/zlib-1.2.11/uncompr.c New
O  211.116.222.233://heme/test/test/zlib-1.2.11/zutil.c New

0/5 Selected

After confirming the changes, click the [OK] button.

B 2dding files from the RTV server build O X
Adding files from the RTV server build
The source file was updated from the RTV server build, and 2 new file was added.
Change:
source file content
:211.116.222.233//homey/test/test/zlib-1.2.11/inflate.c New
211.116.222 233://homertest/test/zlib-1.2.11/inftrees ¢ New
211.116.222.233//homeytest/test/zlib-1.2.11/trees.c New
211.116.222 233://homeytest/test/zlib-1.2.11/uncempr.c New
211.116.222.233://homeytest/test/zlib-1.2.11/zutil.¢ New

User Manual - 3.3
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25.5. RTV Project Information

Target Project Information

1. The icon for the RTV project is displayed as =

2. The target server’s information ([server name: IP]) is displayed after the name of the RTV project.

TE Test Mavigator
v 18 RTV_project [ 1
~ (5 Default Module

[ adler3z.c
L4 compress.c
L[4 cre3zc
[ deflate.c
L4 gzclose.c
[ gzlibc
[ gzread.c
[ gzwrite.c
L4 infbackc
[ inffastc
L] inflate.c
L] inftrees.c
L[] trees.c
L} uncompr.c
L} zutilc
(= Headers

3. Source files in the RTV project can not be modified(the source file editor of the RTV project is

read-only).
Project property

Info

1. The RTV project displays the target server and project information.

Build Lecation: /home/test/test/zlib-1.2.11

[ properties for RTV_project [m] %
type filter text Info Gy
:::;“5'” and Exclusion Project Information
Target test Path:  /RTV_project
Test Type  Project
Location: P:/Product Workspace/ct_3_1_02/RTV,project
RTV Sever Information
Server name:
IP;
Project: [ZUB]libza
Build Time: 2020-03-27 12:32:00

cel

Apply and Close Can

2. If the general project has set the toolchain as the RTV toolchain, information about the target

server from which the RTV toolchain was imported is displayed.
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[ properties for RTV_project

type filter text
Inclusion and Exclusion
Info
Target test
Test

Info

Project Information

path:  /RTV_project

Type:  Project

Location: P-/Product Workspace/ct_3_1.02/RTV.project
RTV Sever Information

Server name:

IP:

Project: [ZUBJlibza

Build Time: 2020-03-27 12:32:00

Build Location: /home/test/test/zlib-1.2.11

Apply and Close

Cancel

Module/File property

Build

User Manual - 3.3

1. The RTV project can not change the RTV toolchain that was set when the project was created.

2. However, if the RTV toolchain you set originally is deleted, you can change it to another toolchain.

3. In general projects, you can change the toolchain to the RTV toolchain. Changing to the RTV
toolchain changes all toolchain settings (modules and source files) under the project and allows
you to run the target tests.

4. The project with the RTV toolchain can not change the compiler settings of the source file (the

module’s linker configuration can be changed).
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The RTV project allows you to run RTV tests without any additional setup. To test a general project in

the target environment, you must set the toolchain of the project to the RTV toolchain created from the

RTV server to be tested.

Run all RTV tests

It runs the selected tests in the [Unit Test] view and the [Integration Test] view.

Target tests can be

1. Select the project to be tested, right-click it and click [Run RTV Test].

T Test Navigator
, =
e Y
&
W stut ¢ Delete
O targ
T b
5 zlib, &
g Zlib i Export

Rename...
Import.

B0 perech
b

Close Project

Quality Management Tools >

Run Target Test

#

Refresh RTV Source File.

Add RTV Source File.
Collect project log
Create Unit Test
Run Test

oy &

Run RTV Test
Reanalyze

Merge Project coverage.

Properties

Import Target Test Log 5

Rebuild and Run Test

run in the following way.

>

Delete
F2

1

Alt+F11

Alt-Enter

Run RTV unit test

Runs the selected test in the [Unit Test] view.

Run RTV test

[Run] button In the [
[ P = L

lest Import Export Properties Preferences

Unit Test] view.

| .Targetl _Y_ |b‘f [ Global Search (Ctrl+3)

Q)i m[=la

<) Coverage -4 MC/DC 7 Stub (¢ Class Factory <% Control Flow Graph

Unit Test Integration Test

TS

type file, function, test, state, issue
Name
adler32(unsigned 1o
adler32_combine
adler32_combine64
adler32_combine_[.
adler32 z
compress(u
compress2 (uns

0/0/00

Result

SETSTTTD
cooooo
coococooco

Run RTV test case

[Run RTV Test Case] context menu (multi-selectable) in the [Unit Test] view.

%o Call Graph % Function Call Hierarchy

%) Error

& H- *=1

v  Statement Coverage

Coverage
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Unit Test Integration Test

EH-r v 9
v  Statement Coverage

(0/0/00 -
type file, function, test, state, issue
Name Result Coverage @
~ @ adler32iunzigned 0/0/00 -
v adler32(unsiz , unsig ©/0/00

e

s Copy crl=C

(ca Paste Ctrl+V
> adler32 Duplicate Ctrl+D ©0/0/0)0 -
» & adler32 Dugplicate multiple times 0707000 -
> B adler32 0/0/0)0 -

1 Delete Delete b |

> adler32 x ©/0/00 -
> compres Add Test Case ©/0/000 -
> &4 compres  ogt output Value -> Expected Value ©/0/0)0 -
> [ compres ©/0/0)0 -
N crcdd i Target Output Value -> Expected Value ©/0/00 B
> crc32_b Generate binary for debugging /07000 -
> @ cre32_c PR et o 0/0/0)0 -
> cre32_c ©/0/00 -
N cre32 ¢ [™ Run Test Case ©/0/0)0 B
> cre32 1 Add Stub. 0/0/00 -
B L w0 smn -

Run RTV integration test

Runs the selected test in the [Integration Test] view.

[Run] button In the [Integration Test] view.

LN A BB I_l -
5 e Target Global Search (Ctrl+3) Qs = @
Test Import Export Properties Preferences 9 i @ l- Lll Efl &

'] Coverage — MC/DC (7% Stub (¢ Class Factory <% Control Flow Graph

Unit Test Integration Test

Call Graph %2 Function Call Hierarchy 7| Error
B d|EBE v=0

v Statement Coverage

0/0/00 -
type file, test, state, issue
Name Result Coverage
v INTEGRATION_@ 0/0/0)0 -
> adler32(unsigned long, ©/0/0)0
0/0/0)0
©/0/0)0
/0700
(0/0/0)0
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25.7. RTV Test Results

Coverage

You can change the coverage information (host, target, host/target merged) displayed in each view and
editor through the coverage view menu in the top toolbar menu.
You can check the detailed information of each view in Test Perspective.

Test results

You can change the test results through the host/target settings menu on the dashboard.
[ zlib = B x A B & Host @ ¥ [ [ Global Search (Ctrl+3)

New Project New Test Import Export Properties Preferences o

- 2E

& TR | Show Coverage i Coverage —JMC/DC it Stub 7t Class Factory <% Control Flow Graph == Call Graph T Function Call Hierarchy ®") Emor

Stub

The RTV build stubs that are created when running the RTV test is distinct from the build stubs which
are created when running the host test.

Histub R YE|®
Manage stub items of zlib project. (2 items)

& v=0o

(1

type filter text Stub code Configuration

© adler32(unsigned long, const unsigned char %\ styb key: ‘5822949563779393816 ‘
v © void _tr_align(struct internal_state * 5)

 tralign 1 Related Files: ‘P:wExampIe_ProjetM(wdiszIilM.2”‘
| A+ tr_align_2 - RTV Build Stub | _—
Description:
RTV Build Stub
e > Save
Type Description

~d Target build stub Auto-created target stub
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26. EULA(End-User License Agreement)

Software End User License Agreement

Important: This End User License Agreement (‘EULA”) is a legal agreement between the user
(individual or organization) and Suresoft Technologies, Inc. (“SureSoft Tech”) which is the manufacturer
the software products (“Software product” or “Software”) identified by the product identification card or
recognition label attached to this EULA. The software product includes computer software, related
media, related documents, and “online” or electronic manual. When installing, copying, downloading,
backing up, accessing or using the software product, the user must accept the terms of use in the EULA,;
if the user does not accept the terms of use in EULA, the user may not be licensed for the software
product. Unless the user is licensed to use the software product, the user cannot install, copy, download,
backup, access or use this software product.

Software Product License

The Software product is protected by intellectual property rights as well as copyrights, program
copyrights, and international copyright regulations. The term “computer” used in this agreement means a
single computer system, the range of which is described below.

1. License Grant

The EULA grants the user the following rights.

Software Installation and Use. Except for those clearly explained in the EULA, only one copy of
software product can be installed, used, accessed, executed or interacted (“execution”) on the computer.
To install, use or execute the software product on two or more computers, the user must obtain the legal
license(s) that corresponds to the number of computers regardless of the interaction of software used or
executed on each computer.

Backup Copy. When there is no software product backup copy on the computer, the user can create a
single backup copy that corresponds to the computer software part of the software product. The backup
copy can be used for the purpose of recording. To create a single backup copy, a backup utility can be
used. Except for those clearly stated in this EULA, the user may not make copies of the software product
including documents provided with the software product.

2. Other Rights and Limits

Computer or Single Computer System. The Software product’s license is applied only to a single
computer system. If the single computer system has multiple CPUs, it is considered as a single
computer system only when these CPUs are installed to one circuit board and the structure is the
symmetric central processing structure that shares one system bus.

Choose language versions. When the software product is included in one or more language versions, it

is allowed to use only one language version.
Reverse engineering limitations. De-compilation and decomposition. The user cannot decompile or
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decompose software the product using reverse-engineering.

Component separation. The software product is allowed as a single product. Users cannot separate
the components to use in one or more computers.

Lease. The Software product cannot be leased or lent.

Right Transfer of software product. The user may permanently transfer all rights as part of the sale of
hardware or right transfer according to this EULA, it is regarded that the recipient has accepted the
terms of use in this EULA.

Expiration. When the user violates the terms and conditions in the EULA, without infringing other rights,
Suresoft Technologies can make user’s rights expire according to the terms and conditions in this EULA.
In such a case, the user must discard all the duplicates and composing parts, including software product
that has been already installed.

Registered Trademark. The EULA doesn’t grant any rights related to the registered trademark and
service trademark of the software manufacturer, the computer manufacturer, and other related suppliers.
Upgrade. If the software product is upgraded via Suresoft Technologies, the terms of use in the EULA
are still valid for the upgraded software and it cannot be separated to use in one or more computers.

3. Copyright

Every right and intellectual propriety right (including all the image, figure, animation, video, audio, music,
text, and applet of the software product) of the software product, the enclosed manual, and every copy of
the software product are the property of software manufacturer or supplier. All rights and intellectual
property rights for the contents that are not built-in the software product but are accessible through the
use of the software product are the property of the Company, and this EULA does not grant any rights
for such use. When software product includes the manual in a file, only one copy of that file can be
printed. The documents accompanied by the software product cannot be copied. All the rights that are
not clearly stated are the property of the corresponding software manufacturer and supplier.

4. Double Media Software Product

The Software product can be delivered in one or more media. Regardless of the received media’s type
or size, only one media can be used in the computer. Other media cannot be executed on another
computer. Except for the case of transferring rights permanently (as described above), the user cannot
lease or lend the other media or transfer the right to other users.

5. Guarantee

The Software product’s guarantee on quality follows the attached warranty. If there is no separate
warranty enclosed, Suresoft Technologies guarantees that there was no defect during the production
process if it has been normally used for one year from the day of purchase. This does not mean that the
software product has no error, and does not exclude the possibility that unexpected result may appear
when using the product. Except for the cases where it is clearly stated in the separate warranty
agreement, Suresoft Technologies is not liable not only for the inaccuracy, error or defect of the software
product but also for the loss and damage produced from these. Suresoft Technologies doesn’t take any
responsibility for the third party’s claims for damage or the user’s claims for damage to the third party.
The Limited warranty statement, mentioned in the EULA, is still valid even though the user notified
Suresoft Technologies or its official representative in advance of the possibility mentioned above.
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6. Export limitation

The right transfer of the software product can be carried out only within Korea, and it cannot be exported
to other countries.

7. JAVA Support

The Software product includes the support of programs written in JAVA. JAVA technology is not
designed as an online control device, or not made, used or sold in dangerous environments that need to
error preventive function, such as nuclear facility, aircraft navigation, aircraft control, medicine, medical
system, and weapon system that can cause death, injury, or critical physical/environmental damage.

Caution

© Suresoft Technologies, Inc. All copyrights reserved. Printed in Korea
Suresoft Technologies and CODESCROLL are trademarks of Suresoft Technologies, Inc.

The product name or trade name mentioned in this document and related document are the trademarks
or registered trademarks of the Company having the copyright for the product. The software described in

this document is provided according to the usage agreement and non-disclosure agreement.

The software may only be used or copied according to the terms of use in this Agreement.
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